Windows XP

FOR

DUMMIEDS

2ND EDITION

by Andy Rathbone

WILEY
Wiley Publishing, Inc.






Windows XP

FOR

DUMMIED

2ND EDITION







Windows XP

FOR

DUMMIEDS

2ND EDITION

by Andy Rathbone

WILEY
Wiley Publishing, Inc.



Windows® XP For Dummies®, 2nd Edition

Published by

Wiley Publishing, Inc.
111 River Street
Hoboken, NJ 07030-5774
www.wiley.com

Copyright © 2004 by Wiley Publishing, Inc., Indianapolis, Indiana
Published by Wiley Publishing, Inc., Indianapolis, Indiana
Published simultaneously in Canada

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or by
any means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as permitted
under Sections 107 or 108 of the 1976 United States Copyright Act, without either the prior written permis-
sion of the Publisher, or authorization through payment of the appropriate per-copy fee to the Copyright
Clearance Center, 222 Rosewood Drive, Danvers, MA 01923, (978) 750-8400, fax (978) 646-8600. Requests to
the Publisher for permission should be addressed to the Legal Department, Wiley Publishing, Inc., 10475
Crosspoint Blvd., Indianapolis, IN 46256, (317) 572-3447, fax (317) 572-4355, e-mail: brandreview@wiley.com.

Trademarks: Wiley, the Wiley Publishing logo, For Dummies, the Dummies Man logo, A Reference for the
Rest of Us!, The Dummies Way, Dummies Daily, The Fun and Easy Way, Dummies.com, and related trade
dress are trademarks or registered trademarks of John Wiley & Sons, Inc. and/or its affiliates in the United
States and other countries, and may not be used without written permission. Microsoft is a registered
trademark of Microsoft Corporation. All other trademarks are the property of their respective owners.
Wiley Publishing, Inc., is not associated with any product or vendor mentioned in this book.

LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY: THE PUBLISHER AND THE AUTHOR MAKE NO REP-
RESENTATIONS OR WARRANTIES WITH RESPECT TO THE ACCURACY OR COMPLETENESS OF THE
CONTENTS OF THIS WORK AND SPECIFICALLY DISCLAIM ALL WARRANTIES, INCLUDING WITHOUT
LIMITATION WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE. NO WARRANTY MAY BE CRE-
ATED OR EXTENDED BY SALES OR PROMOTIONAL MATERIALS. THE ADVICE AND STRATEGIES CON-
TAINED HEREIN MAY NOT BE SUITABLE FOR EVERY SITUATION. THIS WORK IS SOLD WITH THE
UNDERSTANDING THAT THE PUBLISHER IS NOT ENGAGED IN RENDERING LEGAL, ACCOUNTING, OR
OTHER PROFESSIONAL SERVICES. IF PROFESSIONAL ASSISTANCE IS REQUIRED, THE SERVICES OF A
COMPETENT PROFESSIONAL PERSON SHOULD BE SOUGHT. NEITHER THE PUBLISHER NOR THE
AUTHOR SHALL BE LIABLE FOR DAMAGES ARISING HEREFROM. THE FACT THAT AN ORGANIZATION
OR WEBSITE IS REFERRED TO IN THIS WORK AS A CITATION AND/OR A POTENTIAL SOURCE OF FUR-
THER INFORMATION DOES NOT MEAN THAT THE AUTHOR OR THE PUBLISHER ENDORSES THE
INFORMATION THE ORGANIZATION OR WEBSITE MAY PROVIDE OR RECOMMENDATIONS IT MAY
MAKE. FURTHER, READERS SHOULD BE AWARE THAT INTERNET WEBSITES LISTED IN THIS WORK
MAY HAVE CHANGED OR DISAPPEARED BETWEEN WHEN THIS WORK WAS WRITTEN AND WHEN IT
IS READ.

For general information on our other products and services or to obtain technical support, please contact
our Customer Care Department within the U.S. at 800-762-2974, outside the U.S. at 317-572-3993, or fax
317-572-4002.

Wiley also publishes its books in a variety of electronic formats. Some content that appears in print may
not be available in electronic books.

Library of Congress Control Number: 2004107902
ISBN: 0-7645-7326-8

Manufactured in the United States of America
109 87654321

2B/ST/QZ/QU/IN

WILEY



About the Author

Andy Rathbone started geeking around with computers in 1985 when he
bought a 26-pound portable CP/M Kaypro 2X. Like other budding nerds, he
soon began playing with null-modem adapters, dialing up computer bulletin
boards, and working part-time at Radio Shack.

When not playing computer games, he served as editor of the Daily Aztec
newspaper at San Diego State University. Armed with a comparative literature
degree, he began writing features for magazines and local newspapers.

He eventually combined his interests in words and computers, and sold
articles to a local computer magazine. During the next few years, he started
ghostwriting computer books for more-famous computer authors, as well
as writing several hundred articles about computers for various techie
publications.

In 1992, Andy and DOS For Dummies author/legend Dan Gookin teamed up to
write PCs For Dummies. Andy subsequently wrote the award-winning Windows
For Dummies series, Upgrading & Fixing PCs For Dummies, TiVo For Dummies,
and many other For Dummies books.

Today, he has more than 15 million copies of his books in print, which have
been translated into more than 30 languages.

Andy lives with his most-excellent wife, Tina, and their cat in Southern
California. Feel free to drop by his Web site at www.andyrathbone.com.






Dedication

To my wife, parents, sister, and cat.

Author’s Acknowledgments

Special thanks to Dan Gookin, Matt Wagner, Tina Rathbone, Steve Hayes,
Becky Huehls, and Kim Darosett. Thanks also to all the folks I never meet in
editorial, sales, marketing, proofreading, layout, graphics, and manufacturing
who work hard to bring you this book.



Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form
located at www.dummies.com/register/.

Some of the people who helped bring this book to market include the following:

Acquisitions, Editorial, and Composition

Media Development Senior Project Coordinator: Nancee Reeves

Project Editor: Rebecca Huehls Layout and Graphics: Lauren Goddard,

Senior Acquisitions Editor: Steve Hayes Denny Hager, Joyce Haughey,
Senior Copy Editor: Kim Darosett Barry Offringa, Jacque Roth, Heather Ryan

Technical Editor: Lee Musick Proofreaders: John Greenough, Brian H. Walls

Editorial Manager: Leah Cameron Indexer: TECHBOOKS Production Services

Media Development Manager: Laura VanWinkle

Media Development Supervisor:
Richard Graves

Editorial Assistant: Amanda Foxworth

Cartoons: Rich Tennant, www.the5thwave.com

Publishing and Editorial for Technology Dummies
Richard Swadley, Vice President and Executive Group Publisher
Andy Cummings, Vice President and Publisher
Mary Bednarek, Executive Acquisitions Director
Mary C. Corder, Editorial Director
Publishing for Consumer Dummies
Diane Graves Steele, Vice President and Publisher
Joyce Pepple, Acquisitions Director
Composition Services
Gerry Fahey, Vice President of Production Services

Debbie Stailey, Director of Composition Services



Contents at a Glance

JHEPOAUCTION ....aeeeeeeeeeeeeeeaeeeeeennnaaeeeeennasseeennnnsaeeennnnsnees ]

Part I: Windows XP Stuff Everybody
Thinks You Already Know................cccccaaaaaaaaccnnenneeeeeeaaac 1

Chapter 1: What [s WIiNdOWS XP7? ........coooiiiiiieiieeee ettt e sve e 9
Chapter 2: The Desktop, Start Menu, and Other Windows XP Mysteries................. 15
Chapter 3: Basic Windows Mechanics.........c.ccoceviverininienienieene e 41
Chapter 4: Flipping Through Files, Folders, Floppies, and CDs...........ccccceecereeereennen. 61
Part II: Working with Programs and Files.....................83
Chapter 5: Playing with Programs and Documents ..............ccoceeirerceecvereeneniesenennnns 85
Chapter 6: 1 Can’t FINA It ......cccuooiiriiieieeeeceee ettt 107
Chapter 7: Printing, Faxing, and Scanning............ccccocevereniinenieneneneneneeeeeeeenee 115
Part I11: Getting Things Done on the Internet............... 139
Chapter 8: Cruising the WED ..ottt 141
Chapter 9: Sending Mail and Instant MeSSages ..........cccecevverriiriieriieniienieneeneenieeeenns 163
Chapter 10: Safe COMPULING.......ccectruirieiriiieieere ettt st 185
Part IU: Customizing and Upgrading Windows XP.......203
Chapter 11: Customizing Windows XP with the Control Panel ............c.cccceceeenee 205
Chapter 12: Keeping Windows from Breaking ............ccccceevieiiieiieecienieniecieseeieeiens 229
Chapter 13: Sharing One Computer with Several People...........ccccecevviininninnnnnnns 243
Chapter 14: Connecting Two or More Computers with a Network...........ccccccueeuens 255
Part U: Music, Movies, Memories (And Photos, Too) ...273
Chapter 15: Playing and Copying Music in Media Player ............cccocevinininnenenenne 275
Chapter 16: Fiddling with Photos and MOVIES .........cccccveviieviiecieecieciecieceeseeie e, 295
Part UL: Help! ............eueeeccouiicicniacineccccnnecsccnneenaeneee 321
Chapter 17: The Case of the Broken Window ...........ccccccveeviieiiieiiecciicceeceeeeeee, 323
Chapter 18: Strange Messages: What You Did Does Not Compute...........cccceuenuens 333
Chapter 19: Moving from an Old Computer to a New One..........ccccocevevenereeeeennee 347

Chapter 20: Help on the Windows XP Help System ..........c.cccceevieevieeienieneeneeieenens 359



Part UlL: The Part of Tens .........ccceecceeceeeeieesceeeseeneesen 307

Chapter 21: Ten Aggravating Things about Windows XP

(And HOw 0 Fix TREM) ..cc.coiiiiiiiiiiiiiteeeeeeeteteeeee ettt 369
Chapter 22: Ten Things to Remember about Windows XP ........c.cccecevviinieninnnnnnns 375
Chapter 23: Ten Things to Look Forward to in the Next Version of Windows ....... 379



Table of Contents

JOEPOAUCTION «..aaeeeeaeeeeeeeaeeeeeennaaseeeeennasaeeesnnaseeeesnnssseeeens ]

ADOoUt This BOOK......cociiriiiiiiiieteeeeteeete sttt 1
How to Use This BOOK.......cccceoiiiiiiiiiniineteeeeeeee e 2
And What about YOU? ......ooiiiiiiieeeeete et 3
How This BOOK Is Organized..........ccceceviirierienienienieeeeseeieeie et seeeseeenees 3
Part I: Windows XP Stuff Everybody Thinks You Already Know ....... 4
Part II: Working with Programs and Files .........cc.ccooceevviniinninnininnnnns 4
Part III: Getting Things Done on the Internet...........ccccocenvenninvennennne 4
Part IV: Customizing and Upgrading Windows XP ...........ccccovvenenenn. 4
Part V: Music, Movies, Memories (And Photos, T0O).........cccceeeueeuennn. 5
Part VI HEIP! .....eooiieeeeeeeeee ettt ettt 5
Part VII: The Part of TENS.......c.cccecerueeieieieieieneceeeeeeeerieie e eeeennens 5
[cons Used in This BOOK ........cccivviiviiiiiiniiiietctctctceeeee et 6
Where to GO from Here.......cccoooiiiiiiiiiiiiiinieietteteeeeee et 6

Part I: Windows XP Stuff Everybody
Thinks You Already Know ...............cccccaeaaaaaaaaacccnnneneeeeaac ©

Chapter 1: What Is Windows XP? ..., 9
What Is Windows and Why Are You Using It?.........ccccovvevirieiiniinenenenenene 9
Windows XP’s Luggage: Service Packs ........ccccoecvevieneeceenieeciicieeieceeseenenn 11

What service pack version is on my computer? ..........cccceeeveevennnenne. 12
What'’s in Service Pack 27 ........ocoviiviinininininiieceneneeeceeeeene 13
Installing Service Pack 2 ..........cccoovviriiniiiniinieiccceeeeeeeeeeee 13

Chapter 2: The Desktop, Start Menu, and

Other Windows XP Mysteries ..............c.ccoiiiiiinninnennn. 15
Being Welcomed to the World of Windows XP .........cccccecvvviiniiniinienenninns 16

Fiddling around with user accounts .........ccccceeceeveevervenvinnienieeneenen. 17
Keeping your account private with a password...........ccccccveeuennenn. 18
The DESKEOD c..ceeuiiiiirieiteitetteee ettt et st sae e 20
Cleaning up a messy deSKtOP.......cccvevveeierienienieeeeeie e 21
Jazzing up the desktop’s background.........ccccecevveviinieniienieciennnne. 23
Dumpster diving in the Recycle Bin.........cccoceviineiviniiniinniiniieeen. 24
The Start Button’s Reason to Live........ccoceceveneninnnniicnincnnceceeene 25
The Start menu’s prime real estate ..........cccoceevveveeceecieecieecieeieeeene, 27
Starting a program from the Start menu...........ccocecevenenencnicnniennene. 28

Customizing the Start menu..........cceceevieeiiniienieneeeeeeeeeee e, 30



XIf  Windows XP For Dummies, 2nd Edition

Bellying Up to the Taskbar .........cccoceeviinieniiniiiiiicieeeeesecteeeeeieeene 31
Shrinking windows to the taskbar and retrieving them ................... 33
Clicking the taskbar’s sensitive areas..........ccccoceeceevieneenenencnceneeeene 33
Customizing the taskbar.........ccccveievieecieniiinieeeceee e 34
The taskbar’s crazy toolbars..........coceecierienienieneenenieseeieeeeeeeen 35

Logging Off from WINAOWS .......cccceeviiriiniiniiiiiciicitcestesecteseeseesie e 38

Chapter 3: Basic Windows Mechanics .......................... iy

Dissecting a Typical WINAOW .......ccccoeciiriiniiniiniiiiiieeeeiesecseeseeeesie e 41
Tugging on a window’s title bar........cccocevviiviiniiniininiineeeeeeeee, 43
Barking out orders with the menu bar...........ccococeevevinininneee, 43
Playing with a window’s Standard Buttons toolbar .......................... 45
Moving inside a window with its scroll bar..........cccccecvvevvvviervenneennen. 46
Quick shortcuts with the Windows XP task pane............c.cccecveuennnen. 47
BOring DOYdErs .......cociiiuiiniiiiiiiicieeieeeetetet ettt 49

Filling Out Bothersome Dialog BOXES ........ccccocvvveviirirerieierereceeeeeeens 50
Poking the correct command button...........ccceceevievienenenencneeeene, 50
Choosing between option buttons...........cccceeceveeierienenenennceene 51
Typing into teXt DOXES ....cceoveviieiiiieiieeeeeeeeee e 52
Choosing options from list DOXeS.......ccccoevveriinienercinciirieeieceeeeen 52
Drop-down liSt DOXES ........coveivieirieiiieieeieciecieeee ettt et 53
CRECK DOXES .....eoueiiiiiniiieiietetee ettt ettt ettt 54
SHAING CONIOLS ..ottt 55

Maneuvering Windows around the Desktop.........ccceeceeviencienienieneeneeienns 56
Moving a window to the top of the pile.......ccccccoevveviriincinciinieie. 57
Moving a window from here to there.........cccoocveviivinvinvinniencieneenen. 57
Making a window fill the whole screen...........cccoceeevevireneeireerennne, 57
Making a window bigger or smaller ............ccocovvvreiecienenenenineeeenns 58
Placing two windows next to each other...........c.ccocovivininncnnnnnne 58
Making windows open to the same darn size..........cccceceevveevenneennen. 59

Chapter 4: Flipping Through Files, Folders, Floppies, and CDs ...... 61

Browsing My Computer’s File Cabinets.........ccccoocevviniiineiininenineceene 62

Getting the Lowdown on FOIders ..........ccoeuerienieniieniieniecieeicceeeeeseeieeiene 63

Peering into Your Drives and Folders..........ccoovvvviiiviinnieniiiniienieneenecieeiens 65
Seeing the files on a disk Arive .......ccccoeceeviinieniiniinicneeeeee, 65
Seeing what’s inside folders ..........cccovevvieniiniininniininineeeeeen 66

Creating a New FOIder.........ccoooiiiiiiniieeeeee e 67

Renaming a File or FOlder..........ccuiiiiiiiiiiicieectceeecte e 69

Selecting Bunches of Files or FOlders .........cccooiviiriinnieniinciiiienieneeseeiens 70

Getting Rid of a File or FOlder ..........occoviiniiniiiiiiieiieiccieeecceseeeeeeiene 70

Copying or Moving Files and Folders ..........ccoocevviriiniienieniiinienieceseeiene 72

Seeing More Information about Files and Folders ...........cccoceviininnennnnnne 73

What’s That Windows Explorer Thing? .........cccoceeiviriieieneneneeeeeeeeeeene 76

Writing to CDs and DVDS.......cc.ooiiiriiiinininieieeeseeeecet et 77
Buying the right kind of blank CDs and DVDs for burning............... 78
Copying things from or t0 @ CD ....c.cccevviiviinienieecceeieeieeeeeeeeeen 79

Floppy Disks and Memory Cards ........c.ccoecuevienirniinniennieniieneenieneeneesieseens 82



Table of Contents

Part II: Working with Programs and Files.......................83

Chapter 5: Playing with Programs and Documents ................ 85
Starting @ PrOZram .........ccceeveieiieiiieiececeeeeeeesete e 85
Opening @ DOCUMENL ........cocviriiiriiiiinieeiesteeeseee ettt e e esaeeee e 87
Saving @ DOCUMENt .........ccciiiiiiiiiieiieeie ettt st et eeens 88
Choosing Which Program Opens a File ..........ccccoocvvviriinininineceeeee, 90

The wrong program loads my filel...........cccccooirviriiiininineeee, 90
No program will open my file!..........ccceevveriiniinienieeeceeeeeeeeeeen 92
Taking the Lazy Way with a ShortCut.........cccceveeviiniieniinieeicceeeeeeeeiee 94
The Absolutely Essential Guide to Cutting, Copying, and Pasting ........... 95
The quick 'n’ dirty guide to cut 'n’ paste.......cccceeceeverviervenvieneeneennen. 96
Selecting things t0 CUt OF COPY ..covvevveverieieierirceeeeie e 96
Cutting or copying your selected goods .........ccccoeeeveecieeciieieceenneennen. 97
Pasting information to another place...........ccccceeveeeieiiiiiiciiecieene 100
Windows XP’s Free Programs! ..........ccccoceeviieiiinienieneeneesieesiecieeeesseseens 100
Writing letters with WordPad............cccooviviiiniinieniiiiiecieeieee 101
Jotting down notes with Notepad .......c.cccocevvienieniininniininierieee 102
Finding symbols like © with Character Map......c..ccceccvevurerennennne 103
Drawing and editing photos with Paint ...........ccccoeceniininnninnns 105

Chapter6:1Can‘tFindIt! ............... ..., 107
Finding Lost Windows on the DesKtop .........ccccceverviiriienienicnieneecneeee, 107
Finding Lost Files, Folders, Music, Photos,

Videos, People, or COMPULETS ........cccccveeierieniinienienieeieere e eeeeeesnene 109
Finding any lost files or folders ..........ccccoevierieniinieninniinienieeeeneene 110
Finding lost pictures, music, or Video.........ccceceevuervierviirieniienienennne 113
Finding lost dOCUMENLS .........cccociiriiiriiriinieteecceee e 113
Finding computers or people..........coceeveeriiniiniinensenieneeeeeeeneene 114

Chapter 7: Printing, Faxing, and Scanning ....................... 115
Printing Your Masterwork .........ccocevviniiniiniininieeeeeeseceeeeeeee 115

Adjusting how your work fits on the page .......c.cccceevvevvevieviecnennnn. 116
Adjusting your printer’s settings........ccccceevvevvienveencienieeneeneeeeieene 119
Canceling a print JoD .....cocooiiviiiiiiireeeecce e 120
Printing @ Web Page.......cocevuiiviiiiiiiieieetetcteeccee et 121
Installing New fONtS .......cocoviiiiriiiniireee e 122
Troubleshooting your printer.........c.ccoccoeveeviineenicnnennennenieneeseene 125
Sending and Receiving Faxes in Windows XP.........ccccccevevvierienieneenneenen. 126
Installing Windows XP’s fax program.........cccceeceeveevieeciersiensenieennenne 127
Setting up your computerized fax machine .........cccccoccevvervienciennnnns 128
Sending a fax directly from a program..........ccecceeveevervieriensienieeneenne 129
Sending faxes of scanned files ..........cccccceeieiienieniccecceeeeeeeee 131
ReCeIVING @ faX ...cooviiiiiiieieeee e 132
Scanning a Photo, Letter, Receipt, or Clothing Stain .............cccccveeueennenee. 132
Scanning with the Scanning and Camera Wizard ..........c.cccceeveuennne 133
Choosing the right scanning resolution ...........ccccceccevviirvenienieenennns 136

Dealing with scans that look awful............cccceviiniiiiniiniiniiies 137



xi ¢/  Windows XP For Dummies, 2nd Edition

Part l11: Getting Things Done on the Internet................139

Chapter 8: Cruisingthe Web ..., 141
What Is the Internet?........coccoeoiiiiiiiiiieereeee e 142
What’s an ISP and Why Do I Need One? .........cccccoovvevienernennieniienieneeneenne 143
Setting Up Internet Explorer the First Time..........ccccevevveniiiniiniinncnnenen. 144
How Do I Navigate the Web with Microsoft Internet Explorer?............... 148

How do I move from Web page to Web page? .........ccccccevvevenenennen. 148
Making Internet Explorer open to your favorite site ...................... 151
How can I revisit my favorite places? ........c.cccoceevieveeiinvenienceennenne 152
How do I find things on the Internet?...........cccoceeveieveeveneneneeenen. 152
The Web Page Says It Needs a Weird Plug-In Thing! ...........ccccovvininnnnnen. 154
Saving Information from the Internet ............ccoocoovevevincncecenceeeeeeene 155
Saving @ WeD PAZE .....c.ooueeuieieieieieeeeitetete ettt 155
SAVING XL ..eeuvieiieieeieeieeteee et eteeteete s e e st eseesaeesseebeesteessesssessnanes 157
SaVING @ PICLUIE ....ooviiiiieiieieieteeeeeeee ettt r e aeas 157
Downloading a PrograIm ..........cocceevueevierieeneeneeneeneeniessiesssesssessseseenne 158
It DOESIt WOTK! ...ttt 160
The Pages Won’t All Fit on My Screen!...........ccocvevveeneneneecienieeneeeeeenns 161

Chapter 9: Sending Mail and Instant Messages .................. 163

Using OUutlook EXPress.......cccooveevieiiiiniinieniitciteieeeeeeete ettt 163
Setting up your e-mail account ...........eceeveevieriinenenieieeeeeeeeen 166
Composing and sending an e-mail..........c.ccccceereeriecieeciiesieeieeeeneenne 168
Reading a received e-mail..........c.cecevvieriieniiniinieiceeeeeeeeeeeeee 170
Finding lost mail ........cccooviiniiiiniiiieeeecece e 174
Using an Address BOOK ........coccevciiriinieniienienieeccciesiesie e 174
Getting rid of all your spam...........ccceceecieriiniiniiniiieneeeeeeeee 176

Bugging Friends with Windows Messenger ..........ccccocevveneenieneencnneennee. 177
Getting started with a .NET Passport ........c.ccceceeveeciieciiecieecieeieceens 178
Signing on to Messenger and adding friends ...........ccccoceevveeeenenns 179
Sending and receiving an instant message..........ccocceevvervierirerieeneenne 181

Chapter 10: Safe Computing ...............cccoiiiiiiiiiinnnn, 185

Assessing Your Safety in XP’s Security Center ..........cooceevevviervienvienceennenne 185
Changing the firewall settings.........cocceeceviiniininniiiineeeeeee 188
Automating Windows Update ..........cccceeveeriirienieniinennenneereeeeneenn 189
AVOIAING VITUSES ....oouiiieiiiieeieieieereeeetete ettt 190

Staying Safe on the INnternet ...........ccoccveeieeieeienienieeeeeeee e 191
Avoiding evil add-ons and hijackers in Internet Explorer .............. 191
StOPPING POP-UP AAS ...veeviiiieiieiieieeieeteeeestesteeseete st steeresaeesaeenes 196
Buying from secure Web Sites.........ccccoevieriiniiniiniiiiniinienenceneee 197

Maintaining Your Privacy in Windows XP ..........ccccccevrvnincnncncncnencnnen. 198
Removing previously typed words

from online drop-doOwn liSts ........cccceccveviinienienieiece e 199

Using blind carbon copy when sending
e-mail to several PEOPIE .........ccoeveeiiriiriiieeeeee e 202



Table of Contents

Part 1U: Customizing and Upgrading Windows XP.........203

Chapter 11: Customizing Windows XP with the Control Panel ..... 205
Finding the Right Switch in the Control Panel...........ccccccoevviriinvenennennen. 206
Changing Windows’ Appearance and Themes .........ccccecevcverieneeneennennnn. 207

Changing the computer’s theme............ccocevieniininneniinninenieneee 208
Changing the desktop background ............ccccceevrerircieceenienenenennens 210
ChOOSING @ SCIEEN SAVET .......ceeviiierieiieiieieteierie ettt eaeeaees 211
Changing the screen resolution..........ccccoecveeieeeenieceecieeceeceeeeeeeae 212
Changing Network and Internet Connections..........ccccceevveeeverieneeneennennne. 213
Adding or Removing Programs...........cccoceeeieriienienieneeneenienienieseeseeneene 214
Changing or removing Programs ........cccceeceereereereesierseessuesssesseesieenne 215
Adding NEW ProZramS ........ccccveecuieeiiieeiieeeieesieeesreeesaeeereeeseeeessneesseeens 216
Add/remove parts of WIindows XP ..........cccocevevinininieneneneneeene 217
Set program access and defaults..........cccceeierieniecieeciieceecieeieeeene 218
Adjusting Windows XP’s SOUNAS ........c.ccceevierienienieneenieesieeieeeeeveseesnenne 218
Adjusting the system volume...........cccceevierviiriienieniieneeeeeeeeeeeenn 219
Changing the sound scheme............ccccoeceriiniininniinineeee 220
Changing the speaker settings........ccccceeveveeriereninenieeeeeeeeeen 220
Performance and Maintenance............coccoceeeeienienieneneneeceeeeseee e 220
Adding Printers and Other Hardware............cccoevvenienieecieecieccieciecieeenne 221
Viewing installed printers or fax printers ..........cccceceevveveeveecvennnnn. 221
Adding @ PriNEeT......cocviviieieieteeeeeeceee e 222
Adding new hardware ...........ccccevierieniniienienecceee e 223
Installing or adjusting other items .........c.ccooceevieviiiiniinienienieeee 224
Fiddling with User ACCOUNES.........ccevirerieieieieieere e 226
Setting the Date, Time, Language, and Regional Options ........................ 226
Accessibility OPIONS......cccviiiirieieieceeeeeeee et 227
SECUTILY CENLEY ....eeeiieiieiieiteieetecte ettt ae st e e aeebeeneas 228
ICONS t0 AVOId ...ttt 228

Chapter 12: Keeping Windows from Breaking ................... 229
Creating a Restore Point..........ccocevviiriiiniiniiniciiciceceeeetcee e 230
Tuning Up Windows XP with Built-In Maintenance Tools....................... 231

Finding technical information about your computer ..................... 232
Adjusting visual effects to speed up your computer...................... 234
Freeing up space on your hard disk.........ccccccevvevievinviinvenienieneenns 235
Backing up your data ........ccccecceeeieriieniieniienienieneeeeie e 236
Rearranging items on your hard disk to make
programs run faster (defragmenting) ..........cccceeveerviinveniiiniinenne 239
Fiddling with DIivers.........coccooviiiiiiinieeeeeee et 240
Cleaning YOUr COMPULEY .......cceecueecieeiieienienieenieeieesieesteeaeseeseesssesseeseennes 241
Cleaning YOUY IMOUSE..........ccceeveerieerieenreniieseeseesieesseessesssesssesssesseeseenes 241
Cleaning yOUr MONILOY ......ccccecirriiriiiriienienienteseeneeie et sre e see e 242

Cleaning your keyboard...........cccovverieriienienienieeeieeiesieeieseeseenne 242

xv



X(/i Windows XP For Dummies, 2nd Edition

Chapter 13: Sharing One Computer with Several People .......... 243
Understanding USer ACCOUNTS........ccccevieriereeneeiieieeieeiesteeeesee e eee e 244
Setting Up or Changing User ACCOUNLS .........cccceevierviirnieniienienieneeneeieene 246
Switching Quickly between USers..........ccocuevirveriiinniennieniienienieneeseeeeene 248
Changing a User Account’s Picture.........c.ccoeceeeieciieviiecieeciecieceeeeeee e 250
Setting Up Passwords and SeCUrity .......c..cccecevevenenenenieeeeeseeeeeenees 251

Chapter 14: Connecting Two or More Computers

withaNetwork ..............c i 255
Understanding a Network’s Parts..........cccccveeveeieciiecieecieeieseeceeeeeee e 256
Setting Up a Small NetWork.........cccooiviriiieiiieeeeeeceeeeeeee e 258

Buying parts for a NEtWOTK..........cccceeueeievieiieiieieeeeeeeeeeee e 259
Installing @ NETWOTK .......ccceevuiiiiiiiiiiieierteetestee et 260
Running Windows’ Network Setup Wizard...........ccceeeerviervienienenns 262
Setting Up a Wireless CONNECtion ..........ccecueveevieriiinniennieniienienieneeneeeeene 265
Troubleshooting a NetWOrK ..........cccoeciieiieiiiiieeceee e 267
Sharing and Accessing Your Computer’s Files and Folders..................... 268
Sharing a Printer on the Network..........ccccveeieviiiiiiieiicecececeeeeee, 270

Part U: Music, Movies, Memories (And Photos, Too).....273

Chapter 15: Playing and Copying Music in Media Player........... 275
Stocking Media Player’s Library........ccccococeeveevienieiieciececeeceeeeeee e 276
Understanding Media Player’s Controls...........cccccoeevireniecienenenenenenen. 278
PLAYINgG CDS ..uviiiiiieeieeeetett ettt te sttt et saeesaeeae st e ssaesseesaeensaennas 279
Playing DVDS......ciociiriiieiieiteieesieeieeie ettt et saeesaeeaesstesste s e esaeesesnnas 281
Playing Videos and TV ShOWS........cccocciviiriinienieiinieeieciesteetese e 283
Playing Music Files (MP3s and WMAS)..........ccccvvirviirnienienienieneeneeeeenes 284
Playing Internet Radio Stations ...........cccceeeveeievieniieiieiececece e 285
Creating, Saving, and Editing Playlists.........c.cccccevevininininiinieeenenene 285
Copying CDs to Your Hard DisK.........cccecuerieriinieiiieieeieeieeieceeeeese e 287
Duplicating MUSIC CDS......ccccveriirriirieniinieniereeseeieesie e ssesre e see e esseenees 289
Copying Songs to Your Portable Player..........cccocevvirvienieniienieneeneeienne, 290
Buying Music and Movies from Online Stores..........ccceeveevvieniineenenneennen. 291

Chapter 16: Fiddling with Photos and Movies .................... 295
Using Your Computer as a Digital Shoebox ..........cccevevveniiiniininncnnennen. 296

Dumping the camera’s photos into your computer........................ 296
Viewing photos in the My Pictures folder ............cccccoeeveviievueenenenn. 300
Copying your digital photos to @ CD........ccccceveevieciinciieciicieeeeeeene 306
E-mailing PhotosS ....ccccoiiiiieieieciececeectee e 307
Cropping photos with Paint ..........ccceceeiiiniiniiniiniiieeeeee 308

Printing PICtUres .......cocoirieieiiiieecceeeeeeeeeee e 309



Table of Contents X(/ii

Creating, Editing, and Viewing Digital MovVies .........ccccceeervierieneeneennenne. 310
Step one: Importing pictures from your video camera................... 312
Step two: Editing your MovVie........cccoceeieeienienienicieeieeieeeeeeneee 316
Step three: Saving your edited movie ..........ccoceevevverviinveniieniienenne 319

Part Ul: Help! .........c.uuecceeeceeicieiicceeceieecenseeccanceneeee 321

Chapter 17: The Case of the Broken Window .................... 323
My New Computer Keeps Getting Shut Down! .........cccceeevviiniinieneenienen. 323
Restoring Calm with System Restore...........ccocceevirviinniinciniinieneeeceee, 324
My Mouse Doesn’t Work Right ........cccoceviiniiniiiiieeeecee, 326
My Double-Clicks Are Now Single ClicKS! .........ccooovvivirirercieieieeeeeenene 327
Making and Using a Password Reset Disk.........cccccoceeveriiniiniininncnnennee. 327

Creating a password reset disK.........ccceceeeerieneenieniencieecieeceeeeseenne 327

Using a password reset disk to enter a user account..................... 328
Making Older Programs Run under Windows XP.........cccceccevviirvenennnnnen. 329
It Says [ Need to Be an Administrator!...........cccovvrvinniiniiniininieneeeen, 330
I'm Stuck in Menu Land ........coccoveeiiiniiinieniinieecieeieeeeee ettt 330
All My Desktop Icons Vanished ...........cocvevieieninienenineeeeeeseseeee 331
My Computer Is Frozen Up Solid.........ccccoeeveeievieiiieiieieeiececeeeeee e 331
The Printer Isn’t Working Right .........ccccccovviiiiiiiiiiiiieeeeeeeee, 332

Chapter 18: Strange Messages: What You Did

DoesNotCompute ...........c.cciiiniiiiiiiii i 333
Access IS Denied.........ccooiriiiiiiiiieee e 333
Allow This Page to Install ActiveX Controls .........cccoceeveeverciirsiencieneeneenne 334
AULOCOMPIELE ...ttt s b e s sresbeeseens 335
Click Here to Activate NOW ........cceerievirenenineniceeectecetecsee e 335
Did You Notice the Information Bar? .........cccccooceeiiiiiniiniiniiniinieeceee, 336
Do You Want to Run This File?..........cccooviriiiiiieeeeeeeeeeee 336
Error Renaming File or FOIder ..........cccovvriiniinienieieecececeeeeeeeeene 337
Found New Hardware.........cc.cocovieiiiininininieicieeeeeeteteteieeee e 337
Language Pack Installation...........cccceeeivienieniininiinieeicceeeecteseese e 338
Hiding Your Inactive Notification [CONS.........cccceverviirvieniieniiniinieecieee, 338
If You Remove This File, You Will No Longer

Be Able to Run This Program..........ccececeeeievienieniiniinenceeeeeeseeeeceneen 339
New Fax RECEIVEd......cccooiiiriiiiiiiieieeeeee ettt 339
New Programs Installed............cccceevueeiiinienienieeciecieeieeie e 340
New Updates Are Ready to Install.......c.ccoeceeveiririiinniinnienieniecieneeeeeee, 340
The Publisher Could Not Be Verified ..........cccoocevvirniinnieniiiniiinienieneceenee, 341
There Are Unused Icons on Your DesKtop .......ccccccueeeiieeieeeciieecieeceeeeene 342

To Help Protect Your Computer, Windows Firewall
Has Blocked This Program . . . .......cccccceevievieiiieiiieiieciecieeeeeeesee e 342



XVIff Windows XP For Dummies, 2nd Edition

When You Send Information to the Internet . . . .......ccocoviniiiiiniiniinne 343
Windows Cannot Open This File ........cccccooiviiiiiniiniiiieeeeeeeee 344

You Have Files Waiting to Be Written to the CD ..........ccocoiiiiinennnne 344
Chapter 19: Moving from an Old Computer to a NewOne ......... 347
Using the File and Settings Transfer Wizard ..........ccocoveeieiieiineninenennen. 348
Choosing things to move from your old computer...........c.ccoeuene 349

Moving things to the new computer ..........ccccoocveveeveriinnienieniieneens 354

My New Computer Won’t Open My Old Computer’s Files! ...................... 356
Disposing of the Old CompPUter ..........ccoceviiriiiiriiiiierereeeeeeeeeeeee 357
Chapter 20: Help on the Windows XP Help System ............... 359
Get Me Some Help, and Fast!..........c.ccoooviniinieniciceeeeeceeee e 359
PrESS Fl .ottt 360
Right-click on the confusing part .........ccccccoevevieiieciecieceeeeeeceee 360

Sending in Windows XP’s troubleshooting robots..........c.ccccceeueen. 361
Consulting a Program’s Built-In Computer Guru..........cccoecvevveneennennennen. 363
Using the Windows Help and Support Center ..........ccceecvevcieniineenennnennen. 365

Part UIL: The Part of Tens..........cccceeceeeeiceeiceeeseenaneanenn 307

Chapter 21: Ten Aggravating Things about Windows XP

(And Howto FixThem) ...t 369
Windows Makes Me Log On All the Timel!..........ccccoooenininiininenineneee, 369
Turning Down (Or Up) the Volume .........c.coeceeeiieiiiniieiicieciecieceeeeene, 370
The Taskbar Keeps Disappearing!..........cccccoeceeviriiiniinnienieniienieneeneeieenen 371
My Bar Full of Buttons Just Fell Offl...........ccccooviiiinnininiieeeeee, 371
Keeping Track of Open WIndOWS ........c.ccoecieviiniriiinnienienienieeteseeeeeeenes 372
Lining Up Two Windows on the Screen...........cccocoeeevineniecienieneneeeeenen. 372
It Won’t Let Me Do Something Unless 'm an Administrator!................... 373
My Folders List the Wrong Task Panes!...........cccccocevivviinvinciencienieeeeenee, 373
What Version of Windows Do [ Have?..........ccccoocveviiniininninnienienieneeneenne 374
My Print Screen Key Doesn’t WOrk .........cccoeieviivinniinnieniienicnieneeneeene, 374

Chapter 22: Ten Things to Remember about Windows XP ......... 375
When in Doubt, Right-ClCK ........cccceeiriiriiieieieeeeesee e 375
Create Restore POINtS .......cocivviiiieiiiiiiiicceeeeeeteeee e 376
Make Windows Update AutomatiC.........ccceeeeeeeierieneneneeieeieieeeeeenens 376
Show the Quick Launch Toolbar .........cccccveeieviieiiieniieieciecieciee e 376
Add Your Favorite Goodies to the Quick Launch Toolbar ....................... 376
Use the Show Desktop ICON.......cccceciiviiiiieniiiceccececeecee e 377

Use BCC When Forwarding E-Mails.........ccccooceeviiiiiininnieniienienienieneeene, 377



Table of Contents

Add Your Own User Account Picture..........ccoccoveeviiniininninninnienieneeneene 377
Share Files with Other User Accounts...........cocccceenevenenennncncnnencncnnenne. 378
Make Windows Open to the Size You Want...........ccoceniniiiinineninenennen. 378
Lock Your PC before Leaving .......cccccecceeierienieneeniieiieieeieeieeieseese e 378

Chapter 23: Ten Things to Look Forward

to in the Next Versionof Windows ............................. 379
It Won’t Run Well on Older COmMPULErs .........cccoeeeereeienieneneneneeeeieene 379
Longhorn Looks Much Prettier ...........cccocevvievieniinennieeiieiecieeieeeeseen 379
New Improved Digital Photo Viewer...........cccccoviivinniniiniinienienieneee, 380
IMProved SECUTILY......ccccviiriiriirieriereeetee et 380
Improved Filing SyStem .......cccociiviiiiiniiiniiicteececeee e 380
Longhorn Supports DVD BUINING ..........ccecevirinininieieieneneeeeeeeeeeens 380

Appendix A: Upgrading to Windows XP.......................381

Index........cecaaaeaceaceaaceacneceannanneeseannessesnenaesssasnesaes 3O



xx Windows XP For Dummies, 2nd Edition




Introduction

Welcome to the second edition of Windows XP For Dummies, the world’s
best-selling book about Windows XP! I've expanded the book to explain
all the recent patches, tweaks, fixes, and frustrations that Microsoft has added
to Windows XP.

This book’s popularity probably boils down to this simple fact: Some people
want to be Windows whizzes. They love interacting with dialog boxes. Some
randomly press keys in the hope of discovering hidden, undocumented fea-
tures. A few memorize long strings of computer commands while washing
their hair.

And you? Well, you’re no dummy, that’s for sure. But when it comes to
Windows and computers, the fascination just isn’t there. You want to get
your work done, stop, and move on to something more important. You
have no intention of changing, and there’s nothing wrong with that.

That’s where this book comes in handy. Instead of making you a whiz at
Windows, it merely dishes out chunks of useful computing information when
you need them. Instead of becoming a Windows XP expert, you’ll know just
enough to get by quickly, cleanly, and with a minimum of pain so that you can
move on to the pleasant things in life.

About This Book

Don’t try to read this book in one sitting; there’s no need. Instead, treat this
book like a dictionary or an encyclopedia. Turn to the page with the informa-
tion you need and say, “Ah, so that’s what they’re talking about.” Then put
down the book and move on.

Don’t bother trying to memorize all the Windows XP jargon, such as “Select
the menu item from the drop-down list box.” Leave that stuff for the computer
enthusiasts. In fact, if anything technical comes up in a chapter, a road sign
warns you well in advance. Depending on your mood, you can either slow
down to read it or speed on around it.
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Instead of fancy computer jargon, this book covers subjects like these, all dis-
cussed in plain English:

1 Keeping your computer safe and secure
v Finding, starting, and closing programs
v Locating the file you saved or downloaded yesterday
v Setting up a computer for the whole family to use
v Copying information to and from a CD
v Working with your digital camera’s photos
v Scanning and printing your work
v Fixing Windows XP when it’s misbehaving
There’s nothing to memorize and nothing to learn. Just turn to the right page,

read the brief explanation, and get back to work. Unlike other books, this one
enables you to bypass the technical hoopla and still get your work done.

How to Use This Book

Something in Windows XP will eventually leave you scratching your head. No
other program brings so many buttons, bars, and babble to the screen. When
something in Windows XP has you stumped, use this book as a reference. Look
for the troublesome topic in this book’s table of contents or index. The table
of contents lists chapter and section titles and page numbers. The index lists
topics and page numbers. Page through the table of contents or index to the
spot that deals with that particular bit of computer obscurity, read only what
you have to, close the book, and apply what you’ve read.

If you're feeling spunky and want to learn something, read a little further. You
can find a few completely voluntary extra details or some cross-references to
check out. There’s no pressure, though. You won’t be forced to learn anything
that you don’t want to or that you simply don’t have time for.

If you have to type something into the computer, you'll see easy-to-follow
bold text like this:

Type Media Player in the Search box.
In the preceding example, you type the words Media Player and then press

the keyboard’s Enter key. Typing words into a computer can be confusing, so
a description of what you’re supposed to type usually follows.
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Whenever I describe a message or information that you see on-screen or a
cryptic Web address, I present it this way:

WWW.VW.Com

This book doesn’t wimp out by saying, “For further information, consult

your manual.” Windows XP doesn’t even come with a manual. You won’t find
information about running specific Windows software packages, such as
Microsoft Office. Windows XP is complicated enough on its own! Luckily,
other For Dummies books mercifully explain most popular software packages.

Don’t feel abandoned, though. This book covers Windows in plenty of detail
for you to get the job done. Plus, if you have questions or comments about
Windows XP For Dummies, feel free to drop me a line on my Web site at www .
andyrathbone.com.

Finally, keep in mind that this book is a reference. It’s not designed to teach
you how to use Windows XP like an expert, heaven forbid. Instead, this book
dishes out enough bite-sized chunks of information so that you don’t have to
learn Windows.

And What about Vou?

Chances are you already own Windows XP or are thinking about upgrading.
You know what you want to do with your computer. The problem lies in making
the computer do what you want it to do. You've gotten by one way or another,
hopefully with the help of a computer guru — either a friend at the office,
somebody down the street, or your fourth-grader.

But if your computer guru isn’t around, this book can be a substitute during
your times of need. (Keep a doughnut or Pokémon card nearby in case you
need a quick bribe.)

How This Book Is Organized

The information in this book has been well sifted. This newly expanded book
contains seven parts, and I divided each part into chapters relating to the
part’s theme. With an even finer knife, [ divided each chapter into short sec-
tions to help you figure out a bit of Windows XP’s weirdness. Sometimes, you
may find what you’re looking for in a small, boxed sidebar. Other times, you
may need to cruise through an entire section or chapter. It’s up to you and
the particular task at hand.

Here are the categories (the envelope, please):
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Part I: Windows XP Stuff Everybody
Thinks You Already Know

This part dissects Windows XP’s backbone: Its annoying Welcome screen
and user name buttons, the mammoth Start button menu that hides all your
important stuff, and your computer’s desktop — the background where all
your programs live. It explains how to move windows around, for instance,
and click the right buttons at the right time. It explains the Windows XP stuff
that everybody thinks that you already know.

Part II: Working with Programs and Files

Windows XP comes with bunches of free programs. Finding and starting the
programs, however, often proves to be a chore. This part of the book shows
how to prod programs into action. If an important file or program has van-
ished from the radar, you discover how to make Windows XP dredge your
computer’s crowded cupboards and bring it back.

Also, by popular demand, a new chapter explains how to fax, scan, and print
your important information.

Part I1I: Getting Things
Done on the Internet

Turn here for a crash course in today’s computing playground, the Internet.
This part explains how to send e-mail and globetrot across Web sites. Best
yet, an entire chapter explains how to do it all safely, without viruses and
annoying pop-up ads. (And with the newly strengthened firewall.)

An entire section explains Internet Explorer’s new security toolbar and how it
stops Web parasites from attaching themselves to your board as you Web surf.

Part IU: Customizing and
Upgrading Windows XP

When Windows XP needs a jolt, fix it by flipping one of the switches hidden

in its Control Panel, described here. Another chapter explains computer main-
tenance you can easily perform yourself, reducing your repair bills. You dis-
cover how to share your computer with several people in a family or shared
apartment — without letting anybody peek into anybody else’s information.
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And when you're ready to add a second computer, head to the networking
chapter for quick instructions on linking computers to share an Internet con-
nection as well as files.

Part U: Music, Movies, Memories
(And Photos, Too)

Turn here for information on playing music CDs, digital music, and movies.
Buy some cheap CDs and create your own greatest hits CDs from your
favorite tunes. (Or just copy a CD so your favorite one doesn’t get scratched
in the car.)

Digital camera owners should visit the chapter on transferring pictures
from your camera to your computer, organizing the pictures, and e-mailing
them to friends. Bought a camcorder? Head to the section that explains how
to edit out the dopey parts and create a movie the relatives will enjoy for a
change.

Part Ul: Help!

Although glass doesn’t shatter when Windows XP crashes, it still hurts. In this
part, you find some soothing salves for the most painful irritations. Plus, you
find ways to unleash the Windows XP program’s wise team of Troubleshooting
Wizards.

Stuck with the problem of moving your files from an old computer to a new
one? You'll find help here, as well, with a walkthrough of Windows XP’s Files
and Settings Transfer Wizard. (If you're ready to upgrade your old version of
Windows to Windows XP, check out the appendix, too, which holds complete
instructions.)

Part VII: The Part of Tens

Everybody loves lists (except during tax time). This part contains lists of
Windows-related trivia — ten aggravating things about Windows XP (and
how to fix them) and ten simple things to keep in mind about Windows. As
a bonus (and to help you make conversation with your kids), check out ten
things found in the upcoming version of Windows.

5
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Icons Used in This Book

It just takes a glance at Windows XP to notice its icons, which are little push-
button pictures for starting various programs. The icons in this book fit right
in. They're even a little easier to figure out:

Watch out! This signpost warns you that pointless technical information is
coming around the bend. Swerve away from this icon to stay safe from awful
technical drivel.

This icon alerts you about juicy information that makes computing easier: A
tried and true method for keeping the cat from sleeping on top of the monitor,
for instance.

Don’t forget to remember these important points. (Or at least dog-ear the
pages so that you can look them up again a few days later.)

The computer won’t explode while you're performing the delicate operations
associated with this icon. Still, wearing gloves and proceeding with caution is
a good idea.

There’s a bad corner in every large neighborhood, and the Internet’s global
reach makes for some very large bad corners. Look here for information about
keeping you, your computer, and your information as safe as possible.

Where to Go from Here

WMBER
\x&
&

Now, you're ready for action. Give the pages a quick flip and scan a section

or two that you know you’ll need later. Please remember, this is your book —
your weapon against the computer criminals who’ve inflicted this whole com-
plicated computer concept on you. Please circle any paragraphs you find
useful, highlight key concepts, add your own sticky notes, and doodle in the
margins next to the complicated stuff.

The more you mark up your book, the easier it will be for you to find all the
good stuff again.
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In this part . . .

M ost people are dragged into Windows XP without
a choice. Their new computers probably came

with Windows XP already installed. Or maybe you have
Windows XP at the office, where everyone has to learn
it except for the boss, who doesn’t have a computer. Or
perhaps your favorite program’s latest version requires
Windows XP, so you've had to upgrade.

Whatever your situation, this part gives a refresher on
Windows XP basics and buzzwords like dragging and
dropping, cutting and pasting, and tugging at mischie-
vous toolbars.

And if you’re completely new to computers, the first chap-
ter answers that question you’ve been afraid to ask around
the lunchroom: “Just how do I use this thing, anyway?”




Chapter 1

What Is Windows XP?

In This Chapter

Understanding what Windows XP is and what it does

Understanding Windows XP’s service packs
Knowing what service pack is on your computer

Downloading and installing Service Pack 2

C hances are, you’ve probably heard about Windows. In fact, millions of
people all over the world are puzzling over it as you read this. Almost
every new computer sold today comes with a copy of Windows XP prein-
stalled — cheerfully greeting you when first turned on.

This chapter helps you understand why Windows lives inside your computer,
and how to keep it alive and well with Microsoft’s service packs. It explains
which service packs you need to keep Windows XP up-to-date and how to
deal with the burdens they lay at your feet in the name of increased security.

What Is Windows and Why
Are You Using It?

The answer to this one’s pretty easy: You're using Microsoft Windows
because you don’t have much choice. Nearly every computer sold since late
2001 comes with Windows XP preinstalled. A few people escaped Windows
by buying Apple computers (those nicer-looking computers that cost more).
But chances are, you, your neighbors, your boss, your kids at school, and
millions of other people around the world are using Microsoft Windows.

And just what is Windows? Sold by a company called Microsoft, Windows
isn’t like your usual software that lets you write term papers or send angry
e-mails to mail-order companies. No, Windows is an operating system, mean-
ing it controls the way you work with your computer.
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Yes, Microsoft is sneaky

Microsoft may tout Windows as your helpful
computing companion, always keeping your
best interests in mind, but that's not really true.
Windows always keeps Microsoft'sinterests in
mind. You'll find that out as soon as you call
Microsoft for help on making Windows work
right. Your first two questions are free if you pick
up the long distance charges to Redmond,
Washington. The third call (and all the rest) cost
$35 apiece.

Microsoft also uses Windows to plug its own

menu item that touts something helpful, but
Windows simply leads you to a Web site where
you can purchase additional items from
Microsoft or its business partners.

Simply put, Windows not only controls your
computer but also serves as a huge Microsoft
advertising vehicle. Most of the offers you see
on Windows aren't necessarily the best ones —
they're just the ones that make the most money
for Microsoft. Many of its offers are simply
advertising flyers stuffed inside your computer.

products and services. Sometimes you click a

Windows gets its name from all the cute little windows it places on your
monitor. Each window shows information, such as a picture, a program that
you’re running, or a baffling technical reprimand. You can put several win-
dows on-screen at the same time and jump from window to window, visiting
different programs. You can also enlarge a window to fill the entire screen.

Like the mother with the whistle in the lunch court, Windows controls every
window and each part of your computer. When you turn on your computer,
Windows jumps onto the screen and supervises any running programs.
Throughout all this action, Windows keeps things running smoothly, even

if the programs start throwing food at each other.

In addition to controlling your computer and bossing around your programs,
Windows XP comes with a bunch of free programs. Although your computer
can run without these programs, they’re nice to have. These programs let
you do different things, like write and print letters, browse the Internet, play
music, and even whittle down your camcorder’s vacation footage into a three-
minute short — automatically.

v~ Believe it or not, Windows XP isn’t just the newest version of Windows;
it’s actually the best version so far. (Just ask people who upgraded from
previous versions.) Windows XP doesn’t crash very often. And if one
Windows program crashes, it doesn’t drag the entire computer down
with it, like earlier versions did.

v Windows XP makes it easier for several people to share a single com-
puter. Each person receives his or her own user account. When users
click their names at Windows XP’s opening screen, they see their own
work — just the way they left it.
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v Because Windows XP is sturdier and more secure than earlier Windows
versions, it’s also more difficult to figure out. Computers are pretty dumb,
so when a potential security problem arises, they simply make you decide
how to handle it. (I cover safe computing in Chapter 10.)

Windows XP’s Luggage: Service Packs

Microsoft launched Windows XP in 2001, making it a creaky old-timer in
computer years. To keep its old boat afloat until its replacement in 2006,
Microsoft has released not one but two chunky add-on programs called
service packs.

Service packs, given away for free, provide the Microsoft folks a chance to go
back and fix the things they messed up when they first released Windows XP.
For instance, if Microsoft discovers a programming mistake that keeps
Windows XP from working with a certain computer part, the service pack
fixes that particular problem.

Most importantly, service packs repair oodles of security problems. Every
week, some smart alec figures out a new way to break into Windows XP.
Microsoft analyzes the problem and releases software to plug that security
hole. Service packs provide all the patches, fixes, and plaster Windows needs
to bring your computer up-to-date.

The next section explains how to tell what service packs are on your com-
puter, if any, and how to install Service Pack 2 to make your computer as
secure as possible.

v Windows XP Service Pack 1 contains all the patches released during
Windows XP’s first year of operation. Service Pack 2 contains all the
patches in Service Pack 1 and more. Installing Service Pack 2 brings
your computer up-to-date with all the patches released through
mid-2004.

v Although Service Pack 2 includes lots of patches, it doesn’t include the
newest patches — patches released after Service Pack 2. To keep your
computer up-to-date, be sure to set Windows Update on Automatic, a
simple procedure I discuss in Chapter 10.

v Microsoft doesn’t let its service packs install on illegitimate copies of
Windows XP. If your copy of Windows XP isn’t installed legally, the ser-
vice pack leaves this message when you try to install it: The product
key used to install Windows is invalid. If you see that mes-
sage, contact the person who sold you Windows XP.

11
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|
Figure 1-1:
Your
computer
should say
the words
Service
Pack 2in
the System
section.
|

What service pack version
is on my computer?

Despite the way service packs polish Windows XP and protect it from evil-
doers, your computer certainly doesn’t shout for joy when it has received
one. In fact, the only way to know if you have a service pack installed is to
probe your computer’s menus. Follow these steps to reveal the service pack
that’s currently installed on your computer:

1. Click your Start menu.

2. Right-click on the My Computer icon and choose Properties.

The System Properties dialog box appears, revealing intimate technical
details about your computer.

3. Look for your service pack version in the System section.

You should see the words Service Pack as the bottom line of the window’s
System section. The number after the words Service Pack reveals its ver-
sion number. For example, the computer shown in Figure 1-1 has Service
Pack 2 installed. (The mouse’s arrow points to the words.)

v If you don’t see the words Service Pack 2 listed, your computer has serious
security problems. Jump to the next section to install it as soon as you can.

v If your computer already has Service Pack 2, you don’t need to install
Service Pack 1. Service Pack 2 includes Service Pack 1.

v If you see the words Service Pack 1 listed, you still need to install
Service Pack 2.

System Properties (63 5%}
System Restore Automatic Updates Remote
General Computer Mame || Hardware Advanced

System:

Micrasoft Windows P
Professional

| ' Version 2002
s

Service Pack 2

Registered to:
— Andy R athbone
Big Expensive Coffee Table Bo
55276-010-4707613-22545

Computer:
Intel Pentium |1l processor
457 MHz, 640 ME of RAM
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What's in Service Pack 2?

Installing Service Pack 2 is like receiving an updated version of Windows XP
with new features — all for free. Here are some of the tastier tidbits that this
huge 100MB program brings to Windows XP:

v Service Pack 2 contains several years’ worth of security patches and
repairs, making Windows XP much safer and more stable.

v A pop-up ad blocker to Internet Explorer keeps ads from exploding in
your face as you visit Web sites.

v Internet Explorer’s new Add-On manager lets you know when some-
thing’s trying to install itself onto Internet Explorer. The manager lets
you weed out nasty Web parasites but approve the things you do want
installed, like helpful toolbars.

v The new, improved firewall not only turns itself on automatically but
also protects your computer from intruders.

I cover all these features in Chapter 10. You can find also more information
about Service Pack 2 on the Internet at wew.microsoft.com/security.

Installing Service Pack 2

Microsoft lets people install Service Pack 2 in two different ways depending
on how you connect to the Internet, either by dial-up (through the phone
lines) or broadband (cable or DSL):

v~ Dial-up: Because Service Pack 2 is such a large download (100MB), dial-
up Internet users should probably visit Microsoft’s Web site at support.
microsoft.com and sign up to receive Service Pack 2 on a CD.

v Broadband: Internet users with this speedy connection can download
Service Pack 2 from Windows Update, found by opening Internet Explorer
and choosing Windows Update from the Tools menu. Your computer
connects to Microsoft’s Windows Update Web site and automatically
downloads and installs Service Pack 2.

\“Q,N\BEI? Even after you install Service Pack 2, you still need to use Windows Update.
& That keeps you updated with fixes discovered after Microsoft released
Service Pack 2. I explain how to make Windows Update run automatically
in Chapter 10.

Service Pack may make some of your programs behave strangely. If you're
having problems with any of them immediately after you install Service Pack 2,
visit that program’s Web site to see whether it offers a patch.
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What's Windows XP Professional?

Windows XP comes in two basic versions:
Windows XP Home and Windows XP
Professional. Both versions look and act almost
indistinguishably from each other. Chances are,
you're using Windows XP Home, the version
designed for homes and small businesses.
Larger businesses often use Windows XP
Professional because that version has a few
extra menus tucked away for things like
advanced corporate security. Other than those
extra menus, the two versions are virtually
indistinguishable.

If you're planning on using your computer to
connect to the office through a network, ask the
person in charge of your office’s computer net-
works which version he or she recommends.
Windows XP Home connects to most corporate
networks without problem, but only Windows
XP Professional can connect to a specialized
Windows server domain.

| run Windows XP Home on my main computer,
but | run Windows XP Professional on another
computer just to see what the fuss is about.




Chapter 2

The Desktop, Start Menu, and
Other Windows XP Mysteries

In This Chapter
Starting Windows XP
Entering a password

Logging onto Windows XP
Using the desktop

Using the taskbar

Using toolbars

Logging off Windows XP
Turning off your computer

Fis chapter provides a drive-by tour of Windows XP. You'll turn on your
computer, start Windows, and spend a few minutes gawking at its various
neighborhoods: the desktop, the taskbar, the Start menu, and the environmen-
tally correct (and compassionate) Recycle Bin.

Everybody who’s anybody hangs out on the Windows desktop (a fancy word
for the Windows background). The taskbar provides a convenient hideaway for
leaving the spotlight. When something’s missing, the Start menu is the best
place to look it up.

Former friends wind up in the Recycle Bin where they either fade away or, if
necessary, can be safely revived.
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Being Welcomed to the
World of Windows XP

|
Figure 2-1:
Windows XP
wants all
users to
logonsoit
knows who's
using the
computer at
all times.
|

Starting Windows XP is as easy as turning on your computer — Windows XP
leaps onto the screen automatically with a futuristic flourish. But before you
can start working, Windows XP may throw you a fastball with its brilliant blue
Welcome screen: Windows wants you to log on, as shown in Figure 2-1, by
clicking your name.

I've customized my Welcome screen. Yours will look different. If you don’t see
a user name listed for you on the Welcome screen, then you have three options:

v If you just bought the computer, use the account named Administrator.
Designed to let give the owner full power over the computer, the admin-
istrator account user can set up new accounts for new users, install
programs, burn CDs, start an Internet connection, and access all the
files on the computer — even those of other users. Windows XP needs at
least one person to act as administrator, even if your computer isn’t con-
nected to other computers. Hit Chapter 13 if you care about this stuff.

v~ Use the Guest account. Designed for household visitors, this account lets
guests like the babysitter or visiting relatives use the computer temporar-
ily. (Some administrators turn off the Guest account to lock out visitors.)

W

!I ,[ E Kitty

Microsoft® .

Windows 5 Tina
To begin, click your user name -

Guest

[@) Turn off Lab
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Running Windows XP for the first time

If you've just installed Windows XP or you're
turning on your computer for the first time, you're
treated to a few extra Windows XP spectacles: A
hip little box appears on the screen, demonstrat-
ing how Windows XP can indeed create cool
colors and noises. Then Windows XP leaves you
at a box with the following four buttons:

v~ Digital Media: Click here to check out
Windows' fun multimedia stuff. It contains
tours of Media Player — a program for play-
ing CDs, videos, DVDs, digital music, and
much more. You'll also find information about
the built-in video editor, Movie Maker, and
your official digital photo storage bin called
My Pictures.

v Rich Internet Experience: Nothing really
new here: tours of the Internet Explorer
Web browser and the Outlook Express
e-mail program. There's also a plug for MSN

Messenger, a program for bugging your
buddies on the Internet.

+* Home Networking: On your second or third

computer? Perhaps it's time to link them
(with or without cables), run Windows XP's
built-in Network Setup Wizard software,
and add the words Network Administrator
to your business card. (It's a great pickup
tool in Silicon Valley.)

v+ Improved User Experience: These buzz-

words merely refer you to the Windows Help
program. Yawn.

To take any of the tours, let the mouse pointer
hover above the button. Then click either
the words Try It or Learn More to head to
that particular program. Try It takes you to
the program itself; Learn More brings up the
program’s help menu.

A\

No Guest account and no user? Then find out who owns the computer and
beg that person to set up a user name for you. (If they don’t know how, show
them Chapter 13, where [ explain how to set up a User Account.)

When first installed, Windows XP dashes back to the Welcome screen when-
ever you haven'’t touched the computer for ten minutes. To stop this scurrying,
right-click on the desktop and choose Properties. Click the Screen Saver tab
and remove the check mark next to the On Resume, Display Welcome Screen
option. Then you’ll have to log on only when you start up Windows — not
throughout the day.

Fiddling around with user accounts

Windows XP allows several people to work on the same computer, yet

it keeps everybody’s work separate. To do that, it needs to know who’s
currently sitting in front of the keyboard. When you log on — introduce
yourself — by clicking your user name, as shown in Figure 2-1, Windows XP
presents your personalized desktop, ready for you to make your own
personalized mess.

17
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|
Figure 2-2:
With a
password,
nobody else
can access
your files.
|

When you’re through working or just feel like taking a break, log off (explained
at this chapter’s end) so somebody else can use the computer. Later, when you
log back on, your messy desktop will be waiting for you.

Although you may turn your desktop into a mess, it’s your own mess. When
you return to the computer, your letters will be just as you saved them. Jerry
hasn’t accidentally deleted your files or folders while playing Widget Squash.
Tina’s desktop contains links to her favorite Web sites. And all of Carrie’s
Phish MP3s stay in her own personalized My Music folder.

Of course, the big question boils down to this: How do you customize the pic-
tures next to your user name, like my face in Figure 2-1? After you’ve logged
on, open the Start menu (covered in this chapter) and click the little picture
at the top. Windows conveniently lets you pick a new one. (For ideas, browse
through the digital photos you’ve saved in your My Pictures folder.)

Keeping your account private
with a password

Because Windows XP lets bunches of people use the same computer, how do
you stop Rob from reading Diane’s love letters to Henry Rollins? How can Josh
keep Grace from deleting his Star Wars movie trailers? Windows XP’s optional
password solves some of those problems.

By typing in a secret password when logging on, as shown in Figure 2-2, you
enable your computer to recognize you and nobody else. If you protect your
user name with a password, nobody can access your files (except for the
computer’s administrator, who can peek anywhere — and even delete your
account).

To set up or change your password, follow these steps:

1. Click the Start button, click Control Panel, and click the User
Accounts icon.
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2. Click your user account’s name and choose Create a Password.

3. Type in a password that will be easy for you — and nobody else — to
remember.

Keep your password short and sweet: the name of your favorite veg-
etable, for example, or your dental floss brand.

4. In the last box, type a hint that reminds you — and only you — of
your password.

5. Click the Create Password button, and Windows XP begins asking for
your password whenever you log on.

v Passwords are case-sensitive. Caviar and caviar are considered two dif-
ferent passwords.

v Forgotten your password already? Click the little question mark button
in Figure 2-2 that appears whenever you click your user name. Your “hint”
appears, hopefully reminding you of your password. Careful, though —
anybody can click the question mark and read your hint, so make sure
it’s something that only makes sense to you.

Own a laptop? Password protect your account now, before somebody
steals your expensive new toy.

v When you create your password, Windows XP offers to make your files
and folders private to lock out everybody. Before making your account
private, remember that private files are much more difficult for repair
shops to retrieve if something goes wrong with your computer.

v | explain more about user accounts in Chapter 13.

Make Windows stop asking me for a password!

Windows asks for your name and password only with your name and changing your files and
when it needs to know who's tapping on its keys. settings.
And it needs that information for any of these

three reasons: If these concerns don't apply to you, purge the

password by clicking the Control Panel's User
v Your computer is part of a network, andyour  Accounts icon and choosing Remove My
identity determines what goodies you can  Password.

access. Without that password, anybody can now log on

v The computer’s owner wants to limit what  using your user account and view (or destroy)

you can do on the computer. your files. If you're working in an office setting,
this could be serious trouble. If you've been
assigned a password, it's better to simply get
used to it.

v+ You share your computer with other people,
and want to keep others from logging on

19
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The Desktop

Normally, people want their desktops to be horizontal, not vertical. Keeping
pencils from rolling off a normal desk is hard enough. But in Windows XP, your
monitor’s screen is known as the Windows desktop, and that’s where all your
work takes place. You can create files and folders right on your new electronic
desktop and arrange them all across the screen. Each program runs in its own
little window on top of the desktop.

Windows XP starts with a freshly scrubbed, empty desktop. After you've been
working for a while, your desktop will fill up with icons — little push buttons
that load your files with a quick double-click of the mouse. Some people leave
their desktops strewn with icons for easy access; others organize their work:
When they finish working on something, they store it a folder, a task covered
in Chapter 4.

The desktop boasts three main parts, shown in Figure 2-3. The taskbar
rests lazily along the desktop’s bottom edge and lists the programs and
files you're currently working on. The Start menu, seen at the taskbar’s
left edge, lets you locate and run programs. And unlike the office paper
shredder, the desktop’s Recycle Bin lets you safely retrieve accidentally
deleted files. Whew!

v You can start new projects directly from your desktop: Right-click
on the desktop, choose New, and select the project of your dreams
from the pop-up menu. (The menu lists most of your computer’s pro-
grams for quick 'n’ easy access.)

QgN\BEB v Are you befuddled about some object’s reason for being? Timidly
& rest the pointer over the mysterious doodad, and Windows will pop
up a little box explaining what that thing is or does. Right-click on
the object, and ever helpful Windows XP usually tosses up a menu
listing nearly everything you can do with that particular object. This
trick works on most icons found on your desktop and throughout
your programs.

QNING/ v Everything on your desktop may suddenly disappear, leaving it com-
Y pletely empty. Chances are, Windows XP hid everything in a misguided
attempt to be helpful. To bring your work back to life, right-click on
your empty desktop and choose Arrange Icons By from the pop-up
menu. Finally, choose Show Desktop Icons to make everything reappear
with no harm done.
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Recycle Bin

|
Figure 2-3:
The
Windows XP
desktop,
which
spreads
across your
entire
computer
screen, has
three main
parts.
|

Click to open the Start menu. Taskbar

Cleaning up a messy desktop

When icons cover your desktop like a year’s worth of sticky notes, Windows
XP offers several ways to clean up the mess. Many people opt for the Desktop
Cleanup Wizard, the built-in robotic housekeeper. Here’s how it works:

1. As shown in Figure 2-4, right-click on a blank part of the desktop,
choose Arrange Icons By, and choose Run Desktop Cleanup Wizard.

The Desktop Cleanup Wizard carefully examines your clutter and lists
every icon’s last used date.

2. If you click the OK button, the wizard automatically moves your least-
used icons to a new Unused Desktop Shortcuts folder.

Quick, simple, and you can always drag ’em back out of the folder if you
miss them.
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|
Figure 2-4:
Automati-
cally clean
upicons.
|
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If you just want your desktop clutter to look more organized, try the other
Arrange Icons By choices, each discussed in the following list:

Name: Arrange all icons in alphabetical order using neat, vertical rows.

Size: Arrange icons according to their size, placing the smallest ones at the
top of the rows.

Type: Line up icons by their type. All WordPad files are grouped together, for
instance, as are all links to Web sites.

Modified: Arrange icons by the date they were last changed.

Auto Arrange: Automatically arrange everything in vertical rows — even
newly dumped icons are swept into rows.

Align to Grid: This option places an invisible grid on the screen, and aligns
all icons to the grid to keep them nice and tidy — no matter how hard you try
to mess them up.

Show Desktop Icons: Always keep this option turned on. When turned off,
Windows hides every icon on your desktop. If you can remember in your
frustration, click this option again to toggle your icons back on.

Lock Web Items on Desktop: If you've chosen a Web site for your desktop’s
background (covered in the next section), clicking here locks it in place.
(Rarely used.)

Run Desktop Cleanup Wizard: Discussed earlier in this chapter, this cleanup
robot automatically drops infrequently used icons in an Unused Icons folder
on your desktop.
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v These Arrange Icons By options are also available for any of your folders.
(You’ll find them under a folder’s View menu.)
v Every 60 days, the Desktop Cleanup Wizard automatically offers to clean
up your desktop. To turn off the wizard’s bimonthly offers, right-click on
a blank part of the desktop, choose Properties, and click the Desktop tab.
Choose Customize Desktop and remove the check mark from the Run
Desktop Cleanup Wizard Every 60 Days option.
. )
Jazzing up the desktop’s background
To jazz up your desktop, Windows XP covers it with pretty pictures known as
a background. (Most people refer to the background as wallpaper.) Windows
XP’s background starts as a Teletubbies-green hillside.
When you tire of the Teletubbies look, choose your own picture — any picture
stored on your computer:
1. Right-click on a blank part of the desktop, choose Properties, and
click the Desktop tab.
2. Click any of the names listed under Background to slip them onto the
little preview screen, shown in Figure 2-5.
Found a keeper? Click the OK button to stick it on your desktop. If you're
still searching, move to the next step.
Themes | Desktop | Sereen Saver 1 Appearance | Settings: |
|
Figure 2-5:
Try different
backgrounds
by clicking
their names
inthe
Background E.??'T_“””:
list box; click | | v space :
the Browse [ wind Eoron—,
5] windows P Stetch |
buttonto | |5 zapuee o
see pictures || | EDsenis7t r
from differ-
ent folders.
—— l (1]:4 ] I Cancel ] { Apply N
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3. Click the Browse button and click a file from inside your My Pictures
folder.

Most people store their digital photos in their My Pictures folder,
which lives in the My Documents folder. (I explain browsing folders
in Chapter 4.)

4. Found a good one? Click the photo and click Open to preview it.

< 5. Click OK to close the Display Properties box.

Here are some tips for sprucing up your desktop:

v As you browse through different pictures, Windows XP automatically
decides whether the image should be tiled repeatedly across the screen,
centered directly in the middle, or stretched to fill the entire screen. To
override Windows’ automatic choice, select your own preference from
the Position box.

v You can easily borrow any picture on the Internet for a background.
Right-click on the Web site’s picture and select Set as Background from
the pop-up menu. Microsoft sneakily copies the image onto your desktop
as its new background.

v To change Windows XP’s entire look, right-click on the desktop, choose
Properties, and click the Themes tab. Aimed at heavy-duty procrastina-
tors, different themes splash different colors across Windows’ various
buttons, borders, and boxes. I explain more about Themes in Chapter 11.
(If you download any themes offered on the Internet, check them with
antivirus software, covered in Chapter 10.)

Dumpster diving in the Recycle Bin

| The Recycle Bin, that little wastebasket icon in the corner of your desktop,

& works much like a real recycle bin. Shown in the margin, it lets you retrieve

Sunday’s paper when somebody has pitched the comics section before you
had a chance to read it.

You can dump something — a file or folder, for example — into the Windows
XP Recycle Bin in one of two ways:

v Simply right-click on it and choose Delete from the menu. Windows XP
asks cautiously if you're sure that you want to delete the item. Click Yes,
and Windows XP dumps it into the Recycle Bin, just as if you'd dragged
it there. Whoosh!

v For the ultimate deletion rush, click the unwanted object and poke your
keyboard’s Delete key.
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Want something back? Double-click the Recycle Bin icon to see your deleted
items. Right-click the item you want and choose Restore. The handy little
Recycle Bin returns your precious item to the same spot where you deleted
it. (You can also resuscitate deleted items by dragging them to your desktop
or any other folder.)

The Recycle Bin can get pretty crowded. If you're searching frantically for a
recently deleted file, tell the Recycle Bin to sort everything by the date and
time you deleted it. Click View, point at Arrange Icons By, and choose Date
Deleted. (The most recently deleted files are at the list’s bottom.)

To delete something permanently, just delete it from inside the Recycle Bin.
To delete everything in the Recycle Bin, right-click on the Recycle Bin and
choose Empty Recycle Bin.

To bypass the Recycle Bin completely when deleting files, hold down Shift
while pressing Delete. Poof! The deleted object disappears, ne’er to be seen
again.

v The Recycle Bin icon changes from an empty wastepaper basket to a full
one as soon as it’s holding a deleted file. You may have to squint a little
to notice the pieces of paper sticking out of the trashcan’s top.

v How long does the Recycle Bin hold onto deleted files? It waits until the
garbage consumes 10 percent of your hard drive space. Then it begins
purging your oldest deleted files to make room for the new. If you're low
on hard disk space, shrink the bin’s size by right-clicking on the Recycle
Bin and choosing Properties. Decrease the percentage to automatically
delete files more quickly; increase the percentage, and the Recycle Bin
hangs onto them a little longer.

v The Recycle Bin only saves items deleted from your own computer’s
hard drive. That means it won’t save anything deleted from a floppy, CD,
memory card, MP3 player, or digital camera.

v If you delete something from somebody else’s computer over a network,
it can never be retrieved. The Recycle Bin only holds items deleted from
your own computer, not somebody else’s computer. (For some awful
reason, the Recycle Bin on the other person’s computer doesn’t save
the item, either.) Be careful.

The Start Button’s Reason to Live

The clearly labeled Start button lives in the bottom-left corner of the desktop,
where it’s always ready for action. By clicking the Start button, you can start
programs, adjust Windows XP’s settings, find help for sticky situations, or,
thankfully, shut down Windows XP and get away from the computer for a while.
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The little Start button is so eager to please, in fact, that it starts shooting out
menus full of options as soon as you click it. Just click the button once, and
the first layer of menus pops out, as shown in Figure 2-6.

Your Start menu will change as you add more programs to your computer.
That’s why the Start menu on your friend’s computer is probably arranged
differently than the Start menu on your computer.

v Your My Documents, My Pictures, and My Music folders are always one
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click away on the Start menu. These folders are specially designed for

their contents. The My Pictures folder, for instance, displays little thumb-
nails of your digital photos. Their biggest perk? Keeping your files in
these folders helps you remember where you stored them. I cover file

organization in Chapter 4.

v Windows thoughtfully places your most frequently used programs along
the left side of the Start menu for easy point 'n’ click action.

v See the words All Programs near the Start menu’s bottom left? Click
there, and yet another menu squirts out to offer more options.

v Spot something confusing on the Start menu? Hover your mouse pointer
over the mysterious icon. Windows responds with a helpful explanatory
message. Sometimes a hovering mouse pointer summons yet another
menu, listing even more programs available in that category.

v Strangely enough, you also click the Start button when you want to stop
using Windows. (You'll click the Turn Off Computer button at the bottom,
a decision-wringing process described at this chapter’s end.)

Making Windows start programs automatically

Many people sit down at a computer, turn it on,
and go through the same mechanical process of
loading their oft-used programs. Believe it or not,
Windows XP can automate this task. The solution
is the StartUp folder, found lurking in the Start
button’s All Programs menu. When Windows XP
wakes up, it peeks inside that StartUp folder. If
it finds a program lurking inside, it immediately
tosses that program onto the screen.

To make your favorite programs wake up along
with Windows XP, follow these steps:

1. Right-click on the Start menu's Startup icon
and choose Open.

The Startup icon, which lives in the Start
menu’s All Programs area, opens as a folder.

. While holding down the Alt key, drag and

drop any of your favorite programs or files
into the StartUp folder.

You must hold down Alt, as that turns your
newly dropped items into shortcuts. You don't
want to drop the actual programs or files.

. Close the Startup folder.

Now, whenever you start Windows XP from
scratch, those programs or files load up right
along with it.
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The Start menu’s prime real estate

When the Start menu pops up, shown earlier in Figure 2-6, it always shows you
the items listed below, from top to bottom. You’ll use these things constantly
in Windows, so if you're already bored with this Start button section, please
feign interest through the following explanations.

If you find Start menus exciting, you’ll love the upcoming “Customizing
the Start menu” section, which explains how to rearrange your entire
Start menu.

Internet Explorer: This lets you visit the Internet, covered in Chapter 8.

Outlook Express: Choose this to send or receive e-mail, covered in Chapter 9.

Recently Used Programs: The Start menu lists your six most frequently used
programs’ icons above the Start button for easy clicking.

My Documents: Always store your documents in this folder so you’ll know
where to find them later.

My Pictures: Keep your digital pictures in this folder. Each picture’s icon is a
tiny thumbnail image of its picture.
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My Music: Store your digital music in here so Media Player can find and play
it more easily.

My Computer: This displays your computer’s storage areas: folders, disk
drives, CD drives, digital cameras, and other attached goodies.

My Network Places: If your computer connects with other computers
through a network, click here to visit them.

Control Panel: This lets you adjust your computer’s oodles of confusing set-
tings, all described in Chapter 11.

Help and Support: Befuddled? Click here for an answer. (Chapter 20 explains
the stoic Windows Help system.)

Search: When you can’t find something on your computer, click here to make
Windows find it. (I explain the Windows Search system in Chapter 6.)

Run: Used mostly by computing veterans, this launches a program if you
type in its precise name and location.

Log Off: Click here either to let somebody else use the computer, or to save
your work and let the computer rest until others use it.

Turn Off Computer: Click this button to restart the computer, turn it off, or
let it sit resting in Standby mode.

Starting a program from the Start menu

This one’s easy. Click the Start button, and the Start menu pops out of the
button’s head. If you see an icon for your desired program, click it, and
Windows loads the program.

If your program isn’t listed, though, click All Programs, near the bottom of
the Start menu. Yet another menu pops up, this one listing the names of pro-
grams and folders full of programs. Spot your program? Click the name, and
Windows kicks that program to the front of the screen.

If you still don’t see your program listed, try pointing at the tiny folders listed
on the menu. New menus fly out of those folders, as shown in Figure 2-7, list-
ing even more programs.
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When you finally spot your program’s name, just click it. In fact, you never
have to actually click the Start menu until you see your desired program’s
name. The Start menu opens and closes its menus automatically as you move
your mouse pointer near them.

v~ Still don’t see your program listed by name? Then head for Chapter 6
and find the section on finding lost files and folders. Windows XP can
track down your missing program.

1 Sometimes a little organization works wonders. Right-click on any item
on the All Programs menu and choose Sort by Name to alphabetize the
entire stack, with folders at the top.

v There’s another way to load a lost program — if you can find something
you created or edited with that program. For instance, if you wrote let-
ters to the tax collector using Microsoft Word, double-click one of your
tax letters to bring Microsoft Word to the screen from its hiding place.

v If you don’t know how to navigate through your folders, visit Chapter 4.
That chapter helps you move gracefully from folder to folder, decreasing
the time it takes to stumble across your file.
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Customizing the Start menu

The Windows XP Start menu works great — until you're hankering for some-

thing that’s not listed on the menu, or something you rarely use is just getting
in the way.

v To add a favorite program’s icon to the Start button’s menu, right-click
on the program’s icon and choose Pin to Start Menu from the pop-up
menu. Windows copies that icon to your Start menu'’s left column.

(From there, you may drag it to the All Programs area, if you wish.)

v To purge unwanted icons from the Start menu’s left column, right-click
on them and choose either Unpin from Start Menu or Remove from This
List. (Removing an icon from the Start menu doesn’t remove the actual

program from your computer; it just removes one of many push buttons
that launch it.)

When you install a program, as described in Chapter 11, the program
almost always adds itself to the Start menu automatically. Then the pro-
gram boldly announces its presence, as shown in Figure 2-8. Click All

Programs and then follow the highlighted menu items that lead to your
newly installed program.

‘ Andy)
g !ntternreE . 7 My Documents
Internet Explorer
@ Fomail ) LE} My Recent Documents »
Outlook Express :J My Pictures
‘IJ Pairt _’:f My Music
Figure 2-8: C') "4 My Computer
Windows Media Player -
MOSt nery = ‘.J) My Network Places
installed | [T waepad
programs '. & Control Panel
a d d th em- @ Tour ‘Windows ¥P @ SetF Pr‘ugram Access and
- Defaults
Se|VeS to the 1’ 1S Explorer 8 .5IJ Printers and Faxes
Startmenu's | _ _
A" PrOg rams ';& Windows Movie Maker t)} pepandstpect
area and o) seath
announce All Programs | 77 Run...
the Ir New programs installed. |, . o Computer
presence.
e | i3}
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To stop newly installed programs from announcing their presence, check out
Table 2-1.

You can customize the Start menu even more by changing its properties. To
start playing, right-click on the Start button, choose Properties, and click the
Customize button. See Table 2-1 for the rundown and my recommendations.

Table 2-1 Customizing the Start Menu Properties
Setting My Recommendations
Icon Size Switching to small icons packs more icons onto the menu,

yet keeps them easily recognizable.

Programs Try increasing the number of frequently used programs to
about 15. That lets the Start menu display nearly all my fre-
quently used programs with a single click.

Show on Start Menu  The Start menu normally lists Internet Explorer and Outlook
along its top. Click here to show other programs, instead.

Advanced tab Although you can go wild here, | don’t change much. | turn
off Highlight Newly Installed Programs to stop new programs
from sending their annoying announcement pop-ups. Then,
under Start menu items, | choose Display as a Menu for the
Control Panel. That lets me browse the Control Panel’s
options directly from the Start menu, saving plenty of time. |
leave the rest as is, but feel free to experiment when you're
bored at the office.

Here’s a dirty little secret: The Start menu isn’t really anything special. It’s
simply one of many folders on your hard drive. In fact, your entire desktop is
just a folder, too. Chapter 4 shows how to explore the folders living on your
hard drive, so don’t be surprised when you discover folders named Desktop
and Start Menu in your C drive’s Documents and Settings folder.

Bellying Up to the Taskbar

This section introduces one of Windows XP’s handiest tricks, so pull in your
chair a little closer. Whenever you run more than one window on the desktop,
there’s a big problem: Programs and windows tend to cover each other up,
making them difficult to locate.
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|
Figure 2-9:
Click buttons
for currently
running
programs on
the taskbar.
|
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Windows XP’s solution is the faskbar — a special program that keeps track of
all your open programs. Shown in Figure 2-9, the taskbar normally lives along
the bottom of your screen, although you can move it to any edge you want.
(Hint: Just drag it from edge to edge. If it doesn’t move, right-click on the
taskbar and click Lock the Taskbar to remove the check mark by its name.)

Windows automatically keeps your clock accurate.

Click here to see more icons.

o T
& Andy Rathbone's Boo... | M Freecell Game #27013 @E SRR 1zePm J
Il ol 4/ e
I I

Click any minimized program to return it to the screen.

See how the button for Calculator looks pushed in in Figure 2-9? That’s
because Calculator is the currently active window on the desktop: It’s
the program currently accepting your keystrokes. One or more of your
taskbar’s buttons always look pushed in unless you close or minimize
all the windows on your desktop.

From the taskbar, you can perform powerful magic on your open windows,
as described in the following list:

v To play with a program listed on the taskbar, click its name. The window
rises to the surface and rests atop any other open windows, ready for
action.

v To close a window listed on the taskbar, right-click on its name and choose
Close from the pop-up menu. The program quits, just as if you'd chosen
its Exit command from within its own window. (The departing program
gives you a chance to save your work before it quits and walks off the
screen.)

v Don’t see the taskbar? If only the taskbar’s top edge peeks up along the
screen’s bottom, grab the visible part with your mouse and drag it upward
until the entire taskbar is visible. (Consider right-clicking on the taskbar
and choosing Lock the Taskbar to keep it locked in place.)

v Ever wander inadvertently into a Web site’s pop-up window trap, and
pop-up ads explode onto your screen? The taskbar stacks all those open
Internet Explorer windows onto one button on the taskbar. Right-click on
the Internet Explorer button and choose Close Group to close Internet
Explorer — including all those renegade pop-ups. (If you're still seeing
obnoxious pop-up ads, install Windows XP’s second Service Pack,
described in Chapter 1. See Chapter 8 for details on blocking pop-ups.
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Shrinking windows to the taskbar
and retrieving them

Windows spawn windows. You start with one window to write a letter of
praise to the local opera house. You open another window to check an
address, for example, and then yet another to see whether you’ve forgotten
any upcoming shows. Before you know it, four more windows are crowded
across the desktop.

To combat the clutter, Windows XP provides a simple means of window con-
trol: You can transform a window from a screen-cluttering square into a tiny
button on the taskbar, which sits along the bottom of the screen. The solution
is the Minimize button.

See the three buttons lurking in just about every window’s top-right corner?
Click the Minimize button — the button with the little line in it, as shown in
the margin. Whoosh! The window disappears, represented by its little button
on the taskbar at your screen’s bottom.

v To make a minimized program on the taskbar revert into a regular, on-
screen window, just click its name on the taskbar. Pretty simple, huh?

v Each taskbar button shows the name of the program it represents.

v When you minimize a window, you neither destroy its contents nor close
the program. And when you click the window’s name on the taskbar, it
reopens to the same size you left it, showing its same contents.

v Whenever you load a program, its name automatically appears on the
taskbar. If one of your open windows ever gets lost on your desktop,
click its name on the taskbar to bring it to the forefront.

Clicking the taskbar’s sensitive areas

Like a crafty card player, the taskbar comes with a few tips and tricks. You
can see some of them in Figure 2-10. Here’s the lowdown:

+* Clock: Hold the mouse pointer over the clock, and Windows XP shows
the current day and date. Or if you want to change the time or date, a
double-click on the clock summons the Windows XP time/date change
program.

v Double arrows: Sometimes the taskbar hides things. Click the little
double arrows next to the clock (refer to Figure 2-10), and a few more
icons might slide out. (Check out the “Customizing the taskbar” section,
later in this chapter, for tips and tricks affecting these icons.)
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Figure 2-10:
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Figure 2-11:
Change the
volume.
|

v~ Speaker: Click the little speaker to adjust the sound card’s volume, as
shown in Figure 2-11. Or double-click the little speaker to bring up a
mixing panel. Mixers let you adjust separate volume levels for your
microphone, line inputs, CD and DVD players, and other features.

1 Other icons: These often appear next to the clock, depending on what
Windows XP is up to. If you're printing, for example, a little printer icon
appears there. Laptops often show a battery-power-level gauge. As with
all the other icons down there, if you double-click the printer or battery
gauge, Windows XP brings up information about the printer’s or battery’s
status.

v Blank part: This part of the taskbar hides a menu of options. Want to
minimize all your desktop’s open windows in a hurry? Right-click on a
blank part of the taskbar and choose Minimize All Windows from the
pop-up menu.

To organize your open windows, right-click on a blank part of the taskbar
and choose one of the tile commands. Windows XP scoops up all your
open windows and lays them back down in neat, orderly squares. (I cover
tiling in more detail in Chapter 3.)

Volume Disconnect USB gadgets (cameras and MP3 players)

Time settings

|
(\;’T$‘%’$§i 2:|31PM |

Printer | Security settings

Hidden icons

Windows Messenger

Yolume

i

[ kute

Customizing the taskbar

Windows XP brings a whirlwind of new options for the lowly taskbar, letting
you play with it in more ways than a strand of spaghetti and a fork. Right-click
on the Start button, choose the Properties option, and click the Taskbar tab to
start playing. Table 2-2 explains the options, as well as my recommendations
for them. (You need to remove the check mark by Lock the Taskbar before
some of these options will work.)
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Table 2-2 Customizing the Taskbar
Setting My Recommendations
Lock the Taskbar Clicking here makes Windows XP lock the taskbar in

place, keeping you from changing its look. You cant drag
it upward to make it larger, for instance. Lock it, but only
after the taskbar is set up the way you like.

Auto-Hide the Taskbar  Selecting this option makes the taskbar automatically hide
itself when you're not near it. (Point at the taskbar to bring
it back up.) | leave this unchecked to keep the taskbar
always in view.

Keep the Taskbar on This keeps the taskbar always visible, covering up any win-
Top of Other Windows  dows that may be low on the screen. | leave this checked.

Group Similar Taskbar ~ When you open lots of windows and programs, Windows

Buttons accommodates the crowd by grouping similar windows
under one button: All Internet Explorer buttons stack on
one button, for instance. This option protects the taskbar
from overcrowding, so keep it checked.

Show the Clock You want to know when it's time to leave work, don’t you?
Leave this checked.

Hide Inactive Icons This lets you hide those little icons — like the volume
control, printer button, desktop cleanup program, and
other goodies — that hang out by your clock. Click the
Customize button to choose which icons should stay visi-
ble, which should hide, and which should appear only
when being used. | click the Restore defaults button and
leave ‘em alone.

Feel free to experiment with the taskbar, changing its size and position until it
looks right for you. It won’t break. After you set it up just the way you want,
select the Lock the Taskbar check box described in Table 2-2.

The taskbar’s crazy toolbars

Your taskbar won’t always be a steadfast, unchanging friend. Microsoft lets
you customize it even further, often beyond the point of recognition. Some
people enjoy this toolbar gadgetry, sculpting extra buttons and bars onto their
taskbars. Others accidentally turn on a toolbar and can’t figure out how to
get rid of the darn thing.

To turn a toolbar on or off, right-click on a blank part of the taskbar (even the
clock will do) and choose Toolbars from the pop-up menu. A menu leaps out,
offering the options described in the following list:
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v Address: Choose this, and part of your taskbar becomes a place for
typing in Web sites to visit, as shown in Figure 2-12. It’s convenient, but
so is Internet Explorer, which does the same thing.

v Windows Media Player: When turned on, this toolbar turns into a little
button panel for controlling your minimized Windows Media Player.
(Tip: Click where the arrow points in Figure 2-13 to browse your music.)

v Links: This toolbar adds quick access to your favorite Web sites; just
click where the arrow points in Figure 2-14. (This toolbar displays all the
links in the Links folder of Internet Explorer’s Favorites menu.)

v Desktop: Shown in Figure 2-15, this places all your desktop icons — plus
a miniature My Computer program — onto the taskbar, letting you browse
through files by wading up through all the menus.

e v Quick Launch: The only toolbar I use, this places an arsenal of favorite

a icons, as shown in Figure 2-16, next to your Start button: Internet Explorer,
Outlook Express, Media Player, and the “shrink everything from the desk-
top” icon shown in the margin. (Add your own icons to the toolbar by
dragging and dropping them.)

v New Toolbar: Click here and choose any folder to add as a toolbar. For
instance, choose your My Documents folder (shown in Figure 2-17) for
quick browsable access to all its files and folders.

|
Figure 2-12:
The Address ' “address| v, andyrathbone.com | ¥ ,_jeoj%@ 917 PM '
toolbar.
|
% Mo Disc in Drive (F3)
I 2 HNo Disc in Drive (G:)
. _12- l+] Albums 4
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The A Genres >
i [¥] My Playlists 4
Wmdovys |2} Auto Playlists 4
Media & Radio Stations 12
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toolbar. B All Video
— | T LOOODED Q) seomm
2 Amazon.com Music - Essential CDs
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Figure 2-15:
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: s The taskbar’s tiny toolbars don’t leave much room for aiming. For instance,
Links E click the ridiculously small arrows next to a toolbar’s name (shown in the
margin) to view its menu, shown popping up from the toolbars in Figures 2-14,
,and 2-17.

2-15

v Toolbars are supposed to be dragged around with the mouse. When
the taskbar is unlocked, grab the toolbar by its handle, a vertical line
by the toolbar’s name. Drag the handle to the left or right to change a

\\3

toolbar’s size.

to freeze everything in place.

v Toolbars can be dragged off the taskbar and dropped anywhere on the
desktop. If this happens to you by mistake, drag the toolbar back onto
the taskbar; keep trying, the toolbar will eventually stick. Then drag the
renegade’s handle to the right or left, adjusting it to the right size and
position. Finally, right-click on your taskbar and choose Lock the Taskbar
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Logging Off from Windows
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Ah! The most pleasant thing you’ll do with Windows XP all day could very
well be to stop using it. And you do that the same way you started: by using
the Start button, that friendly little helper you’'ve been using all along. (And
if the Start menu is hiding, hold down Ctrl and press Esc to bring it back from
behind the trees.) Two options live along the bottom of the Start menu: Log
Off and Turn Off Computer.

Be sure to shut down Windows XP through its official Off options before
physically turning off your computer. Otherwise, Windows XP can’t properly
prepare your computer for the dramatic event, leading to future troubles.

From the Start menu, should you Log Off or Turn Off the Computer? Here are
the generally accepted guidelines:

v Log Off: Choose this when you’re through working with Windows XP for
the time being. Unable to let go, Windows will toss yet another question
in your face, as shown in Figure 2-18. Which option do you choose?

¢ Log Off: If you're really through with the computer, choose Log Off.
Windows saves your work and your settings, and returns to the
Welcome screen, ready for the next user to log on.

¢ Switch User: If somebody else just wants to borrow the computer
for a few minutes, choose Switch User. The Welcome screen appears,
but Windows keeps your open programs waiting in the background.
When you switch back, everything’s just as you left it. (Personally,
I think Logging Off makes more sense.)

+* Turn Off Computer: Choose this option when nobody else will be using
the computer until the next morning. Windows XP saves everything and
tells you when it’s okay to turn off your computer. (Sometimes it turns it
off for you.) When you choose Turn Off Computer, Windows clings like a
sleepy cat, tossing up the three options shown in Figure 2-19:

¢ Standby: Also called Hibernate on some laptops, this option quickly
saves all your work and puts the computer in virtual sleep — a deli-
cate mode between on and off. Avoid it.

e Turn Off: Choose this option when you’re done for the day. Let
you — and your computer — get some real sleep. When Windows
XP leaves the screen, turn off the computer and the monitor, if
Windows XP doesn’t do it automatically.

¢ Restart: Only choose this option when Windows XP screwed some-
thing up: Several programs crashed, or Windows seems to be acting
awfully weird. Windows XP turns off and reloads itself, hopefully
feeling refreshed.
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Log Off Windows

Turn off computer

Stand By

Cancel

When you tell Windows XP that you want to quit, it searches through all your
open windows to see whether you've saved all your work. If it finds any work
you've forgotten to save, it tosses a box your way, letting you click the OK
button to save it. Whew!

You don’t have to shut down Windows XP. In fact, some people leave their
computers turned on all the time, saying it’s better for their health. Others
say their computers are healthier if they’re turned off each day. However,
everybody says to turn off your monitor when you’re done working. Monitors
definitely enjoy cooling down when not being used.
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Chapter 3
Basic Windows Mechanics

In This Chapter

Understanding a window’s parts

Manipulating buttons, bars, and boxes
Finding and using menus

Paging through a document in a window
Filling out forms

Moving windows and changing their size

Fis chapter is for curious Windows anatomy students. You know who you
are — you're the ones who see all those buttons, borders, and balloons
scattered throughout Windows XP and wonder what would happen if you just
clicked that little thing over there.

This rather gruesome chapter tosses an ordinary window (your oft-used My
Documents folder, to be precise) onto the dissection table. I've yanked out
each part for thorough labeling and explanation. You'll find the theory behind
each one and required procedures for making each piece do your bidding.

A standard field guide follows, identifying and explaining the buttons, boxes,
windows, bars, lists, and other oddities you may encounter when you're trying
to make Windows XP do something useful.

Feel free to don any protective gear you may have lying about, use the margins
to scribble notes, and tread forcefully into the world of Windows.

Dissecting a Typical Window

Figure 3-1 places a typical window on the slab, with all its parts labeled. You
might recognize it as your My Documents window, that storage tank for most
of your work.
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Just as boxers grimace differently depending on where they’ve been punched,
windows behave differently depending on where they’ve been clicked. The
next few sections describe where to click the labeled parts of the window and
how Windows jerks in response.

v Windows XP is full of little weird-shaped buttons, borders, and boxes.
It’s not important to remember all their names. Most items can be dealt
with by simply clicking, double-clicking, or right-clicking, a decision
explained in the nearby sidebar, “Clicking, double-clicking, and right-
clicking strategies.” (Spoiler: When in doubt, always right-click.)

v After you click a few windows a few times, you realize how easy it is
to boss them around. The hard part is finding the right controls for the
first time, like rummaging for the windshield wipers in a rental car.
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Tugging on a window'’s title bar

Found atop nearly every window (see Figure 3-2 and the top of Figure 3-1),
the ho-hum title bar lists the name of the program and the file it’s currently
working on. For example, Figure 3-2 shows the title bar from Windows XP’s
Notepad program. It lists an unnamed file because you haven’t had a chance
to save and name the file yet. (It may be full of notes you’ve jotted down from
an energetic phone conversation with Ed McMahon.)

|

Figure 3-2:

AlgtllltTe bar (j‘. Untitled - Notepad @@
|
A\

Like Peter Parker, the Amazing Spider-man, the boring title bar sports hidden
superpowers, described in the following tips:

v~ Title bars make convenient handles for moving windows around the
desktop. Point at the title bar, hold down the mouse button, and move
the mouse around: The window follows along as you move your mouse.
Found the right location? Let go of the mouse button, and the window
sets up camp in its new spot.

v Double-click a title bar to make the window fill the entire screen. Double-
click it again to shrink the window back to the first size.

v The window you’re currently working with always has a highlighted title
bar — it’s a different color from the title bars of any other open windows.
By glancing at all the title bars on the screen, you can quickly tell which
window is awake and accepting anything you type.

Barking out orders with the menu bar

Windows XP has more menu items than an Asian restaurant. To keep every-
body’s minds on computer commands instead of seaweed salad, Windows
disguises its menus behind the menu bar (see Figure 3-3).

|
Figure 3-3:
The menu [File Edit Format View Help
bar.
|
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Clicking, double-clicking, and
right-clicking strategies

Clicking or double-clicking your mouse will con-
trol nearly everything in Windows, yet Microsoft
seems befuddled when defining the difference
between the two finger actions. Microsoft says
to click when selecting something, and double-
click when choosing something. Huh?

You're selecting something when you're high-
lighting it. For example, you click in a box, on a
window, or on a filename to selectit. That click
usually highlightsthe item, preparing it for further
action.

Choosing something, by contrast, is much
more decisive. An authoritative double-click on
a file convinces Windows to open it for you
immediately.

Microsoft's theoretical hierarchies bore me, so |
almost always take the third option and right-
click on things. Right-click on nearly anything to
see a little menu listing everything it can do. | click
the option | want, and Windows does my bidding.

The moral? When in doubt, right-click.

Perched on a ledge below the title bar, the menu bar hides a different menu
below each word. To reveal the secret options, click any word — Edit, for
instance. A menu tumbles down, as shown in Figure 3-4, presenting options

related to editing a file.

Just as restaurants sometimes run out of specials, a window sometimes isn’t
capable of offering all its menu items. Any unavailable options are grayed out,

& Unlucky dinosaurs - Notepad B[®]=]
File | Edit, Format View Help
R e
Inas ago, a huge asteroid wiped out the
entire your work often. It could happen
| again
Figure 3-4: -
Click Find... Ctrl+F
Ick any Find Next F3
menu to Replace... Ctrl+H
see its '
associated Select All Ctrl+A
commands. Time/Date F5
|
like the Undo, Cut, Copy, Paste, Delete, and Go To options in Figure 3-4.
A\

If you accidentally click the wrong word, causing the wrong menu to jump
down, simply click the word you really wanted. A forgiving soul, Windows
retracts the mistaken menu and displays your newly chosen one.
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|
Figure 3-5:
Standard
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toolbar.
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To back out of Menu Land completely, click the mouse pointer back down on
your work in the window’s workspace — the area where you’re supposed to
be working.

For the convenience of keyboard lovers, previous Windows versions underlined
one letter of a menu item. Mouse haters could press the Alt key followed by the
underlined letter — the Fin File, for instance — to make Windows display

the File menu. Windows XP removes the underlines, but they quickly reappear
when you press Alt. (The underlines disappear again if you press Alt a second
time, a convenient escape if you find yourself trapped in a sea of menus.)

Playing with a window'’s Standard
Buttons toolbar

In a bizarre effort to blur the difference between Windows XP and the
Internet, Microsoft added a strip of buttons (shown in Figure 3-5) beneath
each window’s menu bar. Officially dubbed the Standard Buttons toolbar,
some of the buttons work much like the ones found on Internet Explorer,
which I cover in Chapter 8.

C(Deak - £) - ﬁ ) search Folders '
<) -/

Each colorful button performs a common Windows chore — a quick jump to
a different folder, for instance. If a button’s meaning isn’t immediately obvious,
hover your mouse over it; a little message explains the button’s raison d’étre.
My own translations are in the bullets that follow:

v The large Back and Forward arrows let you navigate through folders the
same way you cruise the Internet. When racing through a long string of
folders, Windows remembers your path; click the Back or Forward arrows
to move backward or forward along your journey, revisiting folders you've
previously viewed.

v The folder with the upward escaping arrow (shown in the margin) lets
you move upward through your folders. For example, when visiting your
My Pictures folder (which lives inside your My Documents folder), click
this Upward button to visit your My Documents folder upstairs.

v The Search button is simply a shortcut to the Start menu’s Search com-
mand, which lets you ferret out information from your computer or the
Internet. (I cover searching in Chapter 6.)
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v Clicking the Folders button whisks away the handy task pane (covered
later in this chapter), replacing it with a tree view of all your folders. By
viewing your folders as branches sprouting from one source, you can
easily jump from one branch to another: Leap directly to your CD drive,
for instance, your Recycle Bin, a distant folder, or even a different com-
puter on the office network. (Click the Folders button again to bring back
the task pane.)

v Easily the most boring button (shown in the margin), the Views button
E hal may be the most useful: It makes the window display your files in differ-
ent ways. Choose Details, for instance, to view everything you wanted to
know about a file: its size, creation date, and other minutia. The List view
packs as many filenames onto the screen as possible. Taste 'em all and
then stick with your favorite. (Windows normally uses the Icons view.)

Moving inside a window with its scroll bar

The scroll bar, which resembles a cutaway of an elevator shaft (see Figure 3-6),
rests along the edge of all over-stuffed windows. Inside the shaft, a little eleva-
tor (technically, the scroll box) rides up and down as you page through your
work. In fact, by glancing at the elevator’s position in the shaft, you can tell
whether you’re viewing the top, middle, or bottom of a window’s contents.

=]

|

Figure 3-6:
A scroll bar.
| M

You can watch the little box travel up or down as you press the PgUp or PgDn
key. (Yes, it’s easy to get distracted in Windows XP.) But it’s more fun to nudge
the elevator around with the mouse. By clicking in various places on the scroll
bar, you can quickly move around inside a document. Here’s the dirt:

v Clicking in the shaft above the elevator shifts your view up one page, just
as if you'd pressed the PgUp key. Similarly, clicking below the elevator
shifts the view down one page.

v To move your view up line by line, click the little arrow (the scroll arrow)
at the top of the scroll bar. Similarly, clicking the little arrow at the bottom
moves your view down one line with each click.
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v Scroll bars occasionally hang out along a window’s bottom edge. Handy
for viewing spreadsheets and other wide documents, scroll bars let you
move your view sideways for peeking at the totals in the spreadsheet’s
last column.

v No little scroll box in the bar? Then you're already seeing all that the
window has to offer. No little elevator to play with.

v To move around in a hurry, drag the scroll box up or down the bar. As
you drag it up or down, you see the window’s contents race past. When
you see the spot you want, let go of the mouse button to stay at that
viewing position.

v Using a mouse that has a little wheel embedded in the poor critter’s back?
Spin the wheel, and the list moves up or down, just as if you were playing
with the scroll bar.

Ouick shortcuts with the
Windows XP task pane

To give its users a handy alternative to random guessing, Windows XP’s fold-
ers now sport a task pane, shown in Figure 3-7. Hugging the left side of most
folders, the task pane lists common chores customized to what you're viewing.
The task pane in your My Pictures folder displays picture-related tasks: Print
This Picture, for instance, or View as a Slideshow. Click any listed task, and
Windows does your bidding.

Dragging, dropping, and running

Although the term drag and drop sounds as if it's
straight out of a Sopranos episode, it's really a
nonviolent mouse trick used in Windows XP.
Dragging and dropping is a way of moving
something — say, an icon on your desktop —
from one place to another.

To drag, put the mouse pointer over the icon and
hold downthe left or right mouse button. (I prefer
the right mouse button.) As you move the mouse
across your desk, the pointer drags the icon
across the screen. Place the pointer/icon where
you want it and release the mouse button. The
icon drops, unharmed.

Holding down the right mouse button while drag-
ging and dropping makes Windows XP toss up a
helpful little menu, asking whether you want to
copy or move the icon.

Helpful Tip Department: Started dragging some-
thing and realized midstream that you're drag-
ging the wrong item? Breathe deeply like a yoga
instructor and press Esc to cancel the action.
Whew! (If you've dragged with your right mouse
button and already let go of the button, there’s
another exit: Choose Cancel from the pop-up
menu.)
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Clicking an individual file brings the task pane’s Details area into action. There,
at the bottom of the task pane, you'll see your chosen file’s size, description,
and if you've selected a picture that’s not currently displayed, a tiny preview.
v The rather thick and colorful task pane has absolutely no relation to the
taskbar, that thin strip along the bottom of your desktop. (I introduce the
taskbar in Chapter 2.)
v~ If the task pane bashfully hides some of its tasks, click the hidden cate-
ory’s little double-arrow thing (shown in the margin). The applicable
' ’s little doubl th h th Th licabl
tasks will spring back into view. (Click it again to hide those tasks, if
you wish.)
v Can’t find your task pane? Clicking the Folders button along the top of
your folder sometimes brings it into view.
e\(Jx\. Sry& v If you think the task pane consumes too much screen space, turn it off:

Choose Folder Options from the window’s Tools menu, click the General
Tab, and choose Use Windows Classic Folders. (Reverse those steps to
revive a missing task pane.)
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v If Windows shows the wrong task pane for your particular folder — it
shows the My Pictures task pane in your My Music folder, for instance —
fix it this way: Choose Folder Options from the Tools menu, click the View
tab, and choose Reset All Folders.

Boring borders

A border is that thin edge surrounding a window. Compared with a bar, it’s
really tiny.

v To change a window’s size, drag the border in or out. (Dragging by the
corner gives you even more leeway.)

v Some windows, oddly enough, don’t have borders. That means you can’t

change their size, unfortunately, even if they’re way too small.

v~ Except for tugging on them with the mouse, you won’t be using bor-

ders much.

Transforming a mere folder into Internet Explorer

Toolbars are optional strips of buttons or controls
that live near the top of a window by the menu
bar and title bar. Folders come with three tool-
bars, accessed by choosing Toolbars from the
folder's View menu. The Standard Buttons tool-
bar, described in its own section, adds handy
push buttons to perform common tasks. But
what's the deal with the Address and Links tool-
bars? Believe it or not, those toolbars let you
turn folders into Internet Explorer.

v+ Address toolbar: Clicking the down arrow in
Internet Explorer’s Address toolbar displays
links to sites you've visited. Similarly, click-
ing that same arrow on a folder’s Address
toolbar lists popular Windows destinations:
disk drives, your desktop, frequently used
folders, the Control Panel, and more. Click
any item — your My Documents folder, for
instance — to jump there immediately.

v~ Links toolbar: This toolbar shows your favor-
ite Web links along the top, effectively trans-
forming your folder into Internet Explorer.
When you click a link, you jump to that Web
page. For a kick, click the Back arrow atop
Internet Explorer, and it transforms back
into the folder you just left.

To make these toolbars appear, click View from
the window's menu bar. Then click Toolbars, and
a drop-down menu lists the toolbars that partic-
ular window offers. Click the missing bar’s name
so that a check mark appears next to its name.
(Don't like a certain bar? Click that toolbar’s
name to uncheck it and wipe it from the screen.)

If you're satisfied with the strips of buttons and
commands along your window’s top, choose
Lock the Toolbars (also on the View menu) to lock
themin place. That keeps you from accidentally
changing a toolbar; they're easy to reposition,
especially with an inadvertent drag of the mouse.
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Filling Out Bothersome Dialog Boxes

Sooner or later, Windows XP will lapse into surly clerk mode, forcing you to
fill out a bothersome form before carrying out your request. To handle this
computerized paperwork, Windows XP uses a dialog box.

A dialog box is simply a window. But instead of containing a program, it
contains a little form or checklist for you to fill out. These forms can have
bunches of different parts, all discussed in the following sections. Don’t
bother trying to remember each part’s name. It’s much more important to
remember how they work.

Poking the correct command button

Command buttons may be the simplest part of a form to figure out — Microsoft
labeled them! Command buttons usually require poking after you've filled out
a form. Based on the command button you click, Windows either carries out
your bidding (rare) or sends you another form (most likely).

Table 3-1 identifies some of the more common command buttons strewn

throughout Windows XP.

Table 3-1 Common Windows XP Command Buttons

Command Button Description

A click on the OK button says, “I've finished the form, and
I'm ready to move on.” Windows XP reads what you've
typed and processes your request.

If you've somehow loused things up when filling out a
form, click the Cancel button. Windows whisks away the
form, and everything returns to normal. Whew!

Boy, would this have come in handy in elementary school!

[ Net> | Click the Back button, and Windows returns you to the

Mext 4

(e ] previous window so that you can change your answer.
Click the Next button to move to the next question.

If you encounter a button with dots (. . . ) after the word,

brace yourself: Clicking that button brings yet another

form to the screen. From there, you must choose even
more settings, options, or toppings.
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v Sometimes you’ll change a setting that makes things looks weird: For
example, a long-loved toolbar will disappear. To bring Windows XP’s
freshly installed look back to a certain form or program, click the
Restore Default button with full force.

v The OK button usually has a slightly darker border than the others,
meaning it’s highlighted. Just pressing Enter automatically chooses the
form’s highlighted button, sparing you the inconvenience of clicking it.
(T usually click it anyways, just to make sure.)

If you've clicked the wrong button but haven't yet lifted your finger from the
mouse button, stop! There’s still hope. Command buttons take effect only
after you've lifted your finger from the mouse button. Keep holding down the
mouse, but scoot the pointer away from the wrong button. When the pointer
no longer rests on the button, gently lift your finger. Whew! Try that trick on
any elevator.

Did you stumble across a box that contains a confusing option? Click the
question mark in the box’s upper-right corner (it will look like the one in the
margin). Then click the confusing command button to see a short explana-
tion of that button’s function in life. Sometimes merely resting your mouse
pointer over a confusing button makes Windows take pity, sending a helpful
caption to explain matters.

Choosing between option buttons

Sometimes, Windows XP gets ornery and forces you to select a single option.
For example, you can elect to eat your Brussels sprouts or not eat your Brussels
sprouts. You can’t select both, so Windows XP doesn’t let you select both of
the options.

Windows XP handles this situation with an option button. When you select one
option, the little dot hops over to it. Select the other option, and the little dot
hops over to it, instead. You find option buttons in many dialog boxes, like the
one in Figure 3-8.

v~ If you can select more than one option, Windows XP won’t present you
with option buttons. Instead, it offers the more liberal check boxes, which
are described in the “Check boxes” section, later in this chapter.

v Some old-time computer engineers refer to option buttons as radio but-
tons, after those push buttons on car radios that switch from station to
station, one station at a time.
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Figure 3-8: ~ Ditino
Select an O Eat Bruzzels sprouts
option (®) Let Brussels sprouts rat

Typing into text boxes

A text box works like a fill-in-the-blanks test in history class. You can type any-
thing you want into a text box — words, numbers, passwords, or epithets. For
example, Figure 3-9 shows a dialog box that pops up when you want to search
for some words or characters in some programs. The text box is where you

type the words you want to search for.

v When a text box is active (that is, ready for you to start typing stuff
into it), either the box’s current information is highlighted or a cursor

is blinking inside it.

v~ If the text box isn’t highlighted or there isn’t a blinking cursor inside it,
it’s not ready for you to start typing. To announce your presence, click
inside it before typing.

v If you need to use a text box that already contains words, remember to
delete any text you don’t want before you start typing in new information.
(Or you can double-click the old information to highlight it; that way, the

incoming text automatically replaces the old text.)

v Yes, text boxes have way too many rules.

I
B[]

Figure 3-9: [~
This dlalog Find what: & good cigar..|

box contains [] Match whole word only

atext box. | [JMatchcase
|

Choosing options from list boxes

Some boxes don’t let you type anything into them. They simply display lists of
things, letting you pluck the items you want. Boxes of lists are called, appro-
priately enough, list boxes. For example, some word processors bring up a list
box if you're inspired enough to want to change the font — the style of the

letters (see Figure 3-10).
v See how the Comic Sans MS font is highlighted in Figure 3-10? It’s the cur-

rently selected item in the list box. Press Enter (or click the OK button),
and your program begins using that font when you start typing.
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v~ See the scroll bar along the side of the list box? It works just as it does
anywhere else: Click the little scroll arrows (or press the up or down
arrow) to move the list up or down, and you can see any names that
don’t fit in the box.

1 Some list boxes have a text box above them. When you click a name in
the list box, that name hops into the text box. Sure, you could type the
name into the text box yourself, but it wouldn’t be nearly as much fun.

\P . s . .

P v When confronted with zillions of names in a list box or folder, type the
first letter of the name you're after. Windows XP immediately hops down
the list to the first name beginning with that letter.

Fart:
.| Comic Sans M5
Figure 3-10: g Arcl lack >
Selecta | | Comic Sans S

Courier
font from €} Courier Mew

the list box. ) Estrangelo Edessa

Fizedsyz
|
Drop-down list boxes
List boxes are convenient, but they take up a great deal of room. So, Windows
XP sometimes hides list boxes, just as it hides pull-down menus. When you
click in the right place, the list box appears, ready for your perusal.
So, where’s the right place? It’s that downward-pointing arrow button, just
like the one shown next to the box beside the Font option in Figure 3-11.
(The mouse pointer is pointing to it.)
2 Character Map =
Font: | €F Al Help |
T sleal&] T =+]. -] [/]o]1]2]3]4|
] 5/68|7(&8(9 == @ ABICIDIE|F|GIH
Figure 3-11: HJ e[ C ] oPlalr]s]Tulvw | ¥[Z] ]
Click the 11 a|blcidle|flglhli]|i|k|!I|m|n|alp
arrow next girisjtiupvfwixgyz[{ 1|3~ |i|¢|£]=]*
to the Font S TS N
box to make o o[z o [A]ALA]ATA]AlECIEIE[EIE[T]T
a dron- IHE R EEEERENMEEREEREE
d I'pt alalalalelc|elelele]i|i]T]i]aln]a]o]a]s
boxotllivsnpll:y O—BDDﬂuypyﬁ\éAéAa_Cééé_v
available Characters to copy | Select
fO nts. [ Advanced view
U+0021: Exclamation Mark
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Figure 3-12 shows the drop-down list box, after being clicked by the mouse.

P v To scoot around quickly in a long drop-down list box, press the first
letter of the item you're after. The first item beginning with that letter is
instantly highlighted. You can press the up- or down-arrow keys to see
nearby words and phrases.

v Another way to scoot around quickly in a drop-down list box is to click
the scroll bar to its right. (Scroll bars are discussed earlier in this chap-
ter, if you need a refresher.)

v You can choose only one item from the list of a drop-down list box.

P v The program in Figure 3-11 is called Character Map, and it’s a handy
way for adding characters that don’t appear on your keyboard: %, ©, ¢,
and the rest. To play with Character Map, click the Start button and
choose the All Programs area. Click System Tools from the Accessories
area and then click Character Map.

42 Character Map =
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Check boxes

Sometimes you can choose several options in a dialog box simply by clicking
in the little square boxes next to their names. For example, the check boxes
shown in Figure 3-13 let you pick and choose options in the game FreeCell.

[efw] ] o[--[a]-[-[«]-]

on| o 2| M-
o | o] | —
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v~ Clicking in an empty square chooses that option. If the square already has
a check mark inside, a click turns off that option, removing the check mark.

» You can click as many check boxes as you want. Option buttons
(those similar-looking but round buttons) restrict you to one option

from the pack.

FreeCell Options [B[%]
|
Dizplay meszages on illegal moves
Figure 3-13: - J
Click to [ Quick play [na animation)
check a box. Diouble click moves card to free cell
|

Sliding controls

Rich Microsoft programmers, impressed by track lights and sliding light
switches in their luxurious new homes, use sliding controls in Windows XP.
These virtual light switches are easy to use and don’t wear out nearly as

P quickly as the real ones do.

Because Windows XP can display only one
background on your desktop at a time, you can
select only one file from the list box of available
backgrounds. Other list boxes, like those in
Windows Explorer, let you select a bunch of
names simultaneously. Here's how:

v To select more than one item, hold down the
Ctrl key and click each item you want. Each
item stays highlighted.

v To select a bunch of adjacent items from a
list box, click the first item you want. Then
hold down Shift and click the last item you
want. Windows XP immediately highlights

When one just isn't enough

the first item, last item, and every item in
between. Pretty sneaky, huh? (To weed out
a few unwanted items from the middle, hold
down Ctrl and click them; Windows un-
highlights them, leaving the rest highlighted.)

v Finally, when grabbing bunches of items, try
using the “rubber band” trick: Point at an
area of the screen next to one item, and,
while holding down the mouse button, move
the mouse until you've drawn a lasso around
all the items. After you've highlighted the
items you want, let go of the mouse button,
and they remain highlighted. Fun!

55



5 6 Part I: Windows XP Stuff Everybody Thinks You Already Know

|
Figure 3-14:
A sliding
lever.
|

Some levers slide to the left and right; others move up and down. None of
them move diagonally, yet. To slide a control in Windows XP — to adjust the
volume level, for example — just drag and drop the sliding lever, like the one
shown in Figure 3-14.

Sliding works like this: Point at the lever with the mouse and, while holding
down the mouse button, move the mouse in the direction you want the sliding
lever to move. As you move the mouse, the lever moves, too. When you’ve
moved the lever to a comfortable spot, let go of the mouse button, and
Windows XP leaves the lever at its new position.

Yolume

_t%

[ kute

Maneuvering Window's
around the Desktop

A terrible dealer at the poker table, Windows XP tosses windows around
your desktop in a seemingly random way. Programs cover each other or
sometimes dangle off the desktop. This section shows you how to gather
all your windows into a neat pile, placing your favorite window on the top
of the stack. If you prefer, lay them all down like a poker hand. As an added
bonus, you can change their size, making them open to any size you want,
automatically.

The Alt+Tab trick

Sometimes your desktop becomes so cluttered listing every open window by name. Keep press-
with windows that you lose track of a particular  ing Tab until you see the name of the window
window. To cycle through every open window, you're after. Found it? Release both keys, and
hold down the Alt key while pressing Tab: Alittle  Windows brings the currently listed window to
window appears in the middle of the screen, the forefront.




Chapter 3: Basic Windows Mechanics 5 7

Moving a window to the top of the pile

Windows XP says the window at the top of the pile getting all the attention is
called the active window. [ won’t argue. The active window is also the one that
receives any keystrokes you or your cat happen to type.

You can move a window to the top of the pile so that it’s active in one of
two ways:

v Sometimes you can recognize a tiny portion of the window you're after.
If so, you're in luck. Move the mouse pointer until it hovers over any
portion of the desired window and click the mouse button. Windows XP
immediately makes the clicked-on window active.

v On the taskbar, click the button for the window you want. Chapter 2
explains what the taskbar can do in more detail.

Repeat the process when necessary to bring other windows to the front.
(And if you want to put two windows on the screen at the same time, read
the “Placing two windows next to each other” section, later in this chapter.)

Moving a window from here to there

Sometimes you want to move a window to a different place on the desktop.
Perhaps part of the window hangs off the edge, and you want it centered.
Or maybe you want one window closer to another.

In either case, you can move a window by dragging and dropping its title bar,
that thick bar along its top. (See the sidebar “Dragging, dropping, and run-
ning,” earlier in this chapter, if you're not sure how dragging and dropping
works.) When you drop the window in place, the window not only remains
where you've dragged and dropped it, but also stays on top of the pile.

Making a window fill the whole screen

Sooner or later, you'll grow tired of all this multiwindow mumbo jumbo. Why
can’t you just put one huge window on-screen? Well, you can.

To make any window grow as big as it can get, double-click its title bar, that
topmost bar along the window’s top edge. The window leaps up to fill the
screen, covering up all the other windows.
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To bring the pumped-up window back to its former size, double-click its title
bar once again. The window quickly shrinks to its former size, and you can
see things that it covered.

v If you're morally opposed to double-clicking a window’s title bar to
expand it, you can click the little Maximize button. Shown in the margin,
it’s the middle of the three buttons in the upper-right corner of every
window.

= v When a window is maximized to fill the screen, the Maximize button
turns into a Restore button, shown in the margin. Click the Restore
button, and the window returns to its smaller size.

Making a window bigger or smaller

Like big lazy dogs, windows tend to flop on top of one another. To space your
windows more evenly, you can resize them by dragging and dropping their
edges inward or outward. It works like this:

1. Point at any corner with the mouse arrow. When the arrow turns
into a two-headed arrow, pointing in the two directions, you can hold
down the mouse button and drag the corner in or out to change the
window’s size.

2. When you’re done yanking and the window looks about the right size,
let go of the mouse button.

As the yoga master says, the window assumes the new position.

Placing two windows next to each other

The longer you use Windows, the more likely you are to want to see two
windows side by side. For example, you might want to copy and paste text
from one document into another document. By spending a few hours with
the mouse, you can drag and drop the windows’ corners until they’re in
perfect juxtaposition.

Or you can simply right-click on a blank part of the taskbar (even the clock
will do) and choose Tile Windows Horizontally to place one window directly
above the other. Choose Tile Windows Vertically to place the windows side
by side, like pillars.
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v If you have more than two windows open, minimize the ones you don'’t
want tiled. Then use the Tile command to align the two remaining
windows.

v To deal all your windows across the desktop like a poker hand, right-click
on a blank part of the taskbar and choose Cascade Windows. [ haven’t
found much use for it yet, but it’s fun to watch.

Making windows open
to the same darn size

Sometimes a window opens to a small square; other times, it opens to fill the
entire screen. But windows rarely open to the exact size you want. Until you
discover this trick, that is: When you manually adjust the size and placement
of a window, Windows memorizes that size and always reopens the window
to that same size. Follow these three steps to see how it works:

1. Open your window.
The window opens to its usual, unwanted size.

2. Drag the window’s corners until the window is the exact size and in
the exact location you want. Let go of the mouse to drop the corner
into its new position.

Be sure to resize the window manually by dragging its corners or edges
with the mouse. Simply clicking the Maximize button won’t work.

3. Immediately close the window.

Windows memorizes the size and placement of a window at the time it
was last closed. When you open that window again, it should open to the
same size you last left it. But the changes you make apply only to the
program you made them in. For example, changes made to the Internet
Explorer window will only be remembered for Internet Explorer, not
other programs you open.
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Chapter 4

Flipping Through Files, Folders,
Floppies, and CDs

In This Chapter
Understanding the My Computer and Explorer programs
Understanding folders
Navigating drives and folders
Creating and naming folders
Selecting items
Deleting items
Copying and moving files and folders
Writing to CDs, memory cards, and floppies

Fe My Computer program is where people wake up from Windows’ easy-
to-use computing dream, clutching a pillow in horror. These people bought
a computer to simplify their work — to banish that awful filing cabinet with
squeaky drawers.

But click the little My Computer icon from the Start menu, start poking around,
and that filing cabinet reappears. Folders, bunches of them, still rule the world.
And unless you grasp Windows’ folder metaphor, you probably won’t be able
to find your information very easily.

This chapter explains how to use the My Computer program and its hidden
twin Windows Explorer. Along the way, you ingest a big enough dose of
Windows file management for you to get your work done. Windows may
bring back your dreaded file cabinet, but at least the drawers don’t squeak,
and files never fall behind the cabinet.
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Browsing My Computer’s File Cabinets

\\3

|
Figure 4-1:
The My
Computer
window dis-
plays your
computer’s
storage
areas and
files, allow-
ing you

to copy,
rename,
move, or
delete them.
|

To keep your programs and files neatly arranged, Windows borrowed the
convenient file cabinet metaphor, cleaned it up with light and airy Windows
icons, and called it the My Computer program. My Computer displays all the
files and storage areas inside your computer, allowing you to copy, move,
rename, or delete them before the investigators arrive.

Everybody organizes his or her computer differently, and some people don’t
organize their computers at all. To see how your computer currently organizes
your files, click the Start menu and click My Computer (the icon shown in the
margin). Although your My Computer window probably looks different from
the one shown in Figure 4-1, it has the same basic sections, each described
shortly.

In fact, whenever you try to open or store a file or folder, you encounter these
same areas. Windows just displays them a little differently depending on what
you’re up to.

To make your My Computer window look more like the one in Figure 4-1, click
the View menu and choose Icons. Then, also from the View menu, choose
Arrange Icons by Type, and check the Show in Groups option.
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Files Stored on This Computer: Normally, Windows XP doesn’t let different
users read each other’s files. But when people want to share information —
party invitations, for instance — the Shared Documents folder (shown in the
margin) comes in handy. If one person puts a party invitation in the Shared
Documents folder, everybody using the computer can read it, making for live-
lier parties.

Figure 4-1 shows three folders next to the Shared Documents folder: Andy’s
Documents (which is my My Documents folder), Guest’s Documents, and
Tina’s Documents. What’s to stop me from peeking into Tina’s folder? Nothing,
actually, because I have an almighty administrator user account, which lets me
peek everywhere. (I explain types of user accounts, and how to keep them
private, in Chapter 13.)

Hard Disk Drives: Shown in Figure 4-1, this area lists hard drives installed
inside your computer. (Every computer has at least one.) Double-clicking a
hard drive icon shows its files and folders, but you'll rarely find much useful
information. In fact, Windows occasionally sends out a stern warning message
to discourage you from peeking. Instead of probing your hard drive, use your
Start menu to find and start programs. Use your My Documents folder to store
your personal folders and files.

Devices with Removable Storage: This area shows detachable storage gad-
getry attached to your computer: CD drives (like the one in the margin),
memory card readers (usually from cameras), and even MP3 players, like the
Dell DJ Explorer shown in Figure 4-1. (I cover MP3 players in Chapter 15.)

Scanners and Cameras: Although not shown in Figure 4-1, digital cameras
and scanners often appear in the My Computer folder. Double-clicking the
camera icon lets you grab its pictures; double-clicking the scanner icon lets
you scan an item into your computer. (Store both their images in your My
Pictures folder.)

Click almost any icon in My Computer, and the task pane’s Details area auto-
matically displays information about that object: the date a file was created,
for instance, or how much space a folder or drive can hold.

Getting the Lowdown on Folders

This stuff is dreadfully boring, but if you don’t read it, you’ll be just as lost as
your files.
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A folder is a storage area on a disk, just like a real folder in a file cabinet.
Windows XP divides your computer’s hard drives into many folders to sepa-
rate your many projects. That lets you work with a spreadsheet, for example,
without having your poems in the way. You can store all your music in your
My Music folder and your pictures in your My Pictures folder.

Any type of disk can have folders, but hard drives need folders the most
because they contain thousands of files. By dividing a hard drive into little
folder compartments, you can more easily see where everything sits.

Windows’ My Computer program lets you probe into different folders and
peek at the files stuffed inside each one. You deal with these main folders in
Windows:

My Documents: Please, please store all your work inside this folder, and for
several reasons. By keeping everything in one place, it’s easier to find. Plus,
it’s something only you can find; other people using the computer can’t fiddle
with it. Create as many new folders inside here as you want. Plus, use its three
built-in folders (described next) for storing pictures, music, or movies.

My Pictures: Store all your pictures in here, whether they’re from a digital
camera, scanner, or the Internet. Covered in Chapter 16, the My Pictures
folder lets you view tiny thumbnails of your photos, grab pictures from an
attached camera, create slideshows, and have more Foto Fun.

My Music: Keep the digital music in here, so Media Player can quickly locate
and play it.

My Videos: Videos downloaded from camcorders and the Internet should
stay here.

v~ Folders used to be called directories and subdirectories. But some people
were getting used to that, so the industry switched to the term folders.

v You can ignore folders and dump all your files onto the Windows XP desk-
top. But that’s like tossing everything into the back seat of the car and
pawing around to find your tissue box a month later. Organized stuff is
much easier to find.

v~ If you're eager to create a folder or two (and it’s pretty easy), page ahead
to this chapter’s “Creating a New Folder” section.

v Sometimes the befuddled Windows XP displays the My Music or My
Pictures task pane for the wrong folders. To fix the switch, open any
folder, choose Folder Options from the Tools menu, click the View tab,
and click the Reset All Folders button. Windows XP’s amnesia clears,
and the proper task panes return.

v Just as manila folders come from trees, computer folders use a tree
metaphor as they branch out from one main folder (a disk drive) to
several smaller folders (see Figure 4-2).



|
Figure 4-2:
Windows’
folders use
a treelike
structure,
with main
folders
branching
outto
smaller
folders.

65

Chapter 4: Flipping Through Files, Folders, Floppies, and CDs

[’ﬁ Deskkop
+ '_i My Docurnents
= g My Computer
&3] i} 3 Floppy (4:)
[= S Local Disk {C:)
= IZ) Documents and Settings
# 1) All Users
) Guest
1) Dnaner
= ) Tina
) Cookiss
|2) Deskrop
[# |J) Favorites
(= 12 My Dacuments
lf_ﬂ Iy Music
[i2} My Pictures
& () Start Menu
[ | ) Program Files
[ WINDOWS

Peering into Vour Drives and Folders

WMBER
@ﬁ
&

¢MBER
S

Knowing all this folder stuff not only impresses computer store employees,
but also helps you find the files you want. Put on your hard hat, go spelunking
among your computer’s drives and folders, and use this section as your guide.

Seeing the files on a disk drive

Like everything else in Windows XP, disk drives are represented by buttons,
or icons. My Computer also shows information stored in other areas, like
MP3 players, digital cameras, or scanners. (I explain these icons in “Browsing
My Computer’s File Cabinets,” earlier in this chapter.)

Opening these icons usually lets you access their contents and move files
back and forth, just as with any other folders in Windows XP.

v When in doubt as to what you can do with an icon in My Computer,
right-click on it. Windows XP presents a menu of all the things you can
do to that object.

v Double-click a drive icon in My Computer, and the My Computer window
displays the drive’s contents. For example, put a CD in your CD drive and
double-click My Computer’s CD drive icon. After a few gears whirl, My
Computer shows what files and folders live on the CD in your CD drive.

v Hold down the Ctrl key while double-clicking a drive icon, and a second
My Computer window appears, to show the drive’s contents. (You might
have to rearrange one window’s size to see them both.) So what? Well, a
second window comes in handy when you want to move or copy files
from one folder or drive to another, as discussed in the “Copying or
Moving Files and Folders” section, later in this chapter.
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v If you click an icon for a CD or floppy drive when no disk is in the drive,
Windows XP stops you, gently suggesting that you insert a disk before

proceeding further.

v Spot an icon called My Network Places? That’s a little doorway for peer-
ing into other computers linked to your computer — if there are any.
You find more network stuff in Chapter 14.

Seeing what's inside folders

Because folders are really little storage compartments, Windows XP uses a
picture of a little folder to stand for each separate place for storing files.

To see what’s inside a folder, either in My Computer or on your computer’s

desktop, just double-click that folder’s picture. A new window pops up, show-
ing that folder’s contents. Spot another folder inside that folder? Double-click

that one to see what’s inside. Keep clicking until you find what you want or

reach a dead end.

What's all this path stuff?

A pathis merely the file’s address, similar to your
own. When mailed to your house, for example,
a letter travels to your country, state, city, street,
and finally, hopefully, your apartment or house
number. A computer path does the same thing.
It starts with the letter of the disk drive and ends
with the file’s name. In between, the path lists
all the folders the computer must travel through
to reach the file.

For example, look at the My Music folder in Fig-
ure 4-2. For Windows XP to find a file stored there,
it starts from the computer’s C: hard drive, travels
through the Documents and Settings folder, and
then goes through the Tina folder. From there, it
goes into the Tina folder's My Documents folder.
And only then does it reach the My Music folder.

Take a deep breath. Exhale slowly. Now add in
the computer's ugly grammar: In a path, a disk
drive letter is referred to as C\. The disk drive
letter and colon make up the first part of the path.

Allthe other folders are inside the big C: folder, so
they're listed after the C: part. Windows sepa-
rates these nested folders with something called
a backslash, or\. The file's name — Rivers of
Babylon, for example — comes last.

Putit all together, and you get C: \Documents
and Settings\Tina\ My Documents\My
Music\Rivers of Babylon.That'sthe offi-
cial path of the Rivers of Babylon file in Tina’s
My Music folder.

This stuff can be tricky, so here it is again: The
letter for the drive comes first, followed by a
colon and a backslash. Then come the names
of all the folders, separated by backslashes.
Last comes the name of the file itself.

Windows XP automatically puts together the
path for you when you click folders. Thankfully.
But whenever you click the Browse button to
look for a file, you're navigating through folders
and showing Windows the path to the file.




Chapter 4: Flipping Through Files, Folders, Floppies, and CDs 6 7

. Reached a dead end? If you mistakenly end up in the wrong folder, back your

O Back  way out as if you're browsing the Web. Click the lime-green Back arrow at the
window’s top-left corner. (It’s the same arrow that appears in the margin.)
That closes the wrong folder and shows you the folder you just left. If you
keep clicking the Back arrow, you end up right where you started.

While burrowing deeply into folders, here’s a quick way to jump immediately
O sk % to any folders you've plowed through: Click the little downward-pointing black
arrow next to the green Back arrow in the window’s top-left corner. A list drops
down, naming the half-dozen folders you've plowed through on your journey.
W Click any name to jump quickly to that folder.

Here are some more tips for finding your way in and out of folders:

v Want a hint as to what’s inside an unopened folder? Rest your mouse
pointer over the folder and wait a few seconds. A small pop-up often
displays the folder’s size and the names of the folder’s first few files.

v Sometimes, a folder contains too many files or folders to fit in the window.
To see more files, click that window’s scroll bars. What'’s a scroll bar?
Time to whip out your field guide, Chapter 3.

v Can'’t find a file or folder? Instead of aimlessly rummaging through fold-
ers, check out the Start button’s Search command, which I describe in
Chapter 6. Windows can automatically find your lost files and folders.

v When faced with a long list of alphabetically sorted files, click anywhere
on the list. Then quickly type the first letter or two of the file’s name.
Windows immediately jumps up or down the list to the first name begin-
ning with those letters.

Creating a New Folder

To store new information in a file cabinet, you grab a manila folder, scrawl

a name across the top, and start stuffing it with information. To store new
information in Windows XP — a new batch of letters to the hospital’s billing
department, for example — you create a new folder, think up a name for the
new folder, and start stuffing it with files.

To create a new folder quickly, look at the task pane. Sometimes you can just
click the words Make a New Folder, and Windows quickly creates one for you.
If your task pane’s being surly, here’s the manual method:

1. Right-click inside your folder and choose New.

The all-powerful right-click shoots a menu out the side.
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2. Select Folder.
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Choose Folder, as shown in Figure 4-3, and a new folder appears in the
folder, waiting for you to type in a new name.

3. Type in a new name for the folder.

A newly created folder bears the boring name of New Folder. When you
begin typing, Windows XP quickly erases the old name and fills in your
new name. Done? Either press Enter or click somewhere away from the
name you’ve just typed.

If you mess up and want to try again, right-click on the folder, choose
Rename, and start over.

v You can also create new folders by choosing New from a folder’s File
menu and selecting Folder.

v Certain symbols are banned from folder (and file) names. The “Using
legal folder names and filenames” sidebar spells out the details, but you
never have trouble when using plain old letters and numbers for names.

v Shrewd observers noticed that in Figure 4-3 Windows offers to create
many more things than just a folder when you click the New button.
Right-click inside a folder anytime you want to create a new shortcut
or other common items.
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Renaming a File or Folder

\\J

Sick of a file or folder’s name? Then change it. Just right-click on the offending
icon and choose Rename from the menu that pops up.

Windows highlights the file’s old name, which disappears as you begin typing
the new one. Press Enter or click the desktop when you’re through, and
you’re off.

Or you can click the file or folder’s name to select it, wait a second, and click
the file’s name again to change it. Some people click the name and press F2;
Windows automatically lets you rename the file or folder.

v When you rename a file, only its name changes. The contents are still
the same, it’s still the same size, and it’s still in the same place.

v To rename large groups of files simultaneously, select them all, right-click
on the first one, and choose Rename. Type in the new name and press
Enter; Windows XP renames that file. However, it also renames all the
other files to the new name, adding a number as it goes: cat, cat (1),
cat (2),cat (3), and so on.

v Renaming some folders confuses Windows, especially if those folders
contain programs. And please don’t rename these folders: My Documents,
My Pictures, or My Music. Windows won'’t let you rename other folders —
like the Recycle Bin.

Windows is pretty picky about what you can and 1/2 of my Homework

Using legal folder names and filenames

can‘t name a file or folder. If you stick to plain old J0B:?2

letters and numbers, you're fine. But don't try to
stick any of the following characters in there:

c /N <>

If you try to use any of those characters,
Windows XP bounces an error message to the
screen, and you have to try again. Here are some
illegal filenames:

ONE<TWO
He's no "Gentleman"

These names are legal:

Half of my Term Paper
JOB?2

Two is Bigger than One
A #@$%) Scoundrel
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Selecting Bunches of Files or Folders
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Although selecting a file, folder, or other object may seem particularly boring,
it swings the doors wide open for further action: deleting, renaming, moving,
copying, and other goodies discussed in the rest of this chapter.

To select a single item, just click it. To select a bunch of files and folders, hold
down the Ctrl key when you click the names or icons. Each name or icon stays
highlighted when you click the next one.

To gather several files or folders sitting next to each other in a list, click the
first one. Then hold down the Shift key as you click the last one. Those two
items are highlighted, along with every file and folder sitting between them.

Windows XP lets you lasso files and folders as well. Point slightly above the
first file or folder you want; then, while holding down the mouse button, point
at the last file or folder. The mouse creates an invisible lasso to surround your
files. Let go of the mouse button, and the lasso disappears, leaving all the sur-
rounded files highlighted.

»* You can drag and drop armfuls of files in the same way that you drag a
single file.

v You can also simultaneously cut or copy and paste these armfuls into
new locations using any of the methods described in the “Copying or
Moving Files and Folders” section.

»* You can delete these armfuls of goods, too.

v To quickly select all the files in a folder, choose Select All from the folder’s
Edit menu. (Or press Ctrl+A.) Here’s another nifty trick: To grab all but a
few files, press Ctrl+A and, while still holding down Ctrl, click the ones
you don’t want.

Getting Rid of a File or Folder

Sooner or later, you’ll want to delete a file that’s not important anymore —
yesterday'’s lottery picks, for example, or a particularly embarrassing digital
photo. To delete a file or folder, right-click on its name. Then choose Delete
from the pop-up menu. This surprisingly simple trick works for files, folders,
shortcuts, and just about anything else in Windows.

To delete in a hurry, click the offending object and press the Delete key.
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QNING/
Y The Delete option deletes entire folders, as well as any files or folders stuffed
inside them. Make sure that you select the right folder before you choose
Delete.

v After you choose Delete, Windows tosses a box in your face, asking
whether you're sure. If you're sure, click Yes. If you're tired of Windows’
cautious questioning, right-click on the Recycle Bin, choose Properties,
and remove the check mark next to Display Delete Confirmation. Windows
now deletes any highlighted items whenever you — or an inadvertent
brush of your shirt cuff — press the Delete key. See Chapter 2 for more
about the Recycle Bin.

% | Be extra sure that you know what you’re doing when deleting any file that
1‘“&; has pictures of little gears in its icon. These files are sometimes sensitive
hidden files, and the computer wants you to leave them alone. (Other
than that, they’re not particularly exciting, despite the action-oriented
gears.)

v Icons with little arrows in their corner (like the one in the margin) are
shortcuts — push buttons that merely load files. (I cover shortcuts in
Chapter 5.) Deleting shortcuts deletes only a butfon that loads a file or
program. The program itself remains undamaged and still lives inside
your computer.

.9

v As soon as you find out how to delete files, trot off to Chapter 2, which
explains several ways to undelete them. (Hint for the desperate: Open
the Recycle Bin, right-click on your file’s name, and choose Restore.)

Don’t bother reading this hidden technical stuff

You’re not the only one creating files on your
computer. Programs often store their own infor-
mation in a data file. They may need to store
information about the way the computer is set

2. Select the View tab from along the menu’s
top and click the Show Hidden Files and
Folders button under the Hidden Files and
Folders option.

up, for example. To keep people from confusing
the files for trash and deleting them, Windows
hides them.

You can view the names of these hidden files
and folders, however, if you want to play voyeur:

1. Open My Computer and choose Folder
Options from the Tools menu.

3. Click the OK button.

The formerly hidden files appear alongside the
other filenames. Be sure not to delete them,
however: The programs that created them will
gag, possibly damaging them or Windows itself.
In fact, please click the View tab’s Restore
Defaults button to hide that stuff again and return
the settings to normal.
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Copying or Moving Files and Folders

To copy or move files to different folders on your hard drive, it’s sometimes
easiest to use your mouse to drag them there. For example, here’s how to
move a file to a different folder on your desktop. In this case, 'm moving the
Traveler file from the House folder to the Morocco folder.

|
Figure 4-4:
To move a
folder from
one window
to another,
drag it there.
|
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1. Aim the mouse pointer at the file or folder you want to move.

In this case, point at the Traveler folder.

2. While holding down the right mouse button, move the mouse until it

points at the destination folder.

As you see in Figure 4-4, the Traveler folder is being dragged to the
Morocco folder from the House folder. (I describe how to make win-
dows sit neatly next to each other in Chapter 3.)

O Morocco

2
o

Folders E )

Address I3 \Documents and Settings|AndyiDeskiop|Morocco | % ﬁ Go

f.f' 7/ Search

S[E)[x]

—J House
File Edit View Favorites Tools Help "

O f

Address || C\Documents and Settings|AndyiDeskbop|Hi v ﬂ G0

»

Search Folders

Traveler

Moving the mouse drags the folder along with it. (Be sure to hold down
the right mouse button the entire time.)

3. Release the mouse button and choose Copy, Move, or Create Shortcut

from the pop-up menu.

Always drag icons while holding down the right mouse button. Windows XP
is then gracious enough to give you a menu of options when you position
the icon, and you can choose to move, copy, or create a shortcut. If you
hold down the left mouse button, Windows XP sometimes doesn’t know

whether to copy or move.

Moving a file or folder by dragging it is pretty easy, actually. The hard part is
placing both the file and its destination on-screen, especially when one folder

is buried deep within your computer.
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When dragging and dropping takes too much work, Windows offers a few other
ways to copy or move files. Depending on your screen’s current layout, some
of the following on-screen tools might work more easily:

+ Right-click menus: Right-click on a file or folder and choose Cut or
Copy, depending on whether you want to move or copy it. Then right-
click on your destination folder and choose Paste. It’s simple, it always
works, and you needn’t place the item and its destination on-screen
simultaneously.

1 Menu bar commands: Click the file and click Edit from the folder’s top
menu. Choose Copy to Folder or Move to Folder, and a new window
appears, listing all your computer’s folders. Click through the folders to
reach the destination folder, and Windows carries out the Copy or Move
command. A bit cumbersome, this method works if you know the exact
location of the destination folder.

v Windows Explorer: Described later in this chapter, Windows Explorer
lines up all your folders along the window’s left side. That makes it
easier to see both the object and its destination on the same screen.
(For a peek at Windows Explorer, open My Computer and click Folders
on the toolbar along the top.)

Don’t ever move these folders: My Documents, My Pictures, My Music, Shared
Documents, Shared Pictures, or Shared Music. Keep them where they are so
they’re easy to find.

After you run a program’s installation program to put the program on your
hard drive, don’t ever move that program’s folder. Programs wedge them-
selves into Windows. Moving the program might break it, and you’ll have to
reinstall it. Feel free to move the program’s shortcut, though, if it has one.

Seeing More Information
about Files and Folders

Whenever you create a file or folder, Windows XP scrawls a bunch of secret
hidden information on it: its size, the date you created it, and even more trivial
stuff. Sometimes it even lets you add your own secret information: lyrics and
reviews for your music files and folders, or thumbnail pictures for any of your
folders.

/3
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|
Figure 4-5:
When
looking ata
file's Prop-
erties, the
General tab
shows phys-
ical details
about the
file; the
Summary
tab shows
more varied
information.
|
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To see what Windows XP is calling your files and folders behind your back,
right-click on the item and choose Properties from the pop-up menu. Choosing
Properties on a Jimi Hendrix song, for instance, brings up bunches of details,
as shown in Figure 4-5.

01 - Hey Joe Properties (3] =] 01 - Hey Joe Properties Z&d
General | summary Gengral | Summary
@ 01 - Hey Joe Property Value ~
Music
Type of file:  MP3 audio file {mp3) [ Artist TJirni Hendrix
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[ Protected Mo
Attributes: Read-only: Hidden
Dlgeagenty Ol Advariced aiics
D Duration 0:03:34 ™
<< Simple:
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Click the General tab (shown on the left of Figure 4-5), and Windows shows
that the Jimi Hendrix song is an MP3 audio file of the song “Hey Joe.” The
song is 3.27 MB in size, and it opens with Windows Media Player. (If you
want a different MP3 player to play the song, click the Change button to
select a different player.)

Click the Summary tab (shown on the right of Figure 4-5) and click the
Advanced button for the real fun. Windows displays the song’s ID Tag infor-
mation: the Artist, Album Title, Year, Track Number, Genre, Duration, and
technical information. (I cover ID Tags in Chapter 15.)

Windows lets you see more information about files as they sit in a folder, too.
Choose Details from a folder’s View menu, as shown in Figure 4-6. Instead of
just displaying icons, Windows displays detailed information about your files.

v To change views, click the square button on the toolbar (shown in the
margin.) A drop-down menu appears, listing options for displaying a
folder’s files: Thumbnails, Tiles, Icons, List, and Details. Try them all to
see what they do.
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a folder's
View menu
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v Is the View menu missing from the top of your folder’s window? Put it

back by choosing Standard Buttons from the View menu’s Toolbars
option. The little bar of buttons reappears atop your window like a

mantel over a fireplace.

v If you can’t remember what those little toolbar buttons do, rest your
mouse pointer over a button and pretend it’s lost. Windows XP displays
a helpful box summing up the button’s mission and, occasionally, places
a further explanation along the bottom of the window.

v Although some of the additional file information is handy, it can consume
a lot of space, limiting the number of files you can see in the window.
Displaying only the filename is often a better idea. Then, if you want to
see more information about a file or folder, try the following tip.

Folders usually display files sorted alphabetically. To sort them differently,
right-click inside the folder and click the Arrange Icons By menu. Choose Sort
by Size to place the largest files at the list’s top. The Sort by Type option
groups together files created by the same program. Choose Sort by Date to

keep your most recent files at the list’s top.

When the excitement of the Arrange Icons By menu wears off, try clicking

the little buttons at the top of each sorted column. Click the Size button,

for instance, to quickly place the largest files at the list’s top. Click the Date
button to quickly sort by date, instead.
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What's That Windows Explorer Thing?

|
Figure 4-7:
Click the
Folders
button from
along a
folder's top
to see
Windows
Explorer's
view of your
folders.
|

Windows almost always uses My Computer to display your files and folders,
but its twin program — Explorer — can also display your files and folders.
What'’s the difference?

My Computer shows the contents of only one folder at a time. Windows
Explorer, on the other hand, lets you see all your folders at the same time. Best
yet, Explorer is easy to load (and quick to turn off, should you disapprove).

To load Windows Explorer, click the Folders button along the top. A list of
folders tacks itself onto your folder’s left side, as shown in Figure 4-7, turning
the window into Windows Explorer. Windows Explorer displays your files in a
“tree” branching off from your hard drive.

See how some folders along that left edge have tiny plus signs next to them?
That means more folders hide inside those folders. Click the plus sign, and the
folder opens up, displaying the folders living inside. By clicking plus signs, you
can worm your way even deeper inside folders.
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Flipping a file's secret switches

Windows XP gives each file special switches
called attributes. The computer looks at the way
those switches are set before it fiddles with the
file. To view a file's attributes, right-click on the
file and choose Properties. Here's what you'll
probably find:

v+~ Read Only: Choosing this attribute allows the
file to be read, but not deleted or changed
in any way.

v~ Hidden: Setting this attribute makes the file
invisible during normal operations.

By clicking the Advanced button, Windows XP
presents more switches:

v~ File Is Ready for Archiving: Some backup
programs look at this one to see if they've
backed up that file or not. When backed up,
this attribute changes to reflect its new status.

v~ For Fast Searching: Normally set to on, this
setting tells Windows to let its Indexing
Service take note of the file and its contents
for faster searching.

v+~ Compress Contents to Save Disk Space:
Only available on computers with special,
NTFS drives, this setting lets Windows XP
squish the file to save space. That makes
the file load more slowly, though.

The Properties box makes it easy — perhaps
too easy — to change these attributes. In most
cases, you should leave them alone. | just
mention them here so that you'll know what
computer nerds mean when they tell cranky
people, “Boy, somebody must have set your
attribute wrong when you got out of bed this
morning.”

/7

What’s the point? Well, Windows Explorer lets you view one folder’s contents
on the right side of the window, and all of your folder’s names on the left. That
makes it easier to move to different folders or copy items from one folder to
another folder. (See Chapter 5 for details on copying and pasting.)

To get rid of the Windows Explorer view and return to My Computer and its

Fel2a handy task pane, click the Folders button from the toolbar along the top.

Writing to CDs and DVDs

Most computers today can write information to a CD using a flameless approach
known as burning. To see if you're stuck with an older drive that can’t burn
CDs, open My Computer and look at the icons for your CD drives. If the drive
says RW after its name, you're in luck.
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() Ifyour disc drive says simply DVD Drive or CD Drive (like the one in the
<& margin), it can read but not write to CDs. (I explain how to play DVDs in
0™ Chapter 15.)

(+)  If your disc drive says CD-RW, like the one in the margin, it can both read and
co.;ﬁme write to CDs. (It can probably play DVDs, too.)
5 If your drive says DVD-RW Drive, like the one in the margin, it can both read
~&  and write to CDs as well as DVDs.
DYD-RW Drrive
v Sometimes a drive claims to be able to write to CDs, but Windows still

has trouble with it. Here’s a surefire test to see whether Windows XP can
write to your drive: Right-click on your drive’s icon in My Computer and
choose Properties. If you see a Recording tab, Windows XP can write to
CDs in that drive. If the Recording tab is missing, Windows XP can’t use
the drive.

v Lagging Technology Department: Although many people have DVD burn-
ers, Windows XP still doesn’t know how to write to DVDs. (Microsoft
says Windows’ next version, previewed in Chapter 23, can burn DVDs.)
Because Windows XP can’t do the job, most DVD burners use a different
company’s DVD burning software.

Buying the right kind of blank
CDs and DUDs for burning

Stores sell two types of CDs: CD-R (short for CD-Recordable) and CD-RW
(short for CD-ReWritable). Here’s the difference:

Duplicating a CD

Windows XP doesn't have a Duplicate This CD 1. Copy a CD’s files and folders to your PC.
command. It can’t even make a copy of a music .
CD. (That's why so many people buy CD burning 2. Copy those same files and folders back to a
] e blank CD.
programs.) Butit can copy all of a CD's filesto a
blank CD using this two-step process: You can try this on a music CD, but it won't work.
(I'tried.)
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CD-R: Most people buy CD-R discs because they’re cheap, and they work fine
for storing music or files. You can write to them until they fill up; then you
can’t write to them anymore. But that’s no problem, because most people
don’t want to erase their CDs and start over.

CD-RW: Techies sometimes buy CD-RW discs for making temporary backups
of data. You can write information to them, just like CD-Rs. But when a CD-RW
disc fills up, you can erase it and start over with a clean slate — something
not possible with a CD-R. However, CD-RWs cost more money, so most people
stick with CD-Rs.

DVDs: DVDs come in both R and RW formats, just like CDs, so the preceding R
and RW rules apply to them, as well. Beyond that, it’s chaos: The manufactur-
ers fought over which storage format to use, confusing things for everybody.
To buy the right blank DVD, check your DVD burner to see what formats it
uses: DVD-R, DVD-RW, DVD+R, DVD+RW, and/or DVD-RAM. (Some new DVD
burners can use all of the first four formats, making your choice slightly easier.)

v The disc’s “x” speed refers to the speed at which it can accept informa-
tion. Your drive can write information onto a 40x CD five times faster than
onto an 8x CD. Buy CDs with as fast an x rating as your burner can handle.

v You'll often find your CD or DVD burner’s format and speed listings
printed directly on the drive’s face. If the information isn’t there, check
the receipt for your computer. If you still have no clue, buy reasonably
fast discs. Slow burners can still write to speedy discs, but not as quickly
as faster burners.

v Blank CDs are cheap; borrow one from a neighbor’s kid to see if it works
in your drive. If it works fine, buy some of the same type. Blank DVDs, by
contrast, are expensive. Most neighbors’ kids won’t let you have one.

v Although Windows XP can handle simple CD burning tasks, it’s extraor-
dinarily awkward at copying music CDs. Most people give up quickly and
buy third-party CD burning software from Roxio or Nero. I explain how
Windows XP creates music CDs in Chapter 15.

Copying things from or to a CD

Copying music to or from a CD isn’t easy in Windows XP. Windows XP makes
you use its awkward and restrictive Media Player program, which [ cover in
Chapter 15.
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Figure 4-8:
Right-click
on any files
and folders
you want to
copytoa
CD, choose
Send To, and
select your
CD burning
drive.

Copying files from a CD works pretty easily, by contrast — just like copying
files from one folder to another. Double-click your CD drive to view the CD’s
contents and then drag and drop the desired files to your My Documents
folder. (Or any other folder, actually.)

Writing files to a CD takes a little more work, but remember this tip: When
you insert a blank CD into your CD burner, a Windows wizard usually pops
up, offering to help. Feel free to take the White Bearded One’s assistance as
it leads you through the entire process. After you master the process, these
steps give you more control over the process:

1. Select the files you want to copy to a CD, right-click on them, choose
Send To, and select your CD burning drive.

Feel free to roam through your folders, sending more and more files or
folders to your CD drive. Windows keeps track of them all in the back-
ground. Whenever you choose Send To from a menu, a window pops
up saying You have files waiting to be written to the CD.
(Figure 4-8 shows an example.)
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. Double-click your CD burning drive from My Computer.

Windows displays a folder containing shortcuts to all the files and fold-
ers you sent to your CD burning drive in Step 1. Feel free to make any
last-minute changes here, deleting any mistaken items and adding any
last-minute items. (Copy and paste additional items into this folder, if
you like, or drag and drop them here.)

Note: This folder is filled with shortcuts — not the actual files themselves.
Deleting items here won'’t delete the real files; they’'re just push buttons
tied to those files. (I cover shortcuts in Chapter 5.)

. Insert a blank CD and then choose Write These Files to CD from the

folder’s File menu.

If you spot Write These Files to CD on the task pane, clicking that does
the same thing.

. Create a name for your new CD and click Next.

Windows CD-Writing Wizard appears, asking you to name the CD. (Just
press Enter to use the current date, or type in something describing your
files.)

Windows slowly mulls over something called a CD image and eventually
begins writing your files and folders to the CD.

. Click the Finish button.

Or, if you want to copy those same files to yet another CD, click the
Yes, Write These Files to Another CD box. If you're through, just click
Finish.

v You can keep writing more and more files to a CD until Windows com-

plains that the CD is full. Then you need to insert another blank CD.

v If you try to copy a large batch of files to a CD — more than will fit —

Windows XP complains immediately. Copy fewer files at a time, perhaps
spacing them out over two CDs.

v While copying files to the CD, Windows may display a frantic Confirm

Stream Loss message about a mysterious Thumbs file. If so, just click the
Skip button and skip that file. The message isn’t nearly as important as it
sounds.

v Most programs let you save files directly to CD. Choose Save from the

File menu and select your CD burner. Put a CD (preferably one that’s not
already filled) into your CD drive and right-click on the CD drive in My
Computer to start the process.
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Floppy Disks and Memory Cards

Most people own some gadget that uses memory cards, but few people have
a memory card drive. The quick solution is to buy an external USB all-in-one
memory card reader and plug it into your computer’s USB port. Available at
most office supply and electronics stores, these card readers accept most
popular memory card formats.

As for transferring information between your computer and a memory card
(or floppy disk), there’s nothing new to figure out: Windows XP treats your
inserted card or floppy just like an ordinary folder. The same “drag and drop’
and “cut and paste” rules covered early in this chapter still apply.

9

Vs v Press the F5 key whenever you stick in a different floppy disk and want
to see what files are stored on it. Windows XP then updates the screen
to show the new floppy’s files, not the files from the first disk. (You don’t
have to do this with memory cards.)

v First, the warning: Formatting a card or disk wipes out all its information.
Never format a card or disk unless you don’t care about the information
it currently holds.

v Now, the procedure: If Windows complains that a newly inserted card
or floppy isn’t formatted, right-click on its drive and choose Format.
(This happens most often with damaged cards or floppies.) Sometimes
formatting also helps one gadget use a card designed for a different
gadget — your camera might be able to use your MP3 player’s card,
for instance.
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In this part . . .

' he first part of the book explains how to manipulate
Windows, applying strategic sequences of clicks and
double-clicks to its sweet spots.

Now you'll find ways to put that knowledge to good use,
prodding your programs into doing the right things and
hopefully getting your work done in the process.

This part of the book also explains ways to print, scan,
and fax your work — before it gets lost. And when some
of your files wander (it’s unavoidable), Chapter 6 explains
how to unleash Windows’ robotic search hounds to track
them down and bring them within reach.




Chapter 5

Playing with Programs
and Documents

In This Chapter

Opening a program or document

Changing which program opens which document
Creating a shortcut

Cutting or copying and pasting

Using Windows XP’s free programs

n Windows, programs are your tools: They let you add numbers, arrange
words, and shoot spaceships. Documents, by contrast, are the things you
create with programs: tax forms, heartfelt apologies, and high scores.

This chapter starts with the basics of opening programs, creating shortcuts,
and cutting and pasting information between documents. Along the way, it
throws in a few tricks — how to add things like © to your documents, for
instance. Finally, it ends with a tour of Windows XP’s free programs, showing
how to write a letter or take notes that you spice up with special characters
and symbols.

Starting a Program

Clicking the Start button presents the Start menu, the launching pad for your
programs. The Start menu is strangely intuitive. For instance, if it notices
you’ve been playing lots of FreeCell lately, the Start menu automatically
moves FreeCell’s icon to its first page for easy access, as shown in Figure 5-1.
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Don’t see your favorite program on the Start menu'’s first page? Click All
Programs along the menu’s bottom row. The Start menu squirts an even
larger list of programs out its right side. Keep moving your mouse toward
the menus on the right; some entries sprout even more menus. When you
spot your program, click its name to haul it onto the desktop.

If you can’t find your program on the Start menu, Windows XP offers plenty of
other ways to open a program, including these:

v Double-click a shortcut to the program. Shortcuts, which often sit on your
desktop, are handy, disposable push buttons for launching files and fold-
ers. (I explain more about shortcuts later in this chapter.)

v Look for the program’s icon on the Windows Quick Launch toolbar — a
small strip of icons that often lives next door to the Start button. (I cover
the QuickLaunch toolbar, including how to add or remove it, in Chapter 2.)

v Right-click on your desktop, choose New, and select the type of docu-
ment you want to create. Windows XP loads the appropriate program to
handle the matter.

v Open My Computer, open your My Documents folder, and double-click
the file you want to work on. The correct program automatically opens.

Windows offers other ways to open a program, but these usually do the job. I
cover the Start menu more extensively in Chapter 2.
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On its front page, the Start menu creates shortcuts — push buttons — for your
six most-used programs. Those shortcuts constantly change to reflect the six
programs you use the most. Don’t want the boss to know you play FreeCell?
Right-click on FreeCell’s icon and choose Remove from This List. The short-

cut disappears, yet FreeCell’s “
Start menu’s Games menu.

Opening a Document

real” icon remains in its normal spot on the

Like Tupperware, Windows XP is a big fan of standardization. All Windows
programs load their documents — often called files — exactly the same way:

1. Click the word File on any program’s menu bar, that row of staid
words along the program’s top. When the File menu drops down,

click Open.

Windows complicates things with the Open box, shown in Figure 5-2.
This bothersome box (named after the menu you clicked to reveal it)
appears over and over again in Windows XP.

2. See the list of documents inside the Open box in Figure 5-2? Point at
your desired document, click the mouse, and click the Open button.

The program opens the file and displays it on the screen.

When programmers fight over file types

When not fighting over fast food, programmers
fight over formats — ways to pack information
into a file. To accommodate the format wars, some
programs have a special box that lets you open
files stored in several different types of formats.

For instance, the Files of Type drop-down list box
in Figure 5-2 lists Word for Windows format. So,
the Open box only displays files stored in Word
for Windows format. To see files stored in other
formats, click in the Files of Type box and choose
a different format. The Open box quickly updates
its list to show files from that new format, instead.

And how can you see a list of allthe files a pro-
gram can open, regardless of their content?

Unfortunately, there's no easy answer. The
Show All Files option works differently in differ-
ent programs. A sophisticated program shows
files in all the formats it can open — and filters
out the ones it can’t open. An unsophisticated
program such as WordPad shows allthe files in
the folder, even if it can’t open them.

WordPad lists digital photos in its All Files menu,
for instance. But if you try to open a photo,
WordPad dutifully displays the photo as a few
obscure coding symbols. (If you ever mistakenly
open a photo in a program and don't see the
photo, don't try to save what you've opened. If
the program is like WordPad, it will ruin it.)




88

Part ll: Working with Programs and Files

Open B[%]
Look in: | [} My Documents v| @ =@

Jak

A, =
aus junk

£)
My Fiecent jMv Music
Documents |2 my Pictures
= EMV Videos
Lﬁ [ Hew Briefcase
S Beers T have known

Desklop
f;j:l Unfinished Move!

|
. My Documents |
Figure 5-2:
Double-click o]
the filename My Computer
ou want .
yto open "!] File: name: ~
pen. by Nt ||l e Word for Windows [*doc] -
|

Opening a file works this way in any Windows program, whether written by
Microsoft, its corporate partners, or the teenager down the street.
\\J
v To speed things up, double-click a desired file’s name; that opens it
immediately, automatically closing the Open box.

v If your file isn’t listed by name, start browsing by clicking the buttons along
the left of Figure 5-2. Click the My Documents folder, for instance, to see
files stored in that folder. Click My Recent Documents to see files you've
opened recently; if you spot the one you want, pluck it from the list.

v We puny humans store things in the garage, but computers store their
files in neatly labeled compartments called folders. (Double-click a folder
to see what'’s stored inside.) If browsing folders gives you trouble,
Chapter 4’s folders section offers a refresher.

v Whenever you open a file and change it, even by accidentally pressing
the spacebar, Windows XP assumes that you've changed the file for the
better. If you try to close the file, Windows XP cautiously asks whether
you want to save your changes. If you changed the file with masterful
wit, click Yes. If you made a mess, click No or Cancel.

\J . . ) .
) v Confused about those little icons along the box’s top and side? Rest

your mouse pointer over the icons, and a little box announces their
occupations.

Saving a Document

Saving means to send the work you've just created to a disk or hard drive for
safekeeping. Unless you specifically save your work, your computer thinks
that you've just been fiddling around for the past four hours. You must specif-
ically tell the computer to save your work before it will safely store it.
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Thanks to Microsoft’s snapping leather whips, the same Save command
appears in all Windows XP programs, no matter what programmer wrote
them. Click File from the top menu, choose Save, and save your document
in your My Documents folder for easy retrieval later.

If you're saving something for the first time, Windows XP asks you to think

up a name for your document. Type something descriptive using only letters,
numbers, and spaces between the words. (If you try to use one of the illegal
characters I describe in Chapter 4, the Windows Police step in, politely request-
ing that you use a different name.)

v Choose descriptive filenames for your work. Windows XP gives you 255
characters to work with, so a file named June Report on Squeegee Sales is
easier to locate than one named Stuff.

» You can save files to any folder, floppy disk, CD, or even a memory card.
But files are much easier to find down the road when they stay in the My
Documents folder. (Feel free to save a second copy onto your floppy or
CD as a backup.)

v Most programs can save files directly to a CD. Choose Save from the File
menu and click your CD burner from the Save In drop-down menu. Put a
CD (preferably one that’s not already filled) into your CD-writing drive
and right-click on the CD drive in My Computer to start the process.

v If you're working on something important (and most things are), choose
the program’s Save command every few minutes. Or use the Ctrl+S
keyboard shortcut (while holding down the Ctrl key, press the S key).
Programs make you choose a name and location for a file when you
first save it; subsequent saves are really speedy.

v Giant clams can reach up to 500 pounds, enough for 571 servings of
chowder.

What's the difference between Save and Save As?

Huh? Save as what? A chemical compound?
Naw, the Save As command just gives you a
chance to save your work with a different name
and in a different location. Suppose that you
open the Ode to Tina file in your My Documents
folder and change a few sentences. You want
to save your new changes, but you don’t want

to lose the original words, either. Preserve both
versions by selecting Save As and typing the
new name, Additional Odes to Tina.

When you're saving something for the firsttime,
the Save and Save As commands are identical:
Both make you choose a fresh name and loca-
tion for your work.
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Choosing Which Program Opens a File

Most of the time, Windows XP automatically knows which program should
open which file. Double-click any file, and Windows tells the correct program
to jump in and let you view its contents. But when Windows XP gets confused,
the problem lands in your lap.

The next two sections explain what to do when the wrong program opens
your file or, even worse, no program offers to do the job.

If somebody says something about “file associations,” feel free to browse the
technical sidebar section, which explains that awful subject.

The wrong program loads my file!

Double-clicking a document usually brings up the correct program, usually the
same program you used to create that document. But sometimes the wrong
program keeps jumping in, hijacking one of your documents. (Different brands
of media players constantly fight over the right to play your music or videos,
for example.)

The awkward world of file associations

Every Windows program slaps a secret code
known as a file extension onto the name of
every file it creates. The file extension works
like a cattle brand: When you double-click the
file, Windows XP eyeballs the extension and
automatically summons the proper program to
open the file. Microsoft Word, for instance,
tacks on the three-letter extension .doc to
every file it creates. So the . doc extension is
associated with Microsoft Word.

Windows XP normally doesn’t display these
extensions, isolating users from Windows' inner
mechanisms for safety reasons. If somebody
accidentally changes or removes an extension,
they'll no longer be able to open the file.

If you're curious as to what an extension looks
like, sneak a peek by following these steps:

1. Choose Folder Options from a folder's Tools
menu and click the View tab.

2. Click the Hide File Extensions for Known
File Types box to remove the check mark.

3. Click the Apply button.

The files all reveal their extensions. Notice that
if you open two different files with the same
extension, these files open in the same pro-
gram. Now that you've peeked, hide the exten-
sions again by putting a check mark back in the
Hide File Extensions for Known File Types box.

The moral? Don't ever change a file's extension
unless you know exactly what you're doing;
Windows XP will forget what program to use for
opening the file, leaving you holding an empty
bag.
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When the wrong program suddenly begins opening your documents, here’s
how to make the right program open it instead:

1. Right-click on your problematic file and select Open With from the
pop-up menu.

As shown in Figure 5-3, Windows names a few programs you’ve used
to open that file in the past. The top-listed program has fop billing —
it’s the program that normally jumps into action when you double-
click your file. (Chances are, the wrong program is now sitting in

that spot.)
- Preview
Pictures  Edit
Print
L Open With » | Windows Picture and Fax Viewer
Figure 5-3: Sond 1o 5, LI halnt
C||Ck the Cut Choose Program...
program Copy
you want Create Shortcut
to open Delete
the file. e
Properties
|
2. Click Choose Program and select the program you want to open
the file.
The Open With window, shown in Figure 5-4, lists many more programs.
If you spot your favorite program, you could double-click it to open your
file immediately. But that wouldn’t prevent the same problem from
recurring. The next step does that.
P If Windows doesn’t list your favorite program anywhere on its list, you

have to look for it. Click the Browse button and navigate to the folder
containing the program you want. (Hint: Hover your mouse pointer
over the folders, and Windows lists the program inside.) You should
spot your favorite program’s icon sitting in one of those folders.

3. Click the Always Use the Selected Program to Open This Kind of File
check box and click OK.

That box makes Windows return top-billing status to your selected pro-
gram. For instance, choosing Paint Shop Pro (and checking the “Always’
box) in Figure 5-4 tells Windows to make Paint Shop Pro open that type

of file the next time it’s double-clicked.

9



92 Part ll: Working with Programs and Files

|
Figure 5-4:
Choose the
program

you want
and click
the box at
the bottom.
|
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Figure 5-5:
Sometimes
Windows
refuses to
open a file.
|

Open With

File:  Pictures of Lily.bmp
Programs

I Recammended Pragrams:
Y Paint

[T]) Other Pragrams:
[ Adobe Reader 6.0
4 Inkernet Explorer
_':.. Motepad

] Chaose the program you want to use to open this file;
<

| Windows Pickure and Fax Wiswer

g {Paint Shop Pro Windows 32 bit Executable

& windows Media Player
A wordPad

1 o0

propriate

%&Iways use the selected program to open this kind of File

IF the program wou want is not in the list or on your computer, you cal

v Sometimes you’ll want to alternate between two programs when working
on the same document. To do that, right-click on the document, choose
Open With, and select the program you need at that time.

v Sometimes you can’t make your favorite program open a particular file
because it simply doesn’t know how. For instance, Windows Media
Player can usually play videos, except when they’re stored in QuickTime,
a format used by Microsoft’s competition. Your only solution, covered in
the next section, is to install QuickTime and use it to open that particu-

lar video.

No program will open my file!

It’s frustrating when several programs fight to open your file. But it’s even
worse when no program ponies up to the task. Double-clicking your file
merely summons the cryptic error message shown in Figure 5-5.

Windows

2% ]

] Windows cannat open this fils:
£

File:  wokboarding.mow

programs on your computer,

Sithat do you want to do?

Ta open this file, Windows needs ta know what program created it, windows
can go online ko look it up automatically, or you can manually select From a list of

(¥ 1ise the Web service to find the appropriate program

() Select the program From a list
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Figure 5-6:
Windows
sometimes
helps you
find a
program for
opening an
orphaned
file.

If you already know the program needed to open your file, choose the second
option: Select the program from a list. That summons the familiar window from
Figure 5-4, letting you choose your program and click OK to open the file.

But if you have no idea which program should open your mystery file, choose
the Use the Web Service to Find the Appropriate Program button and click
the OK button. Windows dashes off to the Internet in search of the right pro-
gram. If you're lucky, Internet Explorer displays a Microsoft Web site like the
one in Figure 5-6. There, Microsoft identifies your file, describes its contents,
and suggests a Web site for downloading a capable program.

&1 Microsoft Application Search - Microsoft Internet Explorer B[=]=]
- File Edit View Favorites Tools Help "
& o Iﬂ IELI ;‘_‘ /--'Search :\T Favorites E? - ﬁ ) ‘i‘i
Address :i’ié:}‘http:Ushg!l.wﬁndgws.cqr@,l’ﬁIeassoc{om?i;m\{redit.a!sp?Efomov " . Go

A

Microsoft Windows File Associations

Windows Home Pages |

Windows has the following information about this file type. This page will help you find software needed to open your file.

File Type: QuickTime video file
File Extension: .mov
Description: This docurnent is a video file.
Software or information available at
o Apole Quicktitne
[f you are unable 1o find information at the above location, you can search the following Web sites for related software and informatio

CRNOWY.COM | UK Technical Support | Download. com | MSN | Shareware.com

& | [

i}l] http: ffww, apple.comfquickkime/download B Internet

Visit the Web site Microsoft suggests, download and install the program
(after scanning it with a virus-checking program described in Chapter 10),
and you’ve solved the problem.

v In Figure 5-6, Microsoft identified a QuickTime video file. (Microsoft’s rival,
Apple, created that format to store movies, but Windows’ Media Player
won'’t open it.) Luckily, Microsoft provided a link to Apple’s QuickTime
Web site, where you can download and install Apple’s QuickTime Movie
Viewer program.

v When you visit a Web site to download a suggested program, you often
find two versions: Free and Professional (expensive). The free version
usually works fine, so try it first.
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v If you can’t find any program that lets you open your file, you’re simply
stuck. You must contact the people who gave you that file and ask them
what program you need to open it. Then, unfortunately, you’ll probably
have to buy that program.

v The savior of unknown documents, Microsoft’s File Associations Web
site in Figure 5-6, identified the file’s extension as .mov.

Taking the Lazy Way with a Shortcut

Some items are buried way too deeply inside of your computer. If you're tired
of meandering through the woods to find your favorite program, folder, disk
drive, document, or even a Web site, create a shortcut — an icon push button
that takes you directly to the object of your desires.

Because a shortcut is a mere push button that launches something else, you
can move, delete, and copy shortcuts without harming the original. They're
safe, convenient, and easy to create. And they’re easy to tell apart from the
original, because they have a little arrow lodged in their bottom-right corner,
such as the FreeCell shortcut shown in the margin.

Follow these instructions to create shortcuts to these popular Windows
doodads:

Folders or Documents: Right-click on the folder, choose Send To, and select
the Desktop (Create Shortcut) option. When the shortcut appears on your
desktop, drag and drop it wherever you please.

Web sites: See the little icon in front of the Web site’s address in Internet
Explorer’s Address Bar? Drag and drop that little icon to your desktop —
or anyplace else. (It helps to drag one of Internet Explorer’s window edges
inward so you can see part of your desktop.)

Anything on your Start menu: Right-click on the object and choose Copy.
Then right-click where you want the shortcut to appear and choose Create
Shortcut.

Nearly anything else: Drag and drop the object to a new place while holding
down your right mouse button. When you let go of the mouse button, choose
Create Shortcut, and the shortcut appears.

Disk drives: Open My Computer, right-click on the drive, and choose Create
Shortcut. Then accept Windows gracious offer to place a shortcut to that
drive on your desktop, as shown in Figure 5-7.
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Figure 5-7:
Accept
Windows’
kind offer of
placing the
shortcut on
the desktop.
|

\NG/
Vg\\\

Shortcut

[ ] Windows cannot create a shartcut here
H’/ Do you want the shortcut to be placed on the desktop instead?

Yes Mo

v For quick CD burning, put a shortcut to your CD burner on your desktop.
Burning files to CD becomes as simple as dragging and dropping them
onto the CD burner’s new shortcut. (Double-click the CD burner’s short-
cut to begin burning.)

v Feel free to move shortcuts from place to place but don’t move the items
they launch. The shortcut won’t be able to find the item, causing Windows
to panic, searching (usually vainly) for the moved goods.

v You can often create quick shortcuts by holding down the right mouse
button while dragging and dropping an item to a new place. When you
let go of the mouse, choose Create Shortcut, and a shortcut appears.

v If you create a shortcut — but the icon doesn’t have that little arrow in
its bottom-left corner — stop. Calmly hold down the Ctrl button and
press Z to reverse your action. Then try again.

» Want to see what program a shortcut will launch? Right-click on the
shortcut, choose Properties, and click Find Target. The shortcut quickly
takes you to its leader.

The Absolutely Essential Guide to
Cutting, Copying, and Pasting

Windows XP took a tip from the kindergartners and made cut and paste play
an integral part of life. You can electronically cut or copy and then paste just
about anything somewhere else with little fuss and even less mess.

Windows programs are designed to work together and share information,
making it fairly easy to put a scanned map onto your party fliers. You can move
files by cutting or copying them from one place and pasting them into another.
Or within a program, you can cut and paste paragraphs to different locations.

The beauty of Windows XP is that, with all those windows on-screen at the
same time, you can easily grab bits and pieces from any of them and paste
all the parts into a new window.
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Don’t overlook copying and pasting for the small stuff. Copying a name and
address from your Address Book is much quicker than typing it into your
letter by hand. Or, when somebody e-mails you a Web address, copy and
paste it directly into Internet Explorer’s Address bar. It’s easy to copy items
displayed on Web sites, too (much to the dismay of many photographers).

The quick 'n’ dirty guide to cut 'n’ paste

In compliance with the Don’t Bore Me with Details Department, here’s a quick
guide to the three steps used for cutting, copying, and pasting:

1. Select the item to cut or copy: a few words, a file, a Web address, or
any other item.

2. Right-click on your selection and choose Cut or Copy from the menu,
depending on your needs.

Use Cut when you want to move something. Use Copy when you want to
create an exact copy of something.

Keyboard shortcut: Hold down Ctrl and press X to cut or C to copy.
3. Right-click on the item’s destination and choose Paste.

You can right-click inside a document, folder, or nearly any other place.
Keyboard shortcut: Hold down Ctrl and press P to paste.

The next three sections explain each of these three steps in more detail.

Selecting things to cut or copy

Before you can shuttle pieces of information to new places, you have to tell
Windows XP exactly what you want to grab. The easiest way to tell it is to
select the information with a mouse. In most cases, selecting involves one
swift trick with the mouse, which then highlights whatever you’ve selected:

v To select text in a document, Web site, or spreadsheet: Put the mouse
arrow or cursor at the beginning of the information you want and hold
down the mouse button. Then move the mouse to the end of the infor-
mation and release the button. That’s it! That selects all the stuff lying
between where you clicked and released, as shown in Figure 5-8.

Be careful after you highlight a bunch of text. If you accidentally press the
letter &, for instance, the program replaces your highlighted text with
the letter k. To reverse that calamity, choose Undo from the program’s
Edit menu (or press Ctrl+Z, which is the keyboard shortcut for Undo).
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Figure 5-8:
Windows
highlights
the selected
text, chang-
ing its color
for easy
visibility.

WMBER
@Y‘
&

+ To highlight part of a picture or drawing while in Paint, Windows’
graphics program: Click Paint’s Select tool — that little button with the
dotted lines in a square. (It's shown in the margin.) Then hold down the
mouse button and slide the mouse over the desired part of the picture.
Missed? Keep trying until you grab it.

1 To select any files or folders: Simply click a file or folder to select it. To
select several items, try these tricks:

¢ If all the files are in a row: Click the first item in the bunch, hold
down the Shift key, and then select the last item. Windows high-
lights the first and last item, as well as everything in between.

o If the files aren’t in a row: Hold down the Ctrl key while clicking
each file or folder you want to select.

[E] Being Frank - WordPad 9]=%]

File Edit View Insert Format Help

My wife went to an herb class, and she came back scared. When she
had mentioned that we used a microwave oven, the crowd blanched.

"Food loses its healthy aura,” they said. "The microwave drains away all
the vitamins, minerals and proteins. The food isn't food anymore."

Now my wife's afraid to use the microwave at all. So tell me this: Are
these a bunch of wacky technology-fearing New Agers who cook their
carrots with "crystal power," or am | slowly killing myself with my
microwaved turkey franks?

For Help, press F1

Now that you've selected the item, the next section explains how to cut or
copy it.

v After you've selected something, cut it or copy it immediately. If you
absentmindedly click the mouse someplace else, your highlighted text
or file reverts to its boring self, and you have to start over.

v To delete any selected item, be it a file, paragraph, or picture, press the
Delete key.

Cutting or copying your selected goods

After you select some information (which I describe in the preceding section,
in case you just arrived), you're ready to start playing with it. You can cut it
or copy it. (Or just press Delete to delete it.)
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Selecting individual letters, words,
paragraphs, and more
When dealing with words in Windows XP, these 1~ To select a single /ine of text, click next to it
shortcuts help you quickly select information: in the left margin. Keep holding down the
v~ To select an individual /etter or character, mouse bL{ttor) i move i MOuse up or
e - down to highlight additional text line by line.
click in front of the character. Then while . .. .
. . You can also keep selecting additional lines
holding down the Shift key, press your — . . .
: by holding down the Shift key and pressing
key. Keep holding down these two keys to
. i the | key or the T key.
keep selecting text in a line.
. . L v To select a paragraph, double-click next to
v To select a single Wor_d, point at it with the it in the left margin. Keep holding down the
mouse and double-click. The word turns .
L mouse button on the second click and move
black, meaning it's highlighted. (In most o o
the mouse to highlight additional text para-
word processors, you can hold down the ranh by paraaraoh
button on its second click, and then by graph by paragraph.
moving the mouse around, you can quickly  »~ To select an entire document, hold down
highlight additional text word by word.) Ctrl and press A. (Or choose Select All from
the Edit menu.)
K‘&N\BER
& This bears repeating. After selecting something, right-click on it. When the

menu pops up, choose Cut or Copy, depending on your needs, as shown in
Figure 5-9. Then right-click on your destination to choose Paste.

2%

% Being Frank - WordPad
File Edit View Insert Format Help
—
Figure 5-9:
Right-click S :
g the vitamins, minerals and . Cut s
onyour Copy
selection || Now my wife's afraid touse P2
and choose || these abunch of wackytec Font..
Cutto move || carrots with "crystal power,' Bullet Style
itinto || microwaved turkey franks? _ Paragraph-
another
window.
E— Cuks the selection and puts it on the Clipboard,

My wife went to an herb class, and she came back scared. When she
had mentioned that we used a microwave oven, the crowd blanched.

"Food loses its healthy aura." thev said. "The microwave drains away all

sn't food anymore."

Il. So tell me this: Are
w Agers who cook their
g myself with my
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The Cut and Copy options differ drastically. How do you know which one to
choose?

1 Choose Cut to move information. Cutting wipes the selected information

off the screen, but you haven’t lost anything: Windows stores the cut
information in a special Windows XP storage tank called the Clipboard
until you paste it.

Feel free to cut and paste entire files to different folders in My Computer.
When you cut a file in My Computer, the icon turns gray until you paste
it. (Making the file disappear would be too scary.) Changed your mind in
mid-cut? Press Esc to cancel the cut, and the icon reverts to normal.

+* Choose Copy to make a copy of the information. Compared with cut-

ting, copying information is quite anticlimactic. Whereas cutting removes

\\3

the item from view, copying the selected item leaves it in the window,
seemingly untouched. Copied information also goes to the Clipboard

until you paste it.

and print it from there.

To copy a picture of your entire Windows XP desktop (the whole screen) to
the Clipboard, press the Print Screen key, which is sometimes labeled PrtScrn
or something similar. (And, no, the Print Screen key doesn’t send anything to

your printer.) You can then paste the picture into Windows XP’s Paint program

Undoing what you've just done

Windows XP offers a zillion different ways for
you to do the same thing. Here are four ways to
access the Undo option, which unspills your
spilled milk:

v Hold down the Ctrl key and press the Z key.
The last mistake you made is reversed,
sparing you from further shame.

v Hold down the Alt key and press the
Backspace key. Nobody but you and the
computer know of your now-rectified error.

v Click Edit and then click Undo from the
menu that falls down. The last command

you made is undone, saving you from any
damage.

v Press and release the Alt key, press the
letter E (from Edit), and then press the letter
U (from Undo). Your last bungle is unbun-
gled, reversing any grievous penalties.

Don't bother learning all four methods. For exam-
ple, if you can remember the Ctrl+Z key combi-
nation, you can forget about the others. Best yet,
just write Ctrl+Z on the cover of the book. (The
publisher’'s marketing people wouldn't let me put
it there. Or my picture, but that's another story.)
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Pasting information to another place

After you cut or copy information to Windows XP’s Clipboard, it’s ready for
travel. You can paste that information nearly anyplace else.

Pasting is relatively straightforward:
1. Open the destination window and move the mouse to the spot where
you want the stuff to appear.
2. Then right-click the mouse and choose Paste from the pop-up menu.
Presto! The item you just cut or copied immediately leaps into its

new spot.

Or, if you want to paste a file onto the desktop, right-click on the desktop and
choose Paste. The cut or copied file appears where you’ve right-clicked.

v You can also choose the Paste command from a window’s menu bar:
Choose the word Edit and then choose the word Paste.

v The Paste command inserts a copy of the information that’s sitting on
the Clipboard. The information stays on the Clipboard, so you can keep
pasting the same thing into other places if you want.

v Some programs have toolbars along their tops, offering one-click access
to Cut, Copy, and Paste, as shown in Figure 5-10.

Copy
T—— Cut | Paste
Figure 5-10:
Cut, Copy,
and Paste
buttons.

Windows XP’s Free Programs!

Windows XP, the fanciest Windows version yet, comes with oodles of free
programs. This makes customers happy and makes the Justice Department
members flap their long black robes.

[ cover most free programs in other chapters. (Media Player, for example, gets
its due in Chapter 15; Outlook Express lives in Chapter 9.) This chapter merely
focuses on Windows XP’s most useful freebies: its WordPad and Notepad word
processors, Character Map, and Paint.



Chapter 5: Playing with Programs and Documents

Installing new programs and removing old ones

Because this type of construction takes place
in the Windows XP Control Panel, | cover it in
Chapter 11. But follow this basic procedure to
install a new program or remove an old one:

1. Create a restore point before installing the

After you install the program with the Control
Panel's Add or Remove Programsicon, name
your new restore point After Installing the
Program.

That leaves you two restore points to return to,
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new program. each with different benefits. If the new program
messes things up, return to the first restore point,
and Windows forgets the mess. If the new pro-
gram works fine, then use the second restore
point when using System Restore in the future.
(If you use any older restore points, Windows will

forget that you've installed that program.)

Covered in Chapter 17, the restore point
creates a snapshot of your computer’s most
important settings in case the program
messes anything up. Name the restore point
Before Installing the Program. (Be sure to
substitute your own program’s name.)

To uninstall a program, call up the Control
Panel's Add or Remove Programs icon, click the
unwanted program’s name from the list, and
click the Remove button.

2. Install the program and create a second
restore point.

Writing letters with WordPad

WordPad is nowhere near as fancy as some of the more expensive word
processors on the market. It can’t create tables or multiple columns, like the
ones in newspapers or newsletters, nor can you double-space your reports.
Ferget the spell checker, too.

Shown in Figure 5-11, WordPad is great for quick letters, simple reports, and
other basic stuff. You can change the fonts, too. And because all Windows
users have WordPad on their computers, anything you create in WordPad
can be read by 90 percent of other computer owners.

2 To give WordPad a whirl, choose All Programs from the Start menu, choose
| /§ Accessories, and click WordPad.
P If you've just ditched your typewriter for Windows, remember this: On an

electric typewriter, you have to press the Return key at the end of each line,
or else you start typing off the edge of the paper. Computers avoid that. They
automatically drop down a line and continue the sentence. (Hip computer
nerds call this phenomenon word wrap.)
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Figure 5-11:
WordPad
lets you
write short
letters
without
buying a
word
processor.
|

v To change fonts in WordPad, select the words you’d like to change (or
select the entire document by choosing Select All from the Edit menu).
Then choose Font from the Format menu. Click the name of the font you
want; the Sample box offers a preview. Click the OK button, and WordPad
displays your changes.

v Quickly insert the current day, date, or time into your document by
choosing Date and Time from the Insert menu. Choose the style of date
or time you want, and WordPad inserts it into your document.

5] Pictures Increase Book Sales - WordPad =&
File Edit View Insert Format Help

Steve Hayes

Senior Acquisitions Editor
Wiley Publishing

Tuesday, May 11, 2004

Dear Mr. Hayes,

It has come to my attention that many authors place their photographs on the covers and spines of their
books. Current studies by the Computer Book Writer's Suppert &roup confirm this practice to jncrease
book sales by a substantial margin.

TI've enclosed several photos of myself to use for the next printing of Windows XP For Dummies. Please
correct this situation as soon as possible.

Best,

Andy Dathhans
For Help, press F1

Jotting down notes with Notepad

Use WordPad for letters that you want other people to see. Notepad works
best for stuff you're going to keep for yourself. Like its name, it’s designed
for typing notes to save on the fly.

To nudge Notepad into life, choose All Programs from the Start menu, choose
Accessories, and click Notepad.

Unfortunately, Notepad tosses you into instant confusion: When you start
typing, the sentences head right off the edge of the window and out of sight.
To turn those single-line, runaway sentences into normal paragraphs, choose
Word Wrap from the Format menu, as shown in Figure 5-12. Windows XP
remembers your preference and wraps the lines to fit the page the next time
you reach for Notepad.



Figure 5-12:
If Notepad's
lines run off
the edge,
choose
Word Wrap
from the
Format
menu.
|
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Character
Map finds
symbols and
foreign
characters
to place in
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4 journal - Notepad

EE]

File Edit | Format View Help

Septembe v Word Wrap [}X

Faont...
Dreamt last g taEr 11 d brought an onacinto the office. Or
perhaps itwas a gnu or a yak. YWe immediately started playing
Scrabble in the lunch room.

October 4, 2004
Slept, awoke, slept, awoke. Despair, Kafka was right.
December 1, 2004

The rental video jammed in the VCR, so did the envelope opener
and my arm.

Another warning: Unlike most word processors, Notepad doesn’t print exactly
what you see on-screen. Instead, it prints according to the margins you set in
Page Setup from the Format menu. This quirk can lead to unpredictable results.
Stick with WordPad for documents you want to print.

Turn Notepad into a logbook by typing .LOG as the first sentence of your file.
Whenever you open that file, Notepad jumps to the bottom of the file and
inserts the current time and date before you start typing.

Finding symbols like © with Character Map

Character Map lets you insert common symbols and foreign characters into
your current document, giving your documents that extra coup de grice. The
handy little program displays a box like the one shown in Figure 5-13, listing

every available character and symbol.

%2 Character Map =)

Font: | O Times New Roman v El
DL 8 (%l & | a*+].]- flof1|2)3]|4]|~
516|7(8|9 === V@ A|B|C|DIE|F|G|H
I(T|E|LM|O|P|QE|\S|T|U|VIW|X|TIZ[|
11 _ alblc|d|e|f|g|h|t]|1]k|]l|m olp
glr|s|t|u|w|w/=z{¥|lz|{]]|[}]|~ il ¢ ol 3
BTN = R A - I S EJ N R R TR | .| F
o[ [sa|vhma]  |RTAA]ATA] A|Z| C|E|E|E|E| T]1
i 1|p[f|o]|e|6]d|o]=|a|u|u|tu|T|e|s]|a]4
ildlald|= Ele|Ele|i|i|t]|i|d|f|s|6]|a]|8
s|+|e|o]alala|s|p|v|Ala|A]alalalC]e|d]e]|

Characters ba copy: |© Select Copy

[ advanced view

U+0043: Copyright Sign Keystioke: Alt+0169
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For instance, follow these steps to insert the copyright character —© —
somewhere in your work:

1.

1

’/

1

Click the Start menu, choose All Programs, select Accessories, choose
System Tools, and select Character Map.

. Make sure that your current font — the name for the style of your

letters — shows in the Font box.

If the font you’re using in your document isn’t showing, click the Font box’s
down arrow and click your font when it appears in the drop-down list.

. Scan the Character Map box until you see the symbol you’re after;

then pounce on that character with a double-click.

The symbol appears in the Characters to Copy box.

. Right-click in the document where you want the symbol to appear and

choose Paste.

The symbol appears, conveniently using the same font as your document.

If you use foreign words a lot, place a shortcut to Character Map on your
desktop, ready for quick consultation. Right-click on Character Map from
the Start menu and choose Copy. Right-click on your desktop and choose
Paste as Shortcut. ;Que conveniencia!

Find yourself constantly typing the same foreign character or symbol?
Then memorize its shortcut key sequence, the little numbers shown in
Character Map’s bottom-right corner. See how Figure 5-13 says Keystroke
AT1t+0169? That’s the shortcut for the copyright symbol. To paste © into
any document any time, hold down Alt and type 0169 using your key-
board’s numeric keypad. The copyright symbol appears as you release
the Alt key. (Make sure your Num Lock key is turned on.)

Table 5-1 lists the shortcut keys for some commonly used symbols.

Table 5-1 Handy Codes for Handy Characters

To Insert This . . . ... Press This

©

Alt+0169

®

Alt+0174

°

as in 75°) Alt+0176

™

Alt+0153

£

Alt+0163

¢

Alt+0162
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Drawing and editing photos with Paint

A very basic graphics program, Paint creates simple drawings. If it’s the
only graphics program you have, you'll probably use it mostly for cropping
photos, which I explain in detail in Chapter 16. Open the Start menu, choose
All Programs, and select Accessories to find Paint.

v With such limited capabilities, Paint is better for quick touch-ups than
ground-zero creations.

v You can paste anything you create or edit in Paint into almost any other
Windows XP program. Paint enables you to add text and numbers to
graphics, so you can add street names to maps copied from the Internet,

put labels inside your drawings, or add the vintage year to your wine
labels.

v Paint opens and saves files in BMP, JPG, GIF, TIF, and PNG formats. Use
JPG for photographs, TIF for production-quality work, and PNG or GIF
for Web buttons. Stay away from BMP. (BMP files are huge.)
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Chapter 6
| Gan't Find It!

In This Chapter
Finding lost windows
Finding lost files and downloaded files

Finding misplaced snippets of information

S)oner or later, Windows XP gives you that head-scratching feeling.
“Golly,” you say, as you frantically tug on your mouse cord, “that stuff
was right there a second ago. Where did it go?” When Windows XP starts
playing hide-and-seek with your information, this chapter tells you where to
search and how to make it stop playing foolish games. Then when you find
your missing Solitaire window, you can get back to work.

The Search Companion works fairly well at dredging up items lost inside your
computer or network. But it stumbles when asked to search the Internet. To
do that, use Goolge instead. Flip to Chapter 8 for details. And to search your
e-mail, use Outlook’s Find feature, covered in Chapter 9.

Finding Lost Windows on the Desktop

Windows XP works more like a spike memo holder than an actual desktop.
Every time you open a new window, you toss another piece of information
onto the spike. The window at the top is easy to spot, but what happened to
the one just beneath it?

If you can see any part of that window’s edge or corner, a well-placed click
will fetch it. The second place to look is the taskbar. If you see a button for
your missing window there, click it to bring the window to the top. (See
Chapter 2 for details about the taskbar.)

But if your window’s still missing — or you’re not sure if it's even on the
desktop anymore — bring in the Windows Task Manager. The Task Manager
automatically keeps a master list of every open window, making it a cinch to
hunt down lost windows. Here’s how:
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Figure 6-1:
Pressing
Ctrl, Alt, and
Delete
simultane-
ously brings
up the Task
Manager,
which lists
all open
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Applications
tab.
|
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1. To summon the Windows Task Manager, press the Magic Key Sequence:
Simultaneously press the Ctrl, Alt, and Delete keys. (Most people use
two hands for this; others contort their right hands only.)

The Task Manager appears, as shown in Figure 6-1.

= Windows Task Manager B[]
File Options ‘iew Windows ShutDown Help
Applications | Processes | Performance Metworking | Users
Task Status
_é My Pichures Running
@Andy Rathbone - Microsoft Internet Explorer Running
¥ Freecell Game #11952 Running
C_r' Control Panel Running
'_i My Docurnents Running
ﬂMy Music Running
'§ Saint Francois d'dssise - Ozamwa Runining
< >
End Task ] | Swikch To R! | hlew Task... ]
Processes: 28 CPU Usage: 1% Commit Charge; 159M [ 1583M

2. Click the Applications tab, shown at the top of Figure 6-1, and the Task
Manager lists all your currently running programs.

The Task Manager lists open windows by program name and filename. In
Figure 6-1, for instance, Internet Explorer is visiting www.andyrathbone.
com, and FreeCell is playing game #11982.

Your missing window is somewhere on that list.

3. When you spot your window, click its name and click the Switch To
button along the Task Manager’s bottom.

The Task Manager pulls your wayward window to the top of the desktop.

Don’t spot your missing window on the list? Then it’s no longer running.
Restart the program from the Start menu or reopen the document you
were working on.

If you're convinced a window is open but still can’t find it, tell the Task
Manager to tile every open window across the desktop for closer inspection:
Choose Tile Horizontally from the Task Manager’s Windows menu. It’s a last
resort, but perhaps you’ll pick your missing window from the lineup.
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Finding Lost Files, Folders, Music, Photos,
Videos, People, or Computers

|
Figure 6-2:
Click the
Start button
and choose
Searchto
look for
things

on your
computer or
the Internet.
|

Windows XP has gotten much better at finding things. And it should because
it’s the one who lost everything in the first place. When one of your files, fold-
ers, or just about anything else disappears into the depths of your computer,
tell Windows XP to bring the darn thing back with the Search Companion.

To befriend the Companion, click Windows XP’s Start button and choose
Search from the menu, as shown in Figure 6-2.

I: Aneky

@ Internet ,-J My Documents

Internet Explarer

:?; My Recent Documents »

€™ E-mail
= Outlook Express &

;J My Pictures

b y
“I" Pairt (22 My Music
v« My Computer
c’) Windows Media Player ‘J
‘J) My Network Places
I __54 Motepad
! Ef Control Panel
'li”: Chex @ Set Program Access and
ex Defaults
@ Tour Windows <P e, Connect To *
=
|*) Printers and Faxes
<=
gj FreeCell
Qj Help and Support
,_) Seatch
All Programs D ] Run...

Log OFF | @8 Turn OFf Computer

e lstisse}

When you open the Search Companion for the first time, Windows XP asks
whether you’d like to search with or without an animated character. Cartoon
lovers should choose one of several characters: a big-eyed doggy, a gal in a
convertible spaceship, a surfing alien, or Merlin the wizard. The character
subsequently watches your moves, blinking, barking, or twitching when you
click. (That’s as helpful as it gets.)

When you tire of the excitement, turn off the animated character by clicking
it and choosing Turn Off the Animated Character. (The same page lets you
choose a different character during a spat.)
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If you want to search a certain place quickly — a single folder, for example —
Windows XP obliges with its all-powerful right-click. Right-click on any folder
and choose Search from the pop-up menu. The Search Companion leaps into
action, presenting its usual menus with one exception: The search is limited
to the place you right-clicked, be it a folder, disk drive, or memory card.

Finding any lost files or folders

Following these steps helps the Search Companion locate any file that’s lost
somewhere inside your computer.

For example, suppose that your file called Hydrator Inspection disappeared
over the weekend. To make matters worse, you're not even sure you spelled
the words hydrator or inspection correctly when naming the file. You don’t
remember what program you used to create your file. Word? WordPad?
Notepad? Who knows? All you know is that the hydrator was moldy — so
the word moldy appears somewhere inside the missing file. Even with that
little bit of information, Search Companion can probably find your file.

Here’s how to scour your computer for any file:

1. Click the Start button and click Search.
2. Click the words All Files and Folders.

That tells the Search Companion to search through every type of file and
folder, as shown in Figure 6-3. Now, you need to tell Windows XP what to
search for.

What do you want to search
for?

EJ Pictures, music, or video

£ Documents (word
processing, spreadsheet,
ekc,)

EJ allfiles and Folders {E’}
ﬂ Computers or people!

@) Information in Help and
Support Center

‘ou may also want to...
&'3 Search the Internet
B Change preferences

AT

- U h
'S

£
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Figure 6-4:
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3. In the All or Part of the File Name box, enter any part of your missing

file’s name.

Although not essential for searching, entering any part of the missing file’s
name speeds up the search. So enter inspection in the first box, as shown
in Figure 6-4. (Don’t know any of the file’s name? Simply leave it blank.)

Search by any or all of the
criteria below.

All or part aof the File name:
inspection

A word or phrase in the file:
moldy

Look, in:

§ My Computer »
When was it modified? ¥
What size is it? ¥

More advanced options ¥

[ Back H Search V\r\ls

o
fet
-

L5}

4. In the A Word or Phrase in the File box, enter a word that appears in

the file.

Search for words least likely to turn up in other files. For example, I
entered the word moldy in Figure 6-4 because it’s more unique than
like, an, or the.

. Tell Windows XP where to search by choosing an option from the

Look In drop-down list.

My Computer: If you don’t know what folder the file is hiding in, My
Computer searches your entire computer (including your CD drive).
Remove CDs before clicking My Computer for searches because CDs
take a long time to search.

My Documents: Tell the Search Companion to look inside your My
Documents folder before searching your entire computer. Many pro-
grams automatically save your information into that folder.

If you remember the name of the folder where you stored the file, click
the Browse button to search inside only that folder.

111
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P Messed up on any choices? Just click the Back button at the bottom of
the menu to fix your mistake. Or keep clicking Back until you arrive at the
original menu, where you can start over.

. Enter any other clues in the other menus, such as the When Was It
Modified menu, by clicking the down arrows next to a menu name.
If you told Windows XP to search a specific folder in Step 5, be sure to click
the More Advanced Options area and click the Search Subfolders box. The
Search will then include any folders living inside that folder, as well.

P The Search Companion’s question When Was It Modified really means
When Was It Last Saved. That could mean the date you dumped it into
your computer, the date you last changed it in a program, or the date you
last changed its name.

. When you’re satisfied you’ve made your choices correctly, click the
Search button.
The little doggy wags its tail, and the Search Companion searches accord-
ing to your command. In my example, it finds and displays any file or folder
on your entire computer witsh a name that contains the word inspection
as well as the word moldy somewhere inside. The result? It found the file
even though hydrator was misspelled, as shown in Figure 6-5.
. Double-click the file or folder to open it and begin working again.
To find out where it was hiding, right-click on the file and choose Open
Containing Folder.
| Search Results == %]
File Edit View Favorites Tools Help i
?‘ /‘ Search Folders Elv
iddress | ) Search Results [v| By a0
Search Companion X MName In Folder
I"i'\ Hydrater Inspection CiiDocuments and SettingstiandyiDesktop
|
Figure 6-5: || Jrstyosmantess ™
The SearCh 3 Yes, finished searching
Companion NRE3Zne s see
SearChes Mo, refine this search and...
the entire E3 Chenge file name or
keywords
CompUter E3 Look in more locations
and a %Tclude hidden and system
retrieves :t )
any f||es o Start 2 pew seardl
containing
the word
, 00"
you've A2
entered. .
—— ‘J;-'ﬂf < >
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Finding lost pictures, music, or video

Can’t find the digital pictures you copied from the digital camera yesterday?
Where’s that MP3 song you downloaded sometime last week? Or perhaps
you’re missing a short video that a friend e-mailed to you. The Search
Companion can easily extract these types of missing files from your com-
puter’s digital jowls. Just follow these steps:

1. Click the Start button and click Search.

2. When the menu appears, choose the option marked Pictures, Music,
or Video.

3. Yet another menu appears, offering three search options: 1) Pictures
and Photos, 2) Music and Sound, or 3) Video. Click in the box next
to your missing item and type any part of the file’s name in the sec-
ond box.

Unfortunately, unless you can help narrow down the search, the over-
eager Search Companion will find all of your pictures, music, or videos.

4. To increase your odds of a match, click Use More Advanced Options.
When that menu appears, add more clues: Where your file is located
inside your computer, when it was saved, or its approximate size.

5. Click Search, and the Search Companion finds every file meeting your
specifications.

Finding lost documents

Lost an important Word or Excel document? Search Companion’s ready to
help out here, too. Because you know it was a Word or Excel document, this
search is fairly easy:

1. Click the Start button, click Search, and select Documents (Word,
Excel, etc.).

2. When the box appears, type in the missing document’s name.
Click the round button next to the time the file was last changed
or saved. Click Search, and the Search Companion ferrets out
your file.

Because the Search Companion knows which program created your files, it
limits its search to those files exclusively (Word or Excel files, in this case)
speeding up the search considerably.
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Finding computers or people

Like a teenager who’s watched too many sci-fi flicks, Windows XP lumps
computers and people in the same category when searching. Neither type of
search is all that exciting, unfortunately, but here goes.The Computer search
is only for people working on nefworks, mysteriously bundled bunches of
computers, covered in Chapter 14. Don’t know if you’re on a network? You
can still use it. Just follow these steps:

1. Click the Start button, click Search, and choose the Computers or
People option.

2. Choose the A Computer on the Network option.

3. Enter the name of the networked computer that you want to search
for and then click the Search button.

But what if you don’t know the computer’s name? Here’s a trick: Just click
the Search button. A list of computers connected to your own computer
appears. (If just one computer appears, don’t get excited. It’s probably
just your own.)

Don’t use this option to search networked computers for files. To do that, fire
up the Search Companion and enter your query in the first two boxes. But in
the Look In box (refer to Figure 6-4), choose Browse. Browse to the networked
computer you'd like to search and click the Search button.

The People search isn’t nearly as exciting as it sounds, even for singles. It
normally just searches through your Address Book, something easily done
from your Address Book itself. (I cover the Address Book in Chapter 9.)



Chapter 7
Printing, Faxing, and Scanning

In This Chapter
Printing files, envelopes, or Web pages
Adjusting how your work fits on a page
Installing fonts
Troubleshooting printer problems
Sending and receiving faxes

Scanning documents

ou asked for it — you got it. Readers of the first edition of Windows XP
For Dummies asked for more information about printers, faxing, and scan-
ners, so I've devoted an entire chapter to the subject in this second edition.

Here you find out how to make that troublesome document fit on a piece of
paper without hanging off the right edge. I cover the mysterious print queue,
a little-known area that lets you cancel documents mistakenly sent to the
printer — before they waste all your paper.

When you’re ready to spiff up your work with some new fonts, you’ll discover
how to install them and view them on the screen, before they're even printed.

Another section explains how to turn your computer into a free fax machine
by installing the fax program hidden on the Windows XP CD. Now you can
delete those junk faxes before they waste your roll of fax paper.

Finally, the last section explains how to scan something with your scanner,
choose the right resolution, and fix things if they turn out awful.

Printing Your Masterwork

Windows XP shuttles your work off to the printer in any of a half-dozen differ-
ent ways. Chances are, you’ll be using these three the most:
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v Choose Print from your program’s File menu.
v~ Right-click on your document icon and choose Print.

v Drag and drop a document’s icon onto the printer icon.

If a dialog box appears, click the OK button; Windows XP immediately begins
sending your pages to the printer. Take a minute or so to refresh your coffee.
If the printer’s turned on (and still has paper), Windows handles everything
automatically. If your coffee cup’s still full, keep on working or playing FreeCell.
Windows prints your work in the background.

If the printed pages don’t look quite right — perhaps the information doesn’t fit
on the paper correctly or it looks faded — then you're ready to fiddle around
with the print settings or perhaps change the paper quality, as described in the
next sections.

v Stumbled upon a particularly helpful page in the Window Help system?
Right-click inside that helpful topic or page and choose Print. Windows
prints out a copy for you to tape to your wall or save in this book.

v For quick 'n’ easy access to your printer, right-click your printer’s icon
and choose Create Shortcut. Windows XP puts a shortcut to your printer
on your desktop. To print things, just drag and drop their icons onto
your printer’s new shortcut. (You can find your printer’s icon by clicking
Printers and Faxes from the Start menu.)

v To print a bunch of documents quickly, select all their icons. Then right-
click on the selected icons and choose Print. Windows XP quickly shuttles
all of them to the printer where they emerge on paper, one after the other.

v~ Still haven'’t installed a printer? Flip ahead to Chapter 11, where I explain
how to plug one in and make Windows XP embrace it.

Adjusting how your work fits on the page

In theory, Windows always displays your work as if it were printed on paper.
Microsoft’s marketing department calls it What You See Is What You Get, for-
ever disgraced with the awful acronym WYSIWYG and its even more awful
pronunciation: “wizzy-wig.” If what you see on-screen isn’t what you want

to see on paper, a trip to the program’s Page Setup dialog box usually sets
things straight.

Page Setup, found on nearly any program’s File menu, offers several ways to
flow your work across a printed page (and subsequently your screen). Page
Setup dialog boxes differ among programs, but I've listed the options that
you'll find most often and the settings that usually work fine, and explain
what happens if you change them anyway. Figure 7-1 shows the Page Setup
dialog box from Internet Explorer.
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Page Setup [B3[%]
Paper
Size: ST
I Letter [ =
Figure 7-1: | 2= . |
Ch oose _Autnmat\cally Select [ i
Page Setup Headers and Foaters
fr om a Headsr
program's BuisbPage fp of &P
. Footer
Filemenuto | ~=°
adjust the
Way yO ur Crientation Margins {inches)
- @ Prtrait Left: 0.75 Right: | 0.75
work fits | T
onto a piece CJ Landscape Top: 0.75 Bottom: | 0.75
Of pa pe r. [ 0k J [ Cancel ] I Printer...
I

Size: This lets your program know what size of paper you're currently using.
Leave this set to Letter to print on standard, 8.5-x-11-inch sheets of paper.
Change this setting if you're using legal size paper (8.5 x 14), envelopes, or
other paper sizes. (The nearby sidebar, “Printing envelopes without fuss,”
contains more information about printing envelopes.)

Source: Choose Automatically unless you’re using a fancy printer that accepts
paper from more than one printer tray. People with two or more printer trays
can select the tray containing the correct paper size. Some printers offer Manual
Paper Feed, making the printer wait until you slide in that single sheet of paper.

Peeking at your printed page before it hits paper

For many, printing requires a leap of faith: You
choose Print from the menu and close your eyes
while the thing prints out. If you're blessed, the
page looks fine. But if you're cursed, you've
wasted another sheet of paper.

The Print Preview option, found on nearly every
program'’s File menu, foretells your printing fate
before the words hit paper. Print Preview com-
pares your current work with your program’s
page settings and then displays a detailed pic-
ture of the printed page. That makes it easy to
spot off-kilter margins, dangling sentences, and
other printing fouls.

Different programs use slightly different Print
Preview screens, with some offering more insight
than others. Microsoft Word’s Print Preview, for
instance, even lets you make on-the-fly changes
by dragging and dropping the margins to change
the page’s flow. But almost any program’s Print
Preview screen lets you know whether every-
thing will fit onto the page correctly.

If the preview looks fine, choose Print at the
window's top to send the work to the printer. If
something looks wrong, however, click Close to
return to your work and make any necessary
adjustments.
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Header/Footer: Type secret codes in these boxes to customize what the
printer places along the top and bottom of your pages: page numbers, titles,
dates, for instance, as well as their spacing. For example, type %b%p in the
Footer box of Internet Explorer’s Page Setup dialog box to center the current
page number at the bottom of each printed page. (The Remember tip that fol-
lows explains how to locate and decipher your particular program’s secret
codes.)

Orientation: Leave this set to Portrait to print normal pages that read verti-
cally like a letter. Choose Landscape only when you want to print sideways;

this setting is often used for printing wide spreadsheets. (If you choose
Landscape, the printer automatically prints the page that way; you don’t
need to slide the paper sideways into the printer.)

Margins: You'll rarely change this setting, but if you do, keep the margins
equal along the left and right sides.

Printer: If you have more than one printer installed on your computer or net-
work, click this button to choose between them. Click here to change your
printer’s settings as well, as discussed in the next section.

When you’re finished adjusting settings, click the OK button to save your
changes. (Click the Print Preview button, if it’s offered, to make sure every-

thing looks right.)

Printing envelopes without fuss

Although it's fairly easy to choose Envelopes
from a program’s Page Setup area, it's extraordi-
narily difficult to print addresses in the correct
spot on the envelope. Some printer models want
you to insert envelopes upside down, others
prefer right side up. Your best bet is to run sev-
eral tests, placing the envelope into your printer's
tray different ways until you finally stumble on
the magic method. (Or you can pull out your
printer's manual, if you still have it, and look at the
“proper envelope insertion” pictures.)

After you've figured out the correct method,
tape a successfully printed envelope above
your printer showing the correct way to insert it
into the tray.

When you eventually give up on printing
envelopes, try using Avery's mailing labels. Buy
your preferred size of Avery labels and then
download the free Avery Wizard from Avery's
Web site (www.avery.com/us/software/
index. jsp). Compatible with Microsoft Word,
the wizard places little boxes on your screen that
precisely match the size of your particular Avery
labels. Type the addresses into the little boxes
and insert the label sheet into your printer, and
Word prints everything onto the little stickers. You
don't even need to lick them.

Or do like | did: Buy one of those little rubber
stamps with your return address. They’re much
faster than stickers or printers.
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Unfortunately, programs don’t use the same secret codes for their header
and footer. To see your program’s codes, click the little question mark in the
Page Setup dialog box’s top-right corner and then click inside the Header or
Footer box. A pop-up box appears, listing the secret codes and their meaning.
(To make a handy printout, right-click inside the pop-up box and choose
Print Topic.)

Adjusting your printer’s settings

When you choose Print from a program’s File menu, Windows offers one last
chance to spruce up your printed page work. The Print dialog box, shown in
Figure 7-2, lets you route your work to any printers installed on your com-
puter or network. While there, you can adjust the printer’s settings, choose
your paper quality, and select the pages you’d like to print.

= Print [2[%]
General
Select Prirker
,_l ] A
e
=
Add Printer  Epson Stylus
Fhoto 1270
ESCIP 2 |
Statuz:  Offline [ Print to file ‘ Prefsrences[
Location:
Commant Find Printer...
Page Range
@al Humber of copies: |1 [
() Pages: 1-65535 L 5 I_3
Enter either a single page number or a single 12 112
page range. For example, 512

Select Printer: Ignore this option if you have only one printer because
Windows chooses it automatically. If your computer has access to more than
one printer, click the one that should receive the job.

Page Range: Select All to print your entire document. To print just a few of its
pages, select the Pages option button and enter the page numbers you want
to print.

Number of Copies: Most people leave this set to 1 copy, unless everybody in
the boardroom wants their own copy.
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Preferences: Click this button to see a dialog box like the one in Figure 7-3,
where you can choose options specific to your own printer model. The
Preferences area typically lets you choose different types of paper, decide
on color or black and white, set the printing quality, and make last-minute
corrections to the page layout.

.2 Printing Preferences B]%]
Layout | Paper/Quality | Utiities
Tray Selection
Paper Source: Qﬁ Autamaticaly Select -v
Media: 3B0dpi Inkjet Paper ~
Quality Settings
O Best & Mormal O Drat [ Custom
Calor
=& ~
|¢,§3 () Black & White
-
Advanced..

Canceling a print job

Just realized you sent the wrong 26-page document to the printer? Panic and
flip the printer’s off switch. Unfortunately, most printers automatically pick
up where they left off when you turn them back on.

So, to purge your mistake from your printer’s memory, double-click your
Printer’s icon (which sometimes sits by the taskbar’s clock) to reveal the
print queue, shown in Figure 7-4. Right-click on your mistaken document and
choose Cancel to end the job. When you turn your printer back on, it won’t
keep printing that same darn document.

_# Epson Stylus Photo 1270 ESC/P 2 _ Use Printer Offline [B[=)]=]
Printer Document Miew Help

Document Mame Status Cnner Pages Size Submitted Port

@Dream Journal - Notepad Andy 1 1.45KB 11:41:12 AW 5/17/2004

@The Diebald memos - Notepad Andy 14 42,6 KB 11:41:21 AM 5/17[2004

@Freaculture‘pdf Spooling Andy 18 16,2 MEB 11:41:34 AM 5{17/2004

(R

<

3 document(s) in queue
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v If you can’t find your printer’s icon, try choosing Control Panel from the
Start menu and double-click the Printers and Faxes icon.

v The print queue, also known as the print spooler, lists every document
waiting patiently to reach your printer. Feel free to change their printing
order by dragging and dropping them up or down the list. (You can’t
move anything in front of the currently printing document, though.)

v If your printer runs out of paper during a job and stubbornly halts, add
more paper. Then to start things flowing again, open the Print Queue,
right-click on your document, and choose Restart. (Some printers let
you push their Online button to begin printing again.)

v You can send items to the printer even when you're working in the
coffee shop with your laptop. When you connect the laptop to your
office printer, the print queue notices and begins sending your files.
(Beware: When they’re in the print queue, documents are formatted for
your specific printer model. If you subsequently connect your laptop to
a different printer model, the print queue’s waiting documents won’t
print out correctly.)

Printing a Web page

Although information-chocked Web pages look awfully tempting, printing
those Web pages is rarely satisfying because they look so awful on paper.
When sent to the printer, Web pages often run off the page’s right side, con-
sume zillions of additional pages, or are much too small to read.

To make matters worse, all those colorful advertisements can suck your
printer’s color cartridges dry fairly quickly. Only three things make for suc-
cessfully printed Web pages, and I've ranked them in order of success:

Use the Web page’s Print This Page option. Some, but not all, Web sites offer a
tiny menu option called Print This Page, Text Version, Printer-Friendly Version,
or something similar. That option tells the Web site to reformat the page as if
it were a simple letter, stripping out all the garbage. This is the most reliable
way to print a Web page.

Copy the portions you want and paste into WordPad. Try selecting the
desired text from the Web page, copying it, and pasting it into WordPad or
another word processor. Delete any unwanted remnants, adjust the margins,
and print the portion you want. Chapter 5 explains how to copy and paste.

Copy the entire page and paste it into a word processor. Although it’s lots
of work, it’s an option. Choose Select All from Internet Explorer’s Edit menu.
Then choose Copy (which is also on the Edit menu) or press Ctrl+C. Next,
open Microsoft Word or another full-featured word processor and paste it
inside a new document. By hacking away at the unwanted portions, you can
sometimes end up with something printable.
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v The only surefire way to print a Web page is if the Web page’s designer
was thoughtful enough to create a Print This Page option. If you spot an
E-Mail option but no Print option, e-mail it to yourself. You’ll probably
have better success printing it as an e-mail message.

v To print just a few paragraphs of a Web page, use the mouse to select
the portion you're after. (I cover selecting in Chapter 5.) Choose Print
from Internet Explorer’s File menu to open the Print dialog box and then
click the word Selection in the Page Range box.

P v~ If a Web page’s table or photo insists on vanishing off the paper’s right
edge, try printing the page in Landscape mode rather than Portrait. See
the “Adjusting how your work fits on the page” section, earlier in this
chapter, for details on Landscape mode.

Installing new fonts

Fonts change the appearance of letters, adding a different mood to your docu-
ment. Windows XP comes with several dozen different fonts, and you can
view them all fairly easily.

A4 To see all your currently installed fonts, open the Control Panel from the
/_,_,,,( Start menu, click Switch to Classic View, and double-click the Fonts icon
(shown in the margin). Windows XP lists all your fonts by name. Double-click
any font — the Impact font icon, for instance — and Windows XP shows how
that font looks on the printed page, as shown in Figure 7-5. (Click the Print
button to send a sample to your printer.)

o Impact (OpenType)

Impact (OpenType)

DpenType Font, Digitally Signed, TrueTyvpe Cutlines
Typeface name: Impact

File size: 133 KB

Figure 7-5: [Version: Yersion 2.35

. Digitized data copyright (C) 1991-1996 The Monotype Carpaoration. All rights reserved. Impact is a frademark of Stephenson Blake
Double-click (Holdings) Ld.

any font's |ahcdefghijkimnopar stuviwiyz
name to see |[ABCDEFGHIJKLMHOPQRSTUYWXYZ
whatit [123456789...L19]
would look |z The quick broum faxjumps over the lazy doy. 1234567890

like on .o The quick brown fox jumps over the lazy dog. 1234567890
Papet . The guick brown fox jumps over the lazy doy. 1234567890
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Printing your Qutlook Express Address Book

Although it's important to back up your Address Memo: Print everything about the contact.
Book (which I cover in Chapter 9), it's downright
handy to printit— or at least print contact infor-
mation for the people you'll be meeting that day.
Here's how to turn a piece of paper into a per-
sonalized, on-the-fly address book: Phone List: Print each contact’s name and
phone numbers (cell, fax, home, business).

Business Card: Print standard business card
items for that person, including name, phone,
address, company, and e-mail address.

1. Open Address Book from Outlook Express
and select the people to print. 3. Click Print.

Press Ctrl+A to highlight everybody or just  QOutlook Express prints a neatly formatted list
hold down Ctrl and click the names youwant.  according to your specifications. If you've never
printed from Address Book, try each option to

2. Choose Print from the File menu, select see the look. It's worth three sheets of paper.

your printer, and choose your Print Style.

In the Print Style section, Outlook Express
offers three ways to print your contact sheet:

A\

If you’re not happy with your current font selection, you can buy or download
new ones and install them on your computer. Most fonts sold at stores come
with installation programs that spare you the messy details in Windows XP’s
font installer. But if your new font didn’t come with an installation package,
here’s how to install it:

1. Place your new font in your My Documents folder.

E Many downloaded fonts arrive inside a compressed folder, also called a

I zipped folder. (Zipped folders have a little zipper on their icon, shown in
the margin.) If your font arrived this way, right-click on its icon, choose
Extract All, and let the wizard extract its contents to your My Documents
folder.

If you'll be installing a lot of fonts, create a new folder called Fonts inside
your My Documents folder and use it as a dumping ground for fonts.

2. Open the Control Panel, switch to Classic View, and double-click the
Fonts icon.

Windows Fonts folder appears on the screen, listing all your currently
installed fonts.

3. Choose Install New Font from the folder’s File menu.

4. Navigate to the folder containing your new font.
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For some reason, Microsoft never bothered to update its Add Fonts
program for Windows XP, so you're stuck with an ugly and confusing
holdover from yesteryear. And that holdover, unfortunately, can’t auto-
matically find your My Documents folder.

To navigate manually to the font waiting in your My Documents folder,
double-click the C:\ drive at the list’s top.

Then double-click the Documents and Settings folder, followed by your
user name. Finally, double-click the My Documents folder, making the
window look like the one in Figure 7-6. The program finally lists any fonts
contained in your My Documents folder.

1 Add Fonts E

e

List of fonts:
Abduction2002 (TueType]

Select Al

Folders:
Sy documents

= o Al
[F= Documents and S¢ i

Drives:

=K v

;Cl N‘!is.cz.a\la.naous e Copy fonts to Fonts folder

5. Click the name of the font you want to install and click OK.

To reward you for all the work, Windows XP quickly installs your font,
and its name appears on the font menus of all your programs.

v Don’t remove the check mark from the Copy Fonts to Fonts Folder check
box, shown in Figure 7-6. Windows must copy your fonts to live with all
your other fonts, or programs won’t be able to find them. In fact, after
you've installed a font, you can delete its installation files. (Better yet,
copy the installation files to a CD and save them as a backup.)

v To delete unwanted fonts, right-click on their names in the Fonts folder
and choose Delete.

Please don’t delete any fonts that came with Windows XP. Just delete fonts
you’ve installed. Deleting some of Windows XP’s built-in fonts will remove let-
ters from your menus, making Windows XP even more difficult to use.

v If you can’t resist downloading free fonts from the Internet, remember
that Windows XP can handle TrueType fonts, OpenType fonts, and
PostScript Type 1 fonts. And if you really get into fonts, you’ll want
to buy a font management program sold at most office supply stores.
Finally, always scan downloaded fonts with your virus checker.
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v Need to reinstall all the fonts that came with Windows XP? Follow Steps
2 and 3 earlier in the section, but head to the C: \Windows\Fonts folder.
Select all the fonts in that folder and click OK.

v Brave Internet travelers who visit mysterious International Web sites can
install foreign fonts that let them view Arabic, Russian, Korean, and other
characters. Windows XP usually offers to download them for you the first
time you visit a foreign language site, but a quick trip to Windows Update
(described in Chapter 10) lets you download them as well. (These fonts
don'’t translate the text — they just let you see the words in their native
language.)

Troubleshooting your printer

First, are you sure that the printer is turned on, plugged in to the wall, full of
paper, and connected securely to your computer with a cable?

If so, then try plugging the printer into different outlets, turning it on, and
seeing if its power light comes on. If the light stays off, your printer’s power
supply is probably blown. Printers are almost always cheaper to replace than
repair, but if your printer is an expensive one, grab an estimate from a repair
shop before discarding it.

If the printer’s power light beams brightly, check these things before giving up:

v Make sure that a sheet of paper hasn’t jammed itself inside the printer
somewhere. (A steady pull usually extricates jammed paper.)

v Does your inkjet printer still have ink in its cartridges? Does your laser
printer have toner? Try printing a test page: Right-click on your printer’s
icon in the Start menu’s Printers and Faxes area, choose Properties, and
click the Test Page button to see if the computer and printer can talk to
each other.

v~ Before giving up, try updating the printer’s driver, the little program that
helps it talk with Windows XP. Visit the manufacturer’s Web site, down-
load the newest driver for your particular printer model, and run its
installation program.

v Turn off your printer when you’re not using it. Inkjet printers, especially,
should be turned off when they’re not being used. The heat tends to dry
the cartridges, shortening their life.

v Don’t unplug your inkjet printer to turn it off. Always use the on/off
switch. The switch ensures that the cartridges slide back to their home
positions, keeping them from drying out or clogging.
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If you've strolled the aisles at an office supply
store lately, you've noticed a bewildering array
of paper choices. Sometimes the paper’s pack-
aging lists its application: Premium Inkjet Paper,
for instance, for high-quality memos. Here's a
list of the paper types to keep on hand for dif-
ferent jobs. When printing, be sure to click the
Printer's Properties button to select the type of
paper you're using for that job.

v Junk: Keep some cheap or scrap paper
around for testing the printer, printing quick
drafts, leaving notes to spouses, and printing
other on-the-fly jobs. Botched print jobs work
great here; just use the paper’s other side.

v Letter quality: Bearing the words Premium
or Bright White, this paper works fine for
letters, memos, and other things designed
for showing to others.

v+~ Photos: You can print photos on any type of
paper, but they only look good on actual
Photo-Quality paper — the expensive stuff.

Choosing the right paper for your printer

Slide the paper carefully into your printer
tray so the picture prints on the glossy, shiny
side. Some photo paper uses a little card-
board sheet beneath it, which helps glide the
paper smoothly through the printer.

Labels: Avery's wizard makes it easy to print
any style of Avery labels using Microsoft
Word. The wizard handles Avery's prefor-
matted paper in common sizes: mailing
labels, greeting cards, business cards, CD
labels, and many others.

Transparencies: For powerful PowerPoint
presentations, buy special transparent
plastic sheets designed to be used with
your type of printer.

Before plunking down your money, make sure
your paper is designed specifically for your
printer type, be it laser or inkjet. Laser printers
heat the pages, and not all paper can stand the
heat.

Sending and Receiving
Faxes in Windows XP

Windows XP Professional comes with a built-in fax program. No more buying
rolls of fax paper! Instead of printing your documents and running them
through a traditional fax machine, you tell whatever program you're using
to print to the built-in fax program. (Windows XP lists the fax program as a
printer.) Type in the recipient’s phone number, fill out a simple cover page
form, push a button, and your document appears on somebody else’s fax

machine a few minutes later.

When a fax arrives, your computer answers the call, receives the fax, and dis-

plays it on your screen. (Feel free to print it out, if necessary.)
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You need four things to send or receive faxes with Windows XP:

v A modem with faxing capabilities. (Cable modems and DSL modems
can’t send faxes; only old-school dial-up modems can.)

v A dial-up phone line. (Cell phones won’t work.)

v Installed fax program. Windows XP must have its fax program installed.
(It’s usually not installed automatically.) You often need to insert a
Windows XP CD to install the fax program. (Not all new computers
come with a Windows XP CD.)

v A scanner. You need a scanner to send things that aren’t already inside
your computer: coffee shop menus, for instance. You won’t need a scan-
ner if you're sending only those things created by your computer.

The rest of this section explains how to install Windows XP’s fax program and
send and receive faxes.

If your computer is blessed by the light of the stars, Windows XP’s built-in
fax program may already be waiting on the Start menu. To see if it’s there,
choose All Programs from the Start menu, select Accessories, and choose
Communications. Finally, choose Fax and look for three programs: Fax
Console, Fax Cover Page Editor, and Send a Fax.

Installing Windows XP’s fax program

If your computer doesn’t have Windows XP’s built-in fax program installed
(most don’t), here’s how to pull it out of its hiding place on the CD. These
steps always work for Windows XP Professional and sometimes work for
Windows XP Home:

1. Choose Control Panel from the Start menu.

2. Choose Add or Remove Programs.

3. Click Add/Remove Windows Components to start the Windows
Components Wizard.

4. In the Components list, select the Fax Services check box and then
click Next (see Figure 7-7).

The fax program installs. If requested, insert your Microsoft Windows XP
CD and click OK.

Don’t have a retail Windows XP CD? Before assuming you’re completely
out of luck, tell the wizard to look in this folder on your hard drive instead:
C:\windows\i386\. (Some sneaky manufacturers hide it in there.)
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5. Click Finish when the installation is through.

6. Click OK to close any open windows.

Setting up your computerized fax machine

Setting up a real fax machine starts with the boring stuff: Plugging it in,
punching in the current date and your fax number, and telling it when to
answer. Windows XP’s virtual fax machine starts with a boring set-up ritual as
well, which guides you through creating a cover letter, filling out forms, and
dealing with other details. I describe the wizard’s thunderous steps in the fol-
lowing list:

1. From the Start menu, choose All Programs, select Accessories, choose
Communications, and finally, select Fax Console to summon the Fax
Configuration Wizard.

2. When the wizard greets you, click the Next button to start the faxing
magic.

3. Fill out the information to appear on your cover page and then
click Next.

Unlike real fax machines, Windows XP’s fax machine makes you fill out a
cover page only once. Windows XP fills out all your future cover pages
with this information, although you can still add last-minute changes if
you want.

4. Choose your fax modem from the list, click the Enable Send and
Enable Receive check boxes, and click Next.

Clicking the Enable Send and Enable Receive check boxes lets your com-
puter send and receive faxes.
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Sharing your fax line with your voice line? Then set the Receive option
to Manual Answer. That way, when you pick up the phone and find your-
self talking to an incoming fax, rush over to your computer and tell it to
pick up the fax, described later in the “Receiving a fax” section, later in
this chapter.

5. Enter your fax number and business name into the TSID box and then
click Next.

The TSID is that little text identifier running along the top of the faxes
you send.

6. Enter your fax number and business name into the CSID box and then
click Next.

Containing the same information as your TSID, your CSID is sent to other
fax machines when they send you faxes. (That lets them know they’ve
reached the right machine.)

7. Choose your Routing Options and click Next.

Feel free to ignore this; the program automatically saves your faxes in its
Inbox. Clicking the Print check box automatically sends incoming faxes
to your printer. Click the Store a Copy in a Folder check box to store a
second copy in a different folder.

8. Confirm your choices and click Finish.

The program lists your choices; when you click Finish, it closes. You've
successfully installed your virtual fax machine.

v If you've installed Windows XP’s Service Pack 2 (described in Chapter 1),
a Security Alert appears when you first load the fax program, asking
whether it’s okay for this new program to receive information from the
Internet or a network. Choose Unblock This Program. (I explain the fire-
wall in Chapter 10.)

v Feel free to change your fax settings at any time. Start the Fax Console
program from the Start menu (discussed at this section’s beginning) and
choose Configure Fax from the Fax Console’s Tools menu. The wizard
reappears, letting you change any of your settings.

v~ Unlike printers, Windows XP’s fax machine can’t be shared on a network.

Sending a fax directly from a program

Think of your new fax program as a printer. Anything you can print can now
be faxed: a letter, map, drawing, spreadsheet, or similar item.
1. Choose Print from the program’s File menu.

2. When the Print dialog box appears, choose the fax as your printer, as
shown in Figure 7-8, and click Print.



130

Part ll: Working with Programs and Files

|
Figure 7-8:
Tosenda
fax, pretend
you're
printing the
document
but choose
the Fax icon
as your
printer.
|

\\3

o Print (€[]
General

Select Prirter

Bl & & 8l

(= = 3 [

Add Printer  Epson Stylus Fax
Phaoto 127...
—i

Status: Feady [CIPiint tafile | Preferences
Locatior:
Corment Find Printer.
Page Range
@Al Mumber of copies: |1
() Pages: 165535

Enter sither a single page number or a single
page range. For example, 512

S
L]

Frint ]{ Cancel Jl Apply

I

3. Click the Next button on the Welcome to the Send Fax Wizard page.

Yes, it’s anticlimactic, but the Send Fax Wizard needs a little prodding to

get started.

4. Enter the recipient’s name and fax number and then click Next.

Click the Address Book button to select the recipient’s name and fax
number from there (if listed). Or enter the information manually.

To send a fax to several people, select all their names from the Address
Book or enter them manually, clicking the Add button after each name

and number.

5. Prepare the cover page if desired and then click Next.

To whip up a quick cover page, as shown in Figure 7-9, click the Select
a Cover Page Template check box. Type in your subject line and note,
if needed. Click the Sender Information button to view or change your
contact information. (You entered that information when you first set
up the fax program.)

To choose among different cover page styles, click the Cover Page
Template drop-down list box. (I usually use Generic.) If you're really
picky, the awkward Fax Cover Page Editor lets you create your own

templates.

6. Choose a time to send the fax and then click Next.

Choose Now to send it immediately. Or, if you're sending something
overseas, take advantage of cheaper long distance rates by scheduling
a time later in the evening, and make sure to leave your computer
turned on. (The priority button doesn’t have much effect, so leave it

at normal.)
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7. Confirm your choices, preview your fax if desired, and click Finish to
send the fax.

Click the Preview button for a glimpse of your cover page and fax. When
you click Finish, the wizard either sends your fax immediately or waits
until the time you’ve scheduled in Step 6.

v To immediately cancel a fax, click the Cancel button as it starts to dial.

v To cancel a fax you've scheduled for later in the evening, head for the Fax
Console: Choose the Start menu’s Add Programs area, select Accessories,
choose Communications, and look in the Fax area. The Fax Console resem-
bles Outlook Express; click your Outbox, right-click on your scheduled
fax, and choose Delete.

Sending faxes of scanned files

Sometimes you’ll want to fax something that didn’t begin life inside your com-
puter. You may want to fax some hand-scribbled notes or somebody else’s
party flyer. For that, you need a scanner, which takes a picture of your notes
or flyer and stores it as a file inside your computer. To fax the file, follow these
steps:

1. Open the folder containing the files you’d like to fax and select them.

2. Right-click on the selected files, choose Preview, and Windows XP’s
Photo Printing Wizard appears.

3. When the wizard asks you to choose the printer, select your Fax icon.
The Photo Printing Wizard kicks the ball to the Send Fax Wizard,
which runs with it.
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Receiving a fax

If you hooked up your fax modem to a dedicated phone line and set it to
answer automatically during the setup program, receiving a fax is easy. The
computer automatically answers, receives your fax, saves it, and heralds its
arrival by placing a pop-up message on your screen.

If you share a fax line with your voice line, things are more difficult depending
on how you first set up the fax program:

v If you chose Enable Receive and specified Manual Answer, an incoming
fax brings a pop-up window to your screen. Click Answer Now in the
pop-up window to begin receiving the fax. This option works best for
people who stay close to their computers.

v If you chose Enable Receive and specified Automatically Answer, the
program answers only after the number of rings you specified. That
gives you time to pick up the phone and start your conversation with-
out interruption from the fax machine. If you hear a fax machine instead
of a voice, though, hang up. When the fax machine calls back a minute or
so later, you’ll know not to pick up the phone.

v If you didn’t choose Enable Receive, your fax program will never answer.
To fix it, choose All Programs from the Start menu; select Accessories,
choose Communications, and select Fax Console from the Fax area.
Finally, choose Configure Fax from the Fax Console’s Tools menu to
rerun the setup program. This time, choose Enable Receive and select
either Manual or Automatic.

If you're expecting an important fax any minute and are waiting by the phone,
here’s how to turn on your computerized fax machine and receive any incom-
ing faxes:

1. Choose All Programs from the Start menu.

2. Choose Accessories, then Communications, and then Fax.

3. Select Fax Console.

4. When the phone rings, choose Receive Fax Now from the File menu.

Scanning a Photo, Letter, Receipt,
or Clothing Stain

Most scanners and digital cameras come with their own software — a strange,
bulky bundle of commands for you to try and remember. Fortunately, you
usually don’t have to install or use that software because most cameras and
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scanners are Windows XP compatible: Windows XP’s built-in grabbing wizard
performs admirably as a simple way to scan images or grab digital photos.
Even if you've been using the software packaged with your scanner or camera,
Windows XP’s wizard may be all you need.

Scanning with the Scanning
and Camera Wizard

After you've hooked up your scanner to Windows XP (right-click on the scan-
ner icon in My Computer, choose Properties, and click the Test Scanner button
to check that the scanner is connected correctly), the steps that follow show
you how to begin scanning anything: photos, letters, lunch receipts, or even
the shirt stain you wanted to e-mail to the restaurant that dropped your wine
bottle.

Before scanning, always clean the scanner’s glass thoroughly with a lint-free
cloth. Even the tiniest dust can show up on the scan. Wipe any dust off the
object you're scanning.

1. Lift your scanner’s cover, place the photo or letter on the glass, and
close the cover.

Place the paper in the top-right corner, pushed up against the edges. If
you'’re scanning a clothing stain, just place the cloth face down on the
glass. I explain how to scan only part of an image in Step 4.

If you don’t align your scanned photos or letters against the corner, the
resulting scan will tilt to one side, making for weird prints.

2. Open My Computer and double-click your scanner’s icon.

No scanner listed? Open the Control Panel, double-click the Scanners and
Cameras icon, and look for the scanner icon in there. If it doesn’t appear —
and you’re sure the scanner is plugged into both the wall and your com-
puter (and turned on) — then it’s not compatible with Windows XP’s
built-in software. In this case, you'll have to install the scanner’s own
software and use it — not Windows XP’s built-in software, unfortunately.

3. Click Next, and the Scanner and Camera Wizard steps forward.
4. Choose your Picture type and click Preview.
Windows XP offers four choices:

¢ Color: The usual choice for most scans, it’s the obvious choice for
anything containing colors.

¢ Grayscale: Use this setting mostly for scanning black-and-white
photos because it picks up different shades of gray. (This some-
times works well for scanning text.)
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Figure 7-10:
Click the
Preview
button to
scan the

image and
then drag
the little
boxes to
surround
the image
so the scan
crops
around the
edges.
|

)

¢ Black and White: This separates everything into only two colors:
black or white. Don’t use it for photos (even old black-and-white
ones). It’s for line drawings, sketches, and other monotone items.

¢ Custom: Stick with the other options until you're used to how they
work. Only then should you experiment with the Custom area and
its individual settings for resolution, brightness, and contrast. The
next section, “Choosing the right scanning resolution,” offers help-
ful tips about resolution.

When you click the Preview button, Windows scans the image and
shows the results on the screen, as shown in Figure 7-10.
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See the little lines around the picture and the boxes in each corner?
Windows surrounds your picture with little lines to crop out everything
but your image. If the lines miss the mark — or if you just want to scan
part of your image (the clothing stain, for instance) — drag the little lines
in or out until they surround the portion you want to capture. The handles
on each corner make them particularly easy to grab.

Click the Enlarge button (shown in the margin) in the bottom-right
corner of Figure 7-10 to see the portion you're about to scan.

Click the Entire Image button (shown in the margin) next to it to return
to the previous view.

. Click the Next button and then type the file’s new name and choose its

format and location.

When the scanner has cropped your image correctly, click the Next
button to chose your image’s name and a file format:
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¢ Choose the JPG format for most items, including photos. The JPG
format compresses the image to save disk space.

e Choose TIF for a photo or image you’ll print or send to a commer-
cial printer. The TIF format doesn’t compress the image as much as
JPG, resulting in a much larger file. But it saves the highest quality
image possible.

e Don’t ever choose the BMP format; the images are gargantuan, and
TIF does a much better job. Likewise, the PNG format is used mostly
for small buttons or artwork on Web sites.

Save all your scanned images in the My Pictures folder so you can find
them easily. If you wish, create additional folders inside your My Pictures
folder to store related items.

6. Click Next and then tell the scanner you’re finished.

Windows XP scans your image, as shown in Figure 7-11, stuffs it in the
folder you selected in Step 5, and leaves you with three choices:

¢ Publish the pictures to a Web site. Choosing this option lets you
send photos to one of Microsoft’s many advertising-driven Web
sites, MSN Groups.

¢ Send the pictures to an online service for printing. Choosing this
option lets you send your pictures (and credit card information)
to Microsoft’s partners: Fujifilm, Shutterfly, or Kodak.

¢ Nothing. Choose this option to close the program and automati-
cally open your My Pictures folder, letting you ogle your newly
scanned image.
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7. When you’ve finished working, click the Close button.

v Unlike printers, scanners can’t be shared on a network.

v Always remember to lock a scanner into place before moving it some-
place. (Most scanners have a little knob on one side that locks it in place,
preventing damage to its internal mechanisms.)

Choosing the right scanning resolution

Today, many people think that a 2400 dpi scanner must be better than a 1200
or 300 dpi scanner. After all, it’s higher resolution, and it costs more. But that
higher resolution costs more than cash — it costs hard drive space and the
time your computer spends chugging along to create that scan, too. And
many times, you don’t even need or want a high-resolution image.

When you scan something at 2400 dpi, you're scanning 2,400 dots per inch.
Your monitor uses a pixel to display each dot. And very few monitors can
display more than 2,000 pixels across their entire screen. The result? When
you scan something at 2400 dpi and view it on your screen, you're going to
see a huge close-up of only about 1 inch of your image.

There’s only one reason to scan at the highest resolution your scanner offers:
when you’re creating a file to be printed or saved — old family photos for
instance. After you've scanned the image, copy the huge file to a CD or DVD
for safekeeping or delete it so that the file doesn’t take up valuable hard drive
space. Store valuable pictures you want to save in a case and lock them in a
safe. You may want to print the files on your own color printer, or any profes-
sional print shop can make a large high-quality print with a high-resolution
image.

Most of the time, a much lower resolution will do the job, as shown in Table 7-1.
In fact, for e-mail or Web sites, a lower resolution is better because these lean
and mean files take up less space and load faster. (OCR stands for Optical
Character Recognition — software that reads a scanned piece of text and
converts it to letters and numbers for a word processor.)

Table 7-1 General Guidelines for Scanner Settings

To Scan This . .. For This . .. Use This And Save
dpi Setting . . . As This

4-x-6-inch photo E-mail 75 JPG

4-x-6-inch photo Web 75 JPG
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To Scan This . .. For This . .. Use This And Save
dpi Setting . . . As This

Anything Printing 600 TIF

Letter Faxing 200 TIF

Text OCR 300 TIF

Anything Archive 2400 TIF

Use Table 7-1 as a general guideline; your scanner may not offer these exact
resolutions. Try several scans at varying dots per inch to see which looks
best to you. Delete the ones that don’t look nice, save the ones that do, and
remember the setting you used for future reference.

Dealing with scans that look awful

Like nearly everything but eating, scanning requires practice. Okay, maybe
eating Dungeness crab from the shell requires a bit of practice, but you get
the point. Making practice scans doesn’t cost you any money, so experiment
with your scanning settings. You can always delete the scans that don’t look
quite right.

If you’ll be scanning lots of things, consider buying some graphics software
like Adobe Photoshop Elements. You’ll be amazed at how much better a
scanned photo looks when touched up.

But if it’s just you, Windows XP, and your scanner, these tips will help produce
the best scans:

1 Never clean your scanner with paper towels because they can leave tiny
scratches on the glass. Instead, use standard glass cleaner and a lint-free
rag, similar to the one packaged with some computer monitors. Spray
the cleaner on the rag, not the glass itself.

v As with most computer parts, scanners rarely come packaged with their
latest drivers. To update your scanner’s drivers, visit the scanner manu-
facturer’s Web site. Manufacturers constantly update a product’s drivers
to fix problems as they’re discovered by disgruntled users like yourself.

v Before making your first scan, make sure your monitor is displaying all
the colors it can. Right-click on a blank part of your desktop, choose
Properties, and click the Settings tab. Change the Color Quality setting
to the highest available (32-bit, if possible).
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In this part . . .

Fle Internet used to be clean, quiet, and helpful, just
like a new library. You could find detailed information
about nearly anything, read newspapers and magazines
around the world, listen to music in the media section, or
quietly browse the card catalogs.

Today, our wonderful global library has been bombarded
with noisy people who toss ads in front of what you're
trying to read. Some won'’t even let you close that book you
inadvertently opened — the book keeps opening back up
to the wrong page. Pickpockets and thieves stalk the halls.

This part of the book helps you turn the Internet back into
that quiet, helpful library it once was. It shows how to stop
pop-up ads, browser hijackers, and spyware. It explains
how to send and receive e-mail so you can keep in touch
with friends.

Finally, it shows you how to stay safe using Windows XP’s
firewall, Security Center, and cookie manager and other
tricks that help bring back the library we all loved.




Chapter 8
Cruising the Web

In This Chapter
Understanding the Internet
Finding out about Internet service providers
Setting up Internet Explorer the first time
Navigating the Web
Finding information on the Internet
Understanding plug-ins
Saving information from the Internet

Troubleshooting Internet Explorer problems

S)me people consider an Internet connection to be optional, but Windows
XP prefers mandatory, thank you very much. Even when being installed,
Windows XP starts reaching for the Internet, eager for any hint of a connec-
tion. After checking in with the Internet, for instance, Windows XP kindly
nudges your computer’s clock to the correct time. Some motives are less
pure: Windows XP wants to check with Microsoft to make sure you're not
installing a pirated copy.

Before you try connecting to the Internet, make sure you install Windows XP’s
Service Pack 2, which I describe in Chapter 1. That piece of software blocks
those annoying pop-up ads in Internet Explorer. (Now if it could just remove
all the other advertisements, as well.) It also strengthens XP’s firewall to thwart
predators.

For other ways to keep out the Internet’s bad guys, be sure to visit Chapter 10
for a quick primer on safe computing. The Internet’s full of back alleys, and that
chapter explains how to avoid viruses, spyware, hijackers, and other Internet
parasites.

Once your computer’s wearing its appropriate helmet and kneepads, how-
ever, hop onto the Internet and enjoy the ride.



1 42 Part lll: Getting Things Done on the Internet

What Is the Internet?

Today, most people take the Internet for granted, much like a telephone line.
Instead of marveling at the Internet’s internal gearing, people treat it as a mul-
tipurpose tool. After it’s connected to the Internet, your computer becomes all
of the following:

Library: The Internet is stuffed with educational material: classic books,
hourly news updates, foreign language dictionaries, specialized encyclope-
dias, and more. Visit RefDesk (www.refdesk.com) for a detailed list of some
of the Internet’s best free reference materials.

Store: Although the Internet began as a novelty ten years ago, today the
Internet revolves around making money. Nearly anything available in stores
(and some things not sold in stores) can be purchased on the Internet and
shipped to your thatch hut. Amazon (www.amazon.com) even lets you listen
to song snippets and read reviews before putting that live Jeff Buckley CD on
your credit card.

Communicator: Some people treat the Internet as a private postal service for
sending messages to friends, coworkers, and even strangers around the world.
Unfortunately, unwelcome marketers do the same, filling everybody’s inboxes
with increasingly desperate sales pitches known as spam. (I cover Outlook
Express, Windows XP’s e-mail program, in Chapter 9.)

Time waster: When sitting in a waiting room, everybody naturally reaches

for the magazine table. The Internet, too, offers zillions of ways to waste time.
Jumping from one Web site to another is much like flipping pages in a magazine,
but each flip often reveals a completely different yet oddly related magazine,
brimming with fascinating information. Or at least it seems so at the time.

Entertainment: The Internet brings not only a movie’s show times into your
home but also its trailers, cast lists, reviews, and celebrity gossip. If you've
already seen the movie, browse for online games, research travel destinations,
or look up sporting statistics.

v Just as a television channel surfer flips from channel to channel, sampling
the wares, a Web surfer moves from page to page, sampling the vast and
esoteric piles of information.

v Almost every government but China loves the Internet. In the United
States, the FBI posts pictures of its ten most wanted criminals (www .
fbi.gov) for public viewing, for example, and the Internal Revenue
Service (www.irs.ustreas.gov) lets Internet users make free copies
of tax forms 24 hours a day.
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v Universities and scientists love the network, too, because they can file
grant forms more quickly than ever. Worried about the goo coagulating
in the crevices of your bromeliads? The Internet’s famed botanical site
(www.botany.net) enables researchers to study everything from
Australian acacias to zoosporic fungi.

v Many computer companies support their products on the Internet.
Visitors can leave messages to technicians or other users asking why
their latest computer doodads aren’t working. After posting messages
back and forth, visitors can sometimes download a fix or uncover the
right series of keystrokes to fix the problem.

What's an ISP and Why Do 1 Need One?

A first-timer needs four things to connect to the Web: a computer, Web browser
software, a modem, and an Internet service provider (ISP). You already have the
computer, and Windows XP comes with a built-in Web browser called Internet
Explorer. Your computer most likely came with a built-in modem. (If it didn’t,
you'll find out when you first try to set up your ISP, as I describe in this chapter.)

Most people only need to find an ISP, and you usually find one listed in your
local Yellow Pages under Computers — Online Services & Internet or Tele-
communications. Or ask your local computer dealer for names and numbers.

Although signals for television channels come wafting through the air to your
TV set for free, you must pay an ISP for the privilege of surfing the Web. You
pay the ISP for a password and account name. When your computer’s modem
connects to your ISP’s network, type the information and grab your surfboard:
You've entered the Web.

Don’t have an ISP? Different ISPs serve different areas. Ask your friends,
neighbors, or librarians how they connect and whether they recommend
their ISP. Call them up for a rate quote, and choose the cheapest. Most bill
on a monthly basis; if you're not happy, you can always switch.

v~ Although some ISPs charge for each minute you're connected, most
charge a flat monthly fee between $15 and $50 for unlimited service.
Make sure that you know your rate before hopping aboard, or you may
be surprised at the end of the month.

v Most free ISPs went out of business when the bottom fell out of the
Internet market. At the time of this writing, you can still find limited
Internet access for free from Juno (www. juno.com), but you have to
peek around the ads to see the screen.
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v~ ISPs let you connect to the Internet in a variety of ways. The slowest
ISPs use a dial-up modem and an ordinary phone line. Faster still are
special DSL or ISDN lines provided by some phone companies. Some of
the fastest connections come from your cable TV company. When shop-
ping for speedy ISPs, your geographic location usually determines your
options, unfortunately.

v If you're computer-inclined, some ISPs let you create your own Web
pages for other Internet members to visit. Show the world pictures of
your kids and cats, share your favorite recipes, talk about your favorite
car waxes, or swap tips on constructing fishing flies or prom gowns.

Setting Up Internet Explorer the First Time

To guide you smoothly through the turmoil of setting up your ISP account,
Microsoft created the New Connection Wizard. After a bit of interrogation, the
wizard helps connect your computer to your ISP so you can Web surf like the
best of them.

Setting up a network? Then connect one of your computers to the Internet
using the New Connection Wizard. When you run the Network Setup Wizard
to set up your network (covered in Chapter 14), that wizard helps all your
networked computers share that single Internet connection.

To transfer your existing Internet account settings to or from another com-
puter, use Windows XP’s Files and Settings Transfer Wizard, covered in
Chapter 19. The wizard copies your existing settings onto a floppy. Insert that
floppy into your other Windows XP computer, and the wizard automatically
installs them.

Here’s what you need to get started:

+* Your user name, password, and access phone number. If you don’t
have an ISP yet, the wizard finds you one, so grab a pencil and paper.
(The wizard’s ISP suggestions are a tad pricey, however.) If you're setting
up a high-speed connection, you don’t need a phone number. High-speed
connections use special modems that don’t require phone lines.

1 A plugged-in modem. Most new computers come with a modem lodged
in their innards. To see if one’s inside of yours, look for telephone jacks
on the back of your computer, near where all the other cables protrude.
Then connect a standard phone cable between that jack (the computer’s
jack says Line, not Phone) and the phone jack in your wall. (Broadband
companies usually supply their own modems, and their technicians often
set them up for you.)
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\J . .
) Whenever your Internet connection gives you log-on problems, head here and

run through these steps. The wizard walks you through your current settings,
letting you make changes.

Summon the wizard by following these steps:

1. Click the Start button, click All Programs, choose Accessories, select
Communications, and load the New Connection Wizard.

up an Internet account yet, your PC can’t connect, so Windows automat-

'h Or, just choose Internet Explorer from the Start menu. If you haven’t set
-
- ically summons a wizard from the appropriate school.

Can’t find the Start menu’s New Connection Wizard? To lure the wizard
from its lair, click the Start menu, right-click on the Internet Explorer icon,
choose Internet Properties, click the Connections tab, and click the Setup
button.

2. Click Next.
3. Choose Connect to the Internet and click Next.

Choosing this first option tells Mr. Wizard that yes, you do want to con-
nect to the Internet. (If you want to connect to the Internet through your
home or office network, choose Set Up a Home or Small Office Network,
and the wizard passes you off to the Network Setup Wizard instead, which
I cover in Chapter 14.)

4. Choose the Set Up My Connection Manually option, as shown in
Figure 8-1, and click Next.

New Connection Wizard

Getting Ready
The wizard iz preparing to set up vour Internet connection.

How do wou want to connect to the [ntemet?

Fi 81 ) Choose from a list of Internel service providess [ISPs]
igure o-1:
The N ew For a dialup connection, you will need pour account name, password, and a
CO nne ction gn;ﬁrumber for your [SP. For a broadband account, you won't need a phone

Wizard O Use the CD I got from an ISP
helps you
connect
your com-
puter to the
Internet.

(%) Set up my connection manually

< Back ” Nexl)% [ Cancel
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Here’s what the three options mean:

Choose from a List of Internet Service Providers (ISPs). Choose
this option if you don’t already have an Internet account and you
want to select one from a list provided by Microsoft. If you choose
this option, the wizard dials a number to locate Internet service
providers in your area and displays their rates and options. The
wizard finds providers only with special Microsoft contracts, so it
leaves out many providers in your area. (The telephone book is a
much better way to find an ISP.)

If you use this option to choose a provider, the wizard finishes the
rest of the setup work by itself.

Set Up My Connection Manually. Chances are, you'll end up choos-
ing this option. This lets you set up an Internet account you've
already paid for; you just enter that ISP’s settings. After selecting
this option, click Next to continue along these steps and introduce
your computer to your existing Internet account.

Use the CD I Got from an ISP. Many national ISPs offer free CDs for
signing up to their service. You choose this option if you have a CD
from America Online, for instance. Choosing this option stops the
wizard and lets the ISP’s CD take over.

5. Tell Windows XP how you connect to the Internet and then click Next.

The wizard provides three options, as shown in Figure 8-2:

Connect Using a Dial-up Modem. If your modem plugs into the
phone line, choose this option and move to Step 6.

Connect Using a Broadband Connection That Requires a User
Name and Password. Broadband connections are the speedy ones
provided by cable or DSL modems. Some require a user name and
password for Internet access. (All ISPs require a user name and pass-
word for e-mail access.)

If you choose this option, you type in a name for your ISP, your
user name, and a password to finish the connection.

Connect Using a Broadband Connection That Is Always On. Some
broadband connections don’t require a password or user name to
access the Internet. (You still enter your user name and password
when setting up your e-mail account with Outlook Express, which |
describe in Chapter 9.)

6. Type a name for your Internet provider and click Next.

Simply type My Provider or the name of company you're paying for
Internet service.
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New Connection Wizard

Internet Connection
How do you want to connect to the Internet?

(%) Connect using a dial-up modem
Thiz lype of connection uses a madem and a regular or [ISDN phane line.

() Connect using a broadband tion that ires a user name and
password

Thig iz a high-speed connection using either & D5L o cable modem. Your |SP may
refer ta this type of connection as PPPoE

() Connect using a broadband connection that is always on
Thig iz a high-speed connection uzsing either a cable modem, D5L or LAM
connection. [tis always active, and doesn't require you ta sign in.

< Back ” Mewt > N E Cancal |

7. Enter the phone number for your Internet service provider and click
Next; then enter your user name and password.

Your provider gives you these three things. Call your provider if these
three magical tidbits of information aren’t in your possession. Without
them, you can’t connect to the Internet.

Enter the phone number you need to dial to reach the ISP. If you’re not
sure whether you need to dial an area code or enter “1” for long distance,
dial the phone number by hand and listen. When you hear a squealing
modem answer, you know you’ve found the right combination of num-
bers to enter in this box.

8. Click the Finish button.

You'’re done. Windows XP automatically leaps into action and uses your
settings to call your Internet provider.

If everything goes correctly, a pop-up message appears with your dial-up
modem’s connection speed. You're logged on to the Internet. Always plugging
its own products, Microsoft tosses one of its own Web pages (MSN) onto the
Internet Explorer screen, and you’re ready to browse. Need a place to go for a
quick test? Log on to www.andyrathbone.com and see what happens.

All Internet users should upgrade to Windows XP’s Service Pack 2, which I
describe in Chapter 1. That service pack beefs up the firewall, among other
things, keeping Internet scoundrels at bay. You'll certainly enjoy the service
pack’s new pop-up ad blocker. You can find out how the blocker works in
Chapter 10.

Don’t be afraid to bug your ISP for help. The best ISPs come with technical
support lines. A member of the support staff can talk you through the instal-
lation process.
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But | want to see some pop-ups!

Early versions of Internet Explorer had no way
to stop pop-up advertisements from exploding
across your screen. Windows XP’s Service
Pack 2, covered in Chapter 1, adds a pop-up ad
blocker to Internet Explorer that stops 90 per-
cent of them. To make sure it's turned on,
choose Pop-up Blocker from Internet Explorer’s
Tools menu and make sure no check mark
appears in the Turn Off Pop-up Blocker box.

If you want to see pop-ups on certain sites, that
same menu lets you choose Pop-up Blocker
Settings. Add the Web site address, and
Internet Explorer allows that site’s pop-ups to
pop unblocked.

If a site tries to send a pop-up ad or message,
Internet Explorer places a strip along the top
saying A pop-up was blocked. To see
this pop-up or additional options,
click here. Click the strip to see the pop-up,
add the site to your pop-ups allowed list, turn off
the blocker completely, turn off the informational
strip, or change the blocker's settings.

Finally, to stop the informational strip from
making that obnoxious pop noise when it stops
a pop-up, choose Pop-up Blocker from Internet
Explorer’s Tools menu, choose Pop-up Blocker
Settings, and remove the check mark from the
Play a Sound When a Pop-up Is Blocked box.

How Do | Navigate the Web with
Microsoft Internet Explover?

Your Web browser is your Internet surfboard — your transportation between
the Internet’s thousands of Web sites. Internet Explorer comes free with
Windows XP, so many people use it out of convenience. Other people use
other browsers published by other software companies, like Netscape
Communicator or Opera. People with too much time on their hands switch
back and forth between several types of Web browsers.

How do 1 move from Web
page to Web page?

All browsers work basically the same way. Every Web page comes with a spe-
cific address, just like houses do. Internet Explorer lets you move from page
to page in three different ways:

v By pointing and clicking a button or link that automatically whisks you
away to another page

v By typing a complicated string of code words (the Web address) into the
Address box of the Web browser and pressing Enter

v By clicking the navigation buttons on the browser’s toolbar, which is
usually at the top of the screen
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Figure 8-3:
When the
mouse
pointer
becomes
a hand,
click the
underlined

or

highlighted
word or
picture to
see more
information
about that

item.

Clicking links

The first way is the easiest. Look for links — highlighted words or pictures
on a page — and click them. See how the mouse pointer turned into a hand
(shown in the margin) as it pointed at the word Books in Figure 8-3? Click that
word to see more information about my books. Most words on this site are
links, as well; the mouse pointer becomes a hand when near them, and the
words become underlined. Click any of them to view pages dealing with that
link’s particular subject.

&7 Andy Rathbone - Microsoft Internet Explorer BEE
File Edit View Favorites Tools Help "
Q Back - ﬂ lEI ' / 7 search ' Favorites 6“ =

Address http: v, andyrathbone,com 12 ﬂ e

By selling more than 10 milion copies of his Windows For Dummiss series,

Andy Rathbone 1s one of today's best-selling computer book wiiters. You'll find
plenty of information here about Andy and his books.

Tips

Links & Today's Reader Rave:
Mail .
. | have enjoyed your books and have learned lots from all of
Media "
them.
WebCam
Site Index
TiVo For Dummies hits the store shelves
| - I | have been Inokind to biv a Tiva and have been scavencing | ¥
ﬁ"ﬁ Rkt i, andyrathbone, com/baoks findex. html B Internet

Web page manufacturers get mighty creative these days, and without the
little hand pointer, it’s often hard to tell where to point and click. Some but-
tons look like sturdy elevator buttons; others look more like fuzzy dice or
vegetables. But when you click a button, the browser takes you to the page
relating to that button. Clicking the fuzzy dice may bring up a betting-odds
sheet for local casinos, for example.

Typing Web addresses in the Address box

The second method is the most difficult. If a friend gives you a napkin with
a cool Web page’s address written on it, you need to type the Web site’s
address into your browser’s Address box yourself. You'll do fine, as long as
you don’t misspell anything. See the Web site address for my Web site along
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the top of Figure 8-3? I typed www.andyrathbone.cominto the Address
box. When I pressed Enter, Internet Explorer scooted me to my Web page.
(You don’t need to type the http:// part, thank goodness.)

Using Internet Explorer’s toolbar

Finally, you can maneuver through the Internet by clicking various buttons
on Internet Explorer’s toolbar, which sits at the top of the screen. Table 8-1
offers a handy reference of the important navigation buttons.

A\
Hover your mouse pointer over a confusing Internet Explorer button to see
its purpose in life.

Table 8-1 Navigating with Internet Explorer’'s Buttons
This Button ...Is Called This . .. ... And It Does This
pa Back Pointed and clicked yourself
O Bl into a dead end? Click the

Back button to head for the
last Web page you visited. If
you click the Back button
enough times, you wind up
back at your home page,
where you began.

Forward After you click the Back

@ i button, you can click Forward
to revisit a page, too.
A Home If you get stuck as you
L explore the Internet, click the

Home button along the top
to move back into familiar
territory.

along the top reveals a folder
where you can stash buttons
leading to your favorite Web
sites.

ij Favorites Clicking the Favorites button

| History Click the History button to
@ return to any page that you
— visited in the past few weeks.
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Making Internet Explorer
open to your favorite site
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Your Web browser automatically displays a Web site when you first log on.
That Web site is called your home page, and you can tell Internet Explorer
to use any site you want for your home page by following these steps:

1. Visit your favorite Web site.

Choose any Web page you want. I use Google News (news.google.com)
so Internet Explorer always opens with the hour’s current headlines.

2. Choose Internet Options from Internet Explorer’s Tools menu.

3. Click the General tab and click the Use Current button shown in

Figure 8-4.

Now, Internet Explorer always opens to the page you're currently viewing.

Internet Options &[]

General | Security | Privacy | Content | Connections | Programs | Advanced

Home page
E% Y'ou can change which page to use for pour hame page.

Address http:/inews. google.comf

| Use Eurrenla\t[ Use Default Jl U sz Blank.

Temporary Internet files

7 Pages you view on the Internet are stored in a special folder
@Y for quick viewing later.

{Delele Eookies..J [Delete Files.. J I Settings..

History

The History folder containg links to pages you've visited, for
£ quick access ta recently viewed pages.

Days to keep pages in histar: 20 1% | Clear History

l Colors. .. ] [ Fonts... ] l Languages... ] [Accessibilily.. I

I 0k, ]I Cancel H Apply ]

Clicking Use Default reverts to Microsoft’s MSN site as your home page;
click Use Blank for an unappetizing white screen.

4. Click OK to save your efforts and return to browsing.

After Internet Explorer loads your chosen home page, you can move around
the Internet, searching for topics by looking in indexes or simply pointing and

clicking from topic to topic.
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A\

v If your home page is suddenly hijacked to a different site and these
instructions don’t fix it, then it’s probably been hijacked by evil forces.
Read the spyware section in Chapter 10.

1 A home page of a Web site is different from your own home page. A Web
site’s home page is its “cover,” like the cover of a magazine. Whenever
you jump to a Web site, you usually jump to the site’s home page.

How can 1 revisit my favorite places?

Sooner or later, you'll stumble across a Web page that’s indescribably deli-
cious. To make sure that you can find it again later, add it to your favorite
pages folder by choosing Add to Favorites from the Favorites menu.

Don’t choose the Make Available Offline option. (That one tells Windows to
automatically download the page’s contents once a day or whenever you
press a button.) Then click OK to save your efforts.

Whenever you want to return to that page, click the Favorites menu along the
top of the screen and then click the name of the link you want to revisit.

Librarian-types like to click the Organize Favorites option when the Favorites
menu drops down. By doing so, they can create new folders for storing simi-
lar links and move related links from folder to folder.

How do 1 find things on the Internet?

Just as it is nearly impossible to find a book in a library without a card cata-
log, it is nearly impossible to find a Web site on the Internet without a good
index. Luckily, several exist.

Unfortunately, none exist in Windows XP. Clicking the Search button at the
top of the Internet Explorer window brings up Windows’ built-in Search func-
tion, but that program often stumbles when searching on the Internet. Instead,
try this:

1. Click in Internet Explorer’s Address box, type www.google.com, and
press Enter.
That summons Google, the Internet’s best search engine.

2. Type a few key words describing your interest (cornbread recipes, for
instance) and click the Google Search button.

In less than a second, Google found 95,900 references to cornbread
recipes, as shown in Figure 8-5.
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Internet Explorer’s secret history of your Web visits

Internet Explorer keeps a record of every Web
site you visit. For some odd reason, it also keeps
track of files you play in Media Player and even
some of the files you open. Although Internet
Explorer’s History list provides a handy record
of your computing activities, it's a spy’s dream.

To keep tabs on what Internet Explorer is
recording, click its History icon on the toolbar at
the top of the screen. Internet Explorer lists

Feel free to sort the entries: Choose View to list
them by date, alphabetically, most visited, or by
the order you've visited on that particular day.

To delete a single entry from the history, right-
click on it and choose Delete from the menu. To
delete the entire list, choose Internet Options
from its Tools menu and click the Clear History
button. To turn off the history entirely, set the
Days to Keep Pages in History setting to 0.
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every Web you’ve visited in the past 20 days.

Click any of the sites that Google lists to check out those recipes. Click the
Back button to return to Google’s search and click a different recipe. Or, right-
click on the link and choose Open in New Window. A new copy of Internet
Explorer appears, displaying that link, while the other copy keeps displaying
your other Google search locations. (That keeps you from losing your place
on the search page.)

v If Google finds Web sites in foreign languages, it often translates them
into your own language for you.

v Sometimes Google brings up a Web site that’s been updated and no
longer lists what you’re searching for. If that happens, click the word
Cached instead of the site’s name. That brings up a snapshot of the
Web site as it looked when it contained what you're searching for.

v Click Google’s I'm Feeling Lucky button, and Google displays the site
most likely to contain what you’re after. This option works best when
searching for common information.

v~ Although Google is very handy, it’s just one way of finding information.
The Internet’s loaded with other search engines. AltaVista (www.alta
vista.com) and Yahoo! (www.yahoo.com) are also popular.

v For many years, people have exchanged messages on a section of the
Internet called Usenet. Divided into thousands of discussion areas, Usenet
lets people type questions about nearly every subject, exchanging infor-
mation, holding discussions, or simply yelling at each other. It’s a fantastic
source of computer information from real people, without a corporate
filter. To search Usenet in Google, click the word Groups, listed above
the entry box.

\\3

v Searches usually come up with hundreds or even thousands of hits relat-
ing to your subject. If you come up with too many, try again and be more
specific with each search.
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The Web Page Says It Needs
a Weird Plug-In Thing!

Computer programmers abandoned their boring old TV sets and turned to
their exciting new computers for entertainment. Now, they're trying to turn
their computers back into TV sets. They’re using fancy programming tech-
niques called Java, Shockwave, RealPlayer, QuickTime, and other goodies to

add animation and other gizmos to the Internet.

Programmers are also adding little software tidbits called plug-ins that

increase your computer’s capability to display these gizmos — as well as
flashy advertisements along the top of your screen. You'll know when you

need one when the Web site sticks a threatening notice in your face, as

shown in Figure 8-6.

Internet Explorer - Security Warning
Do you want to install this software?

|
Figure 8-6:

A site asks Hors ptins ) (e
to install

SOftWa re. ; This type of file can harm your computer, Only install software from publishers

you brust. How can 1 decide what software to install

|
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What’s the problem? If your computer says it needs a plug-in or its latest ver-
sion, click the button that takes you to its download area — but only if you
can trust it. Although it’s often difficult to tell the good programs from the
evil ones, [ explain in Chapter 10 how to judge a plug-in’s trustworthiness.
The following plug-ins are both free and safe:

v QuickTime (www.apple.com/quicktime): The free version of QuickTime
plays many video formats that Microsoft’s Media Player can’t handle,
including those required to view most movie trailers.

1 RealPlayer (www. real.com): Although I find this software offensive,
sometimes it’s the only way to see or view some things on the Internet.
Be sure to download the free version, no matter now much the Real folks
try to hide it behind the pay version on its Web site.

1 Macromedia Flash/Shockwave (www.macromedia.com): Although this
free download plays most of the elaborate moving advertisements on
Web sites, it also lets you watch funny cartoons and animations.

v Adobe Acrobat Reader (www.adobe. com): Another popular freebie,
Acrobat Reader lets you view documents as if they are printed on paper.
(Sometimes it doesn’t let you copy parts of them, though, or read them
into your word processor.)

Saving Information from the Internet

The Internet places a full-service library inside your house, with no long
checkout lines. And just as every library comes with a copy machine, Internet
Explorer provides several ways for you to save interesting tidbits of informa-
tion for your personal use. (Check your country’s copyright law for specifics.)

The following sections explain how to copy something from the Internet onto
your computer, whether it’s an entire Web page, a single picture, a sound or
W movie, or a program.

[ explain how to print a Web page (or information it contains) in Chapter 7.

Saving a Web page

Hankering for a handy Fahrenheit/Centigrade conversion chart? Need that
Sushi Identification Chart for dinner? Want to save the itinerary for next
month’s trip to Russia? When you find a Web page with indispensable infor-
mation, sometimes you can’t resist saving a copy onto your computer for
further viewing, perusal, or even printing at a later date.
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& When you save a Web page, you're saving the page as it currently exists on
your screen. To see any subsequent changes, you must revisit the actual site.
Saving your currently viewed Web page is easy:
1. Choose Save As from Internet Explorer’s File menu.
Internet Explorer enters the Web page’s name in the File Name box, as
shown in Figure 8-7, and fills out the Encoding box automatically.
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2. Use the Save In drop-down list to choose where you want to save the file.

My Documents or a subfolder that you create in My Documents is usu-
ally a good choice.

3. Choose how you want to save the page in the Save As Type box.
Internet Explorer offers four different ways to save the Web page:

¢ Web Page, Complete (*.htm;*.html): Fast, handy, but a tad awk-
ward, this option tells Internet Explorer to divide the Web page
into two parts: a folder containing the page’s pictures and graphics,
and an adjacent link that tells the computer to display that folder’s
contents.

Web Archive, Single File (*.mht): A much tidier option, this also
saves an exact copy of the Web page. However, everything’s pack-
aged neatly into a single file named after the Web page.

e Web Page, HTML Only (*.htm;*.html): This option saves the
page’s text and layout but strips away the images. It’s handy for
stripping pictures and advertisements from tables, charts, and
other formatted chunks of text.
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|
Figure 8-8:
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¢ Text File (*.txt): This option scrapes all the text off the page and
dumps it into a Notepad file, without taking many pains to preserve
the formatting. It’s handy for saving lists but not much else.

4. Click the Save button when you’re done.

Saving text

To just save a little of the text, select the text you want to grab, right-click
on it, and choose Copy. Open your word processor and paste the text into
a new document and save it in your My Documents folder with a descrip-

tive name.

To save all the text from a Web site, it’s easiest to save the entire Web page,
as described in the previous section. But select either the Web Page HTML
Only option to preserve the text’s formatting (tables, charts, receipts, and
similar information work well this way) or select the Text File option to save
the words without their formatting (good for lists, for instance.)

Saving a picture

As you browse through Web pages and your mouse pointer rests over a
photo or other large image, an annoying box of icons appears, as shown in
Figure 8-8.

Those little boxes let you play with the image in different ways. Click the little
disk icon, shown in Figure 8-8, to save the image to your My Pictures folder.
Click the Printer icon to send the image straight to your printer. A click on the
little letter icon e-mails the image through your e-mail program. And clicking
the little folder opens your My Pictures folder for browsing.
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Saving a sound or movie you've played

Some downright mean Web sites don’t let you allowed to save what you’ve just watched or
save movies or sounds you've just played in heard.

Media Player. But friendly sites let you choose
Save Media As from Media Player’s File menu
to save the show to your hard drive. But if that
option's grayed out or Media Player doesn't
automatically fill in the format, you're not

This trick doesn’t work for all media (especially
for Internet radio stations), and it doesn’t always
work on different media players like QuickTime
or RealPlayer. But it's sometimes worth a try.

P Remember the little picture by your name on Windows XP’s Welcome screen?
Feel free to use any picture from the Internet. Right-click on the new picture
and save it to your My Pictures folder. Then use the Control Panel (see
Chapter 11) to transform that picture into your new user account picture.

A\\J Don’t see the little icons pop up when you point at a picture you want? Right-
click on the picture and choose Save Picture As. Choose your My Pictures
folder, if necessary, and click Save to save the file.

Downloading a program

Sometimes downloading is as easy as clicking a Web site’s Click to Download
Now button. The Web site asks where to save your file, and you choose your
My Documents folder for easy retrieval. The file arrives in a few seconds (if you
have a cable modem) or a few minutes to hours (if you have a dial-up modem).

But sometimes downloading becomes a chore, described in the following
two-step process:

1. Right-click on the link pointing to the desired file and choose Save
Target As.

For instance, to download Cory Doctorow’s science fiction novel, eastern
standard tribe, from his Web site, right-click on its link (the words ASCII
text file, in this case). Then choose Save Target As from the pop-up menu,
as shown in Figure 8-9.

When you try to download a program, Windows asks whether you want
to Save the File or Run It from Its Current Location. Choose Save the File.

2. Navigate to your My Documents folder and click the Save button.

When the Save As dialog box appears, as shown in Figure 8-10, navigate
to your My Documents folder and click the Save button.
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Windows XP begins copying the file from the Web site to your hard drive.
Windows XP tells you when it finishes downloading, and you can click
the Open Folder button to open your My Documents folder and see your

downloaded file.

v If you download a lot of things, create a file in your My Documents folder

called Downloads and save downloaded files in there. That keeps things

organized.

v Before running any downloaded programs, screen savers, themes, or

other items, be sure to scan them with your antivirus program. Windows

XP doesn’t come with one built-in, leaving it up to you to purchase one.

v Many downloaded programs come packaged in a tidy folder with a
zipper on it, known as a Zip file. Windows XP treats them like normal
folders; just double-click them to open them. (The files are actually
comipressed inside that folder to save download time, if you care
about the engineering involved.)
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Visiting Web sites in foreign languages

If you travel worldwide on the Internet, you'll
eventually come across a Web site you can't
read. Actually, Internet Explorer can't /et you
read it because it can’t display the Web page’s
foreign fonts.

Instead of stumbling to the nearest embassy for
assistance, Internet Explorer sends a pop-up
message, graciously offering to download a
Language Pack Installation that lets it display
the language’s characters correctly.

Click the box’s Install button, and Internet Explorer

site, downloads and installs the appropriate
language pack, and begins displaying the Web
site using its proper characters.

Internet Explorer won't translate the \Web site,
unfortunately, but at least you can see how it
looks in its original language. And if you want a
free rudimentary translation of the site, copy the
Web site’s address, visit Google (www . google.
com), and paste the address into Google's
Search box. When Google displays the page, it
sometimes offers to translate the Web site into
your language, be it English, German, Spanish,

automatically dashes off to the Microsoft Web Franch, Italian, or Portuguese.

It Doesn’t Work!

Don’t feel bad. The Internet’s been around for a while, but this whole Web
thing is relatively new and complicated. It’s not supposed to work smoothly
yet, and it isn’t something you can figure out overnight. This section explores
some of the most common problems and some possible solutions.

The person holding the Administrator account — usually the computer’s
owner — is the only one who is authorized to make many of the changes you
read about in this chapter. If a mean message pops up, waving its finger and
mumbling about Administrator restrictions, you're locked out. Better find the
computer’s owner to proceed.

\\J
Here are some general tips that you may want to try before you explore the
following sections:

1 When a Web site gives you problems, try emptying Internet Explorer’s
wastebasket. Choose Internet Options from its Tools menu and click
the Delete Files button. Click the Delete All Offline Content box and click
the OK button. Twiddle your thumbs until it finishes and then revisit the
problematic site and try again.

v If your connection settings seem askew, sometimes the New Connection
Wizard can set things straight. Described at the beginning of this chapter,
it guides you through your current settings, letting you change things that
look suspicious.
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v If you can’t connect to the Internet at all, your best bet is to call your
ISP’s tech support number and ask for help. (Be sure to call your Internet
service provider, not Microsoft.)

v Finally, if a page doesn’t seem to display correctly, look for Internet
Explorer’s warning strip along the page’s top. Click the strip and tell
Internet Explorer not to block what it’s trying to block.

The Pages Won’t All Fit on My Screen!

Some people (with good eyesight) can afford huge monitors that pack lots of
information onto the screen. Other folks have smaller monitors that simply
don’t have the real estate to display everything. So, how does a Web site
reshape itself to fit every screen? It can’t.

Some try by fitting squarely onto smaller monitors but leaving white space
along the edges of larger monitors. Others try to guess a monitor’s size and
resize themselves to fit. Others simply fall off your screen’s right edge.

The best way to fight back is to experiment with your screen resolution.
Although I describe the process in Chapter 11, here are the quick-and-dirty
steps:

1. Right-click on a blank part of your desktop and choose Properties.

2. Click the Settings tab and slide the bar to adjust your Screen
Resolution.

Sliding the bar to the right packs more information onto the screen but makes
everything smaller. Sliding to the left makes everything larger but sometimes
leaves parts of the screen hanging off the edge.

Although the resolution setting of 800 x 600 pixels usually makes a nice com-
bination, many sites now pack their information into a resolution of 1024 x
768 pixels.
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Chapter 9

Sending Mail and
Instant Messages

In This Chapter

Using Outlook Express

Setting up Outlook Express for AOL, Hotmail, or Yahoo! mail
Sending and receiving e-mail

Finding lost mail

Managing your contacts with Address Book

Using Windows Messenger

nternet Explorer turns the Internet into a multimedia magazine, but

Outlook Express turns it into your personalized post office, where you
never need fumble for a stamp. A Windows XP freebie, Outlook Express
lets you send letters and files to anybody in the world who has an e-mail
account. (And that’s just about anybody, these days.)

Quite the bargain for a freebie, Outlook Express automatically sorts your
incoming mail and stuffs it into the correct folder, juggles several e-mail
accounts simultaneously, and adds some security to your e-mail as well.

[ wrap up this chapter with another subject requested by readers: Windows
Messenger. You find out how to sign up for an account, send instant messages
to your friends and coworkers, and uninstall the darn program when all that
instant chatter starts grinding on your nerves.

Using Outlook Express

The Outlook Express screen, shown in Figure 9-1, contains three main parts:
Folders, which automatically store and sort your e-mail; Contacts, which dis-
play names of people in your Address Book; and the work screen, where you
tinker with your e-mail.
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Folders: The folders in Outlook Express work much like in baskets and out
baskets for sorting memos. Click any folder’s name to peer inside, and you're
in for a pleasant surprise. Unlike your own office, Outlook Express automati-
cally sorts your information into the following folders:

v Inbox: When you connect to the Internet, Outlook Express grabs any
waiting e-mail and places it in your Inbox. (To send and receive any wait-
ing e-mail immediately, click the Send/Recv button along the top of the
Outlook Express window.)

v Outbox: When you send or reply to a message, it sits in your Outbox,
ready to be sent automatically the next time you connect to the Internet.
(Clicking the Send/Recv button connects to the Internet, sends your out-
going mail, and fetches any waiting e-mail.)

v Sent: Fvery piece of e-mail you've sent stays in here, leaving a perma-
nent record. (Right-click on an offensive e-mail and choose Delete to kill
it for good.)

v Deleted: The Deleted folder serves as the Outlook Express Recycle Bin.
Right-click on anything in here to delete it permanently or move it to a
different folder. Or, to keep the Deleted folder empty, choose Options
from the Tools menu, click the Maintenance tab, and select the Empty
Messages from the ‘Deleted Items’ Folder on Exit check box.
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v Drafts: When you’re halfway through composing a letter and want to
finish it later, choose Save from your e-mail’s File menu. The letter moves
to your Drafts folder for later retrieval.

\\3

Contacts: In the Contacts area, Outlook Express lists the first few names in
your Address Book, sorted alphabetically. If you don’t see your contacts’
names listed like in Figure 9-1, choose Layout from the View menu and click
in the Contacts check box. (The Address Book gets its own section later in

this chapter.)

v Missing that handy row of buttons along the top of Outlook Express like
in Figure 9-1? Choose Layout from the View menu and click to place a
check mark in the Toolbar box.

v If your copy of Outlook Express still doesn’t look like Figure 9-1, it’s time
to tweak its layout. Try this trick: Choose Layout from the View menu
and make sure that you've selected Folder Bar, Folder List, Status Bar,
and Toolbar. (Clicking the Apply button after you select or deselect an
option lets you see exactly what that option does to the screen.)

v Want to transfer all your e-mail and contacts from your old computer to
a new one? | explain that chore in Chapter 19.

Exactly what do | need to send and receive e-mail?

To send e-mail to a friend or foe with Outlook
Express, you need three things:

v An e-mail account: The next section
describes how to set up Outlook Express to
work with your e-mail account. Most ISPs
(Internet service providers, covered in
Chapter 8) give you a free e-mail address
along with your Internet access.

v+~ Your friend's or foe’s e-mail address: Locate
your friends’ e-mail addresses by simply
asking them. An address consists of a user
name (which occasionally resembles the
user’s real name), followed by the @ sign, fol-
lowed by the name of your friend’s Internet
service provider. The e-mail address of an
America Online user with the user name of
Jeff9435 would be jeff9435@ao0l . com.

v Your message: Here's where the fun finally
starts: typing your letter. After you type in
the person’s e-mail address and your mes-
sage, hit the Send button. Outlook Express
routes your message in the right direction.

You'll find people’s e-mail addresses on business
cards, Web sites, and even return addresses:
Whenever you reply to e-mail, Outlook Express
automatically adds that person’s e-mail address
to your Address Book.

If you misspell part of an e-mail address, your
sent message will bounce back to your own
Inbox, with a confusing undeliverable message
attached. Check the spelling of the address and
try again. If it bounces again, humble yourself:
Pick up the phone and ask the person if you
have the right address.
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Setting up your e-mail account

In order to send or receive e-mail in Outlook Express, you need these three
things, all available from your ISP: your user name, your password, and a
working Internet connection. (You've already used these things if you suc-
cessfully set up your Internet account, as described in Chapter 8.)

Most people set up more than one e-mail address — a freebie account from
both Yahoo! (www.yahoo.com), and Hotmail (www.hotmail.com), for
instance, and separate addresses for each family member. Whether you're
setting up your 1st or your 40th e-mail account, follow these six steps:

1. Set up your Internet account and open Outlook Express.

You need to set up your Internet account first, as described in Chapter 8§,
or your e-mail won’t have any way to reach the Internet.

click the Outlook Express icon (shown in the margin). Outlook Express
hops onto the screen, ready to be set up to send and receive your e-mail,
as shown in Figure 9-2.

‘ﬂl To call up Outlook Express for the first time, open the Start menu and

Internet Connection Wizard

Your Name

- . ‘When vou send e-mail, your name will appear in the From field of the outgoing message.
Flgure 9-2: Type your name as you would ke it to appear.

When
loaded for Display nae: Andy Rathbone
the fl rst For example: John Smith
time,
Outlook
Express
offers to set
up your
e-mail

account. | Mext > E Cancel

If the screen in Figure 9-2 doesn’t appear automatically, open Outlook
Express and choose Accounts from the Tools menu. Click the Add button
and choose Mail to bring up the window in Figure 9-2, ready to add an
e-mail account.

2. Type in your name and click Next.

This name will appear in the From box of all your e-mail, so most people
simply type in their own name, as shown in Figure 9-2. Names like
DragonSlayer may come back to haunt you.
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3. Type in your e-mail address and click Next.

This is your user name, the @ sign, and your ISP, all information that
your ISP must provide you with. For instance, if your user name is
jeff41265 and your ISP’s name is charternet.com, then type jeff4265@
charternet.com into the E-Mail Address box.

Adding a second e-mail address to Outlook Express? The procedure is
the same: Type in the user name for that second account.

4. Choose your server type and the names for your incoming and outgo-
ing mail servers.

Here, you need to know what fype of e-mail account the service uses. It’s
a weird word like POP3, IMAP, or HTTP. Most ISPs send you these handy
settings and instructions through the post office. If you've lost them, visit
your ISP’s Web site or call your ISP’s tech support folks and ask them for
their mail server’s name and type. Table 9-1 lists the information required
by some common e-mail services.

Table 9-1 E-Mail Settings for Popular ISPs

Service E-Mail Incoming Mail Outgoing Mail
Type Server Server

America Online IMAP  imap.aol.com smtp.aol.com

(AOL) (See the related
sidebar for additional
settings that AOL
accounts need.)

Hotmail HTTP  http://services.msn. Don'tenteranything
com/svcs/hotmail/ anything in this area.
httpmail.asp.

Yahoo! (Only paid POP3  pop.mail.yahoo smtp.mail.yahoo

Yahoo! e-mail

accounts can

receive mail

through Outlook

Express.)

5. Type in your account name and password and click Next.

For your account name, enter the part of your e-mail address before the @
sign. Then type in the password for that account. If you want to log on
automatically without entering your password each time, check the
Remember Password box.

(Check the Secure Password Authentication box only if your Internet
provider requests it.)
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Finishing up your AOL account in Outlook Express
Even after finishing Steps 1-6to set up your AOL 4. Click the Advanced tab.

Svcocr‘l’(“:;;:‘e?:;’lt"’fr']‘tﬁxﬂss.i}x"“thgl‘l"’I‘]";L‘;V?glf 5. In the Outgoing Mail (SMTP) box, change
y you jump g the number to 587 and click Apply.

lowing hoops:

6. Click the IMAP tab and click to remove the
check from the Store Special Folders on
IMAP Server box.

1. Choose Accounts from Outlook Express’
Tools menu, select Accounts, and click the

Mail tab.
2. Selectthe AOL account you created, choose e
Properties, and click the Servers tab. If a message asks you to download folders from

3. Click the My Server Requires Authentication i el SR el s

box and click Apply.

6. Click Finish.

That’s it. You should be able to send and receive e-mail on Outlook
Express.

v~ If the settings don’t work or don’t look right, they’re easy to change.
Choose Accounts from the Tools menu, click the Mail tab, and double-
click the name of the account that needs tweaking. (This also lets you
choose a more descriptive name for it.)

v Some ISPs let you create up to five different e-mail accounts. Feel free to
create a “disposable” e-mail account to use when signing up for online
offers or filling out forms. When it becomes plagued with spam, simply
delete it and create a new one.

v Set up more than one account? Then make your most-used account your
default account — the one Outlook Express chooses automatically as the
From name when you click the Send button. To set your default account,
choose Accounts from the Tools menu, click the Mail tab, and click your
most-often used account. Finally, click the Set as Default button. (You
can always change which account to use before sending a message.)

Composing and sending an e-mail

Ready to send your first e-mail? After you've set up Outlook Express with
your e-mail account, follow these steps to compose your letter and drop it
in the electronic mailbox, sending it through virtual space to the recipient’s
computer:
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1. Open Outlook Express and click the Create Mail icon from the pro-
gram’s menu.

If you don’t see a Create Mail icon along the top (it looks like the one in
the margin), click the File menu, select New, and choose Mail Message.

A New Message window appears, as shown in Figure 9-3.

@Dinner =[] =]
File Edit View Insert Format Tools Message Help o
= Y & G 0 ¥, =35
Send Unda Check ) Attach  Priority Sign Encrypt  Offline
Fram: andyrathbonel@hotmall.com  {Hotmail) Vv_

B3 To: ‘p\zza@pizzadelivery.cum
[EE Cc: ‘

Subject: ‘Dinner

Al M E B 7 UA|EEEE === (-8R
Hello,

Please deliver an Extra-Large pizza with the works to the usual address. But this time, LEAVE OFF THE
PIMEAPFLE

Thanks,

Andyl

If you've set up more than one account, described in the previous sec-
tion, Outlook Express automatically addresses the mail with your default
account. To send it from a different e-mail account, click the downward-
pointing arrow in the From box and select the other account.

To send a quick e-mail to somebody in your Address Book, just double-
click his or her name. Outlook Express opens an e-mail already addressed
to that person, saving you a step.

2. Type your friend’s e-mail address into the To box.

Type the person’s e-mail address into the To box. Or, if you've e-mailed
that person previously, click the word To next to where you type an
address: A window appears, listing the names of people you've previ-
ously e-mailed. Click your friend’s name and click the To button, shown
in the margin.

Sending or forwarding a message to several people? Select their names
but click the Bcc button (shown in the margin) instead of the To button.
That still sends the same message to them all but hides their e-mail
addresses from each other, preserving their privacy.

To let everybody see each other’s e-mail addresses, select their names
and click the Cc button, shown in the margin. (Unless the recipients all
know each other, this is considered bad etiquette.)
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Send

. Fill in the Subject box.

Although optional, the Subject line lets your friends know why you’re
bugging them. That lets them respond right away or file your mail in
their “I'll respond when I get around to it” box.

. Type your message into the large box at the bottom of the window.

Type whatever you want and for as long as you want. There’s very little
limit on the size of a text file.

. Want to attach a file to your message? Click the paper clip icon (or

choose File Attachment from the Insert menu). Navigate through the
folders to reach the file that you want to send and then double-click
its name to attach it.

Most ISPs balk at sending files larger than about 4MB, however, which
rules out most MP3 files and some digital photos. | explain an easy way
to send nearly any photo in Chapter 16.

. Click the Send button in the box’s top-left corner.

Whoosh! Outlook Express dials your modem, if necessary, and whisks
your message through the Internet pipelines to your friend’s mailbox.
Depending on the speed of the Internet connection, mail arrives anywhere
within 15 seconds to five days, with a few minutes being the average.

No Send button? Then click File and choose Send Message.

v Some people like those big buttons along the top of Outlook Express, as

shown in Figure 9-3. If your big buttons are missing, and you want ’em
back, right-click on a blank part of the Outlook Express menu — an inch
to the right of the word Help will do the trick. Choose Toolbar, and the
buttons appear. To get rid of ’em, right-click in the same place and choose
Toolbar again to toggle them off.

v Not too good of a speler? Then before you send the message, click the

Spelling button from the icons along the top. Or choose Spelling from
the Tools menu. Or press your F7 key. Or grab a dictionary off the shelf.
(Pressing F7 is quicker.) If it doesn’t work, read the following warning.

v Microsoft pulled a dirty trick on the spell checker. Outlook Express bor-

rows the spell checker that comes with Microsoft Word, Microsoft Excel,
or Microsoft PowerPoint. If you don’t have any of those programs, its
spell checker won’t work. (That’s why the Spelling button is grayed out
in Figure 9-3.)

Reading a received e-mail

Q 3 74se 1T you keep Outlook Express running while you’re connected to the Internet,

you’ll know when a new letter arrives. Your computer makes a breezy little
sound to herald its arrival. You'll also spot a tiny Outlook Express icon in
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your desktop’s bottom-right corner, right next to the clock. Plus, if more than
one person uses your PC, the Welcome screen where you log on displays how
many e-mails each person has received.

To check for any new mail when Outlook Express isn’t running, load the pro-
gram from the Start menu. When it loads, click the Send/Recv button (or click
the Tools menu, choose Send and Receive, and then choose Send and Receive
All). Outlook Express logs onto the Internet, sends any outgoing mail you have
sitting around, and grabs any incoming mail to place in your Inbox.

Follow these steps to read the letters in your Inbox and either respond or file
them away into one of Outlook Express’ many folders:

1. Open Outlook Express and look at your Inbox.

Depending on how Outlook Express is set up, you can do this several
different ways. If you see an opening screen announcing that you have
unread mail in your Inbox, click the words Unread Mail to start reading.
Or, if you see folders along the left side of Outlook Express, click the
word Inbox.

Either way, Outlook Express shows you the messages in your Inbox, and
they look something like Figure 9-4. Each subject is listed, one by one,
with the newest one at the bottom.

<) Inhox - Outlook Express D=
File Edit View Tools Message Help i
gl y A= *
> . 8¢ & v8 (= X == B .
Create Mail Reply Reply Al Faorward Print Delete SendfRecy Addresses Find
]
Folders X[ 4 8 ¥ From Subject Received /|4
(%3] Outlook Express inoah matelic Qqvbihakhb e-scripts 5(29/2004 11:2
= @ Lacal Folders “1Bobby Preslsy Walium ,#anax and more - Mo prescription necessary 5i30/2004 12:(
k=] 1anHJ,\{X7) i Leonida Fernande AS EASY AS 123 T0 PURCHASE SUPER LOW PRI...  5/30,/2004 2:
2 Outhe <] Bettye Meade Low cost pharmaceuticals delivered to your d...  5/30/2004 3;
£ Sent Trems [ Bryan Patterson 300+ pharmaceuticals shipped overnight 5/30/2004 4;
'f;‘ Deleted Thems EAMargo Lyles Yiagra, Great Price, No Hidden ChargesO 5/30/2004 5;
B Drafts b4 Kristine satisfy 5/30,2004 6:
=% Hotrmail [ Owen Goode No need to cross the border for your CHEAP A...  5/30,/2004 6:
@ Inbay B dallas willoughby Ch req.ues.ted rx info 5/30/2004 T\
SF Sent Trems i >
& DEIEtEd_ Trams From: noah matelic  To: santo dorris Co: bracey stacy; hal carpanini; alan tenley
& Bulk Mail Subject: Qgvbjhagkhb e-scripts
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Contacts ~ x || hatp hastycgribh gwia
[Habdul Zanzibar -~
[ FIBeulah Grant
[HlBiobly Presley The biggest phaBrmacy store! Save over 80%! More than 3,000,000 satiQsfied
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L T Legally or der V-ico'din
[ FIEugenio Dickson
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Want your newest e-mails to appear at the list’s top? Then click the word
Received at the top of the Received column. Outlook Express resorts
everything but now places your newest message at the top. (You can
sort mail by name or subject by clicking those column headers, too.)

. Click any message’s subject to read it.

The message’s contents then shows in the bottom portion of the screen,
as shown in Figure 9-5, ready for you to read. Or, to see the entire mes-
sage in its own window, double-click it.

. From here, Outlook Express leaves you with several options, each

described in the following list:

¢ You can do nothing. The message simply sets up camp in your
Inbox folder until you delete it.

¢ You can respond to the message. Click the Reply icon along the top
of Outlook Express (or choose Reply to Sender from the Message
menu), and a new window appears, ready for you to type your
response. The window is just like the one that appears when you
first compose a message but with a handy difference: This window
is preaddressed with the recipient’s name and the subject.

¢ You can file the message. Right-click on the message and choose
either Copy to Folder or Move to Folder and then select the desired
folder from the pop-up menu. Or drag and drop the message to the
desired folder along the left side of your screen. (Don’t see the fold-
ers there? Click the word Inbox and, when the folders drop down,
click the little push pin to keep the folders in place.)

¢ You can print the message. Click the Print icon along the menu’s
top, and Outlook Express shoots your message to the printer to
make a paper copy.

¢ You can delete the message. Click the Delete button along the top
to send the message to your Deleted items folder.

v Outlook Express can be confusing when you drag and drop a message:

As you drag the message over to the folders, the little envelope icon
turns into a circle with a diagonal line through it. Don’t fret. That menac-
ing circle disappears when the mouse rests over a folder that’s able to
accept a message.

v To organize your incoming messages, right-click on your Inbox and

choose New Folder to create another folder inside. Create as many fold-
ers as you need to categorize your spam offers.
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1 When you see a little red X in place of a picture or photo on your e-mail,
that means Outlook Express is blocking it. It'll appear if you edit, forward,
or reply to the message. Or, to make Outlook Express stop blocking it,
choose Options from the Tools menu, click the Security Tab, and remove
the check mark from the Block Images and Other External Content in
HTML E-Mail box.

V?‘“\NG! v If you ever receive a message with an attached file from a friend, don’t
S open it. E-mail your friend and ask whether he or she really sent it. Evil
people have written programs that can mimic other people’s e-mail
addresses to spread virus and worm programs into other computers.
If the worm infects your computer, it sneakily sends copies of itself to
everybody in your Address Book.

v To prevent you from opening a virus, Outlook Express refuses to let you
open almost any attached file. If Outlook Express won’t let you open a file
you're expecting from a friend, turn off that protection: Choose Options
from the Tools menu, click the Security tab, and click to remove the check
mark from the Do Not Allow Attachments to Be Saved or Opened That
Could Potentially Be a Virus box.
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Finding lost mail

Outlook Express retrieves e-mail much faster than a pair of hands. To locate
that missing piece of mail anywhere in any folder, follow these steps:

By 1. Click the Find button’s downward arrow (shown in the margin).

Frd [y No Find button? Choose Find from the Edit menu and select Message.

2. In the Find Message dialog box that appears, shown in Figure 9-6,
search for messages containing certain items.

I3 Find Message =01 ]
File Edit View Message
Look in: Outlook Express Include subfolders

Frarm: | Find Mo D

I | T

Figure 9-6: Subject: | pneapple fizza topping [ New Search |
Searchfora | Message:
m issin g Received before; [ | w [IMessage has attachment(s)
message' Received after: =) w [Message is fagged
|

Here are your options:

¢ From: In here, type the name of somebody who’s sent you mail to
see all the messages that person has sent you.

¢ To: Type a person’s name here, and Outlook Express shows you
every message you’'ve sent to him or her.

¢ Subject: Type a word that appeared in an e-mail’s subject line to
locate it.

* Message: Type any word that you know appears in the message.

P Usually filling out one box catches your message. Try just entering a few
letters of a person’s e-mail address or a single word that appeared in the
message. If a search turns up too many items, add more and more words
to limit the number of matches.

3. Click Find Now when you’re done filling out the boxes.

Using an Address Book

\ Just as every office desk needs a business card holder, Outlook Express
% needs its Address Book (shown in Figure 9-7) to store everybody’s contact
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information. Click the Address Book button in Outlook Express to open it.
(You can also click the Start menu, choose All Programs, and open it from the
Accessories area.)

.J Address Book - Main Identity =l
Eile Edit Yiew Tools Help
B B X B 9 @
Mew Properties Delete  Find People Print Action
I [ shared Contacts Tupe niame o select from list:
Fiqure 9-7: N Main Identity's Contacts! || pame  « aiicess e
9 i [E=)Abdul Zanzibar az@asdf.com 555-268-3456
The Outlook ElBeulah rant
EZlBobby Presley DKEGDQSEHISQGEN@hotmail.com
EXp ress Carmela ‘White
Address Dalon Santana
:|Darrell Yega
BOOk keeps Eugenio Dickson
E5] Jerry Hatricl Jerryi@Hatrick, com 955-234-6325
rack o =] k k.
bod [E=IMeredith Brown
every 0 y [E=lPalatnicksod palotnickS04@cox.nek
you contact. EXlshaunna Otelia
11 ikems
|

You can start beefing up your Address Book several ways:

v Add contacts manually. When somebody hands you a business card,
you must enter the information by hand: Choose New from the File menu
and choose Contact. Start filling out all the boxes on every tab to create
a detailed dossier; click OK when you’re through.

1 Make Outlook Express do it automatically. When you respond to an
e-mail, Outlook Express will automatically add that person and e-mail
address to your Address Book if you do the following: Choose Options
from the Tools menu, click the Send tab, and select the Automatically
Put People I Reply to in My Address Book check box.

v+ Import an old Address Book. To import an Address Book file from
another computer, click the File button and choose Import. Select the
Address Book option to import an Address Book from another com-
puter’s Outlook Express; select Other Address Book to import a list of
addresses created by another program.

Here are some other tasks you might want to know how to do:

v To send a quick message to somebody in the Address Book, double-click
that person’s name. The Address Book calls up a handy, preaddressed
New Message window, ready for you to type your message and click
Send.

v | explain how to print an Address Book into handy information sheets in
Chapter 7.
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Keeping Outlook Express secure, but convenient

Outlook Express automatically turns on many
security measures. To see what security switches
it has flipped (and to turn them off if they annoy
you), choose Options from Outlook Express’ Tools
menu and click the Security tab.

Virus Protection: Although some of these mea-
sures protect you from viruses, they do that by fil-
tering out nearly everything. Here's the rundown:

v Internet Explorer Security Zone: Ignore this
unless you've deliberately set restricted
security zones in Internet Explorer, as cov-
ered in Chapter 10.

v Warn Me When Other Applications Try to

an inoffensive way to keep worms from
spreading.

+* Do Not Allow Attachments to Be Saved or
Opened That Could Potentially Be a Virus:
Because nearly anyfile can contain a virus
these days, this effectively stops you from
opening most attachments. Uncheck this
box to open your attachments again.

Download Images: Outlook Express simply
stops showing any pictures in your e-mail.
Remove the check to view them again.

Secure Mail: This is much too complicated to
worry about.

Send Mail as Me: Leave this on because it's

v To back up an Address Book, choose Export from the File menu and
choose Address Book. Click the Text File (Comma Separated Values)
option to create something nearly any program can read. Choose the
Microsoft Exchange Personal Address Book option to move your
Address Book to another computer using Outlook Express.

Getting rid of all your spam

Unfortunately, you can’t get rid of spam. Believe it or not, some people still
reply and buy things from spam messages, making them profitable enough
for spammers to continue. But although you can’t stop spam, you can weed
out much of it by following these rules:

v Give your e-mail address only to close friends and relatives. Don’t give it
to strangers or post it on Web sites.

v Every few months, create a new, disposable e-mail account to use when
signing up for online offers, filling out online forms, or carrying out any
short-term correspondence. If that address becomes plagued with spam,
simply delete it and create a new one.

v Never post your real e-mail address in an Internet’s chat forum, news-
group, or other public conversation area. And never respond to a spam-
mer, even if it’s to click the unsubscribe link. That merely adds you to
the spammer’s list of confirmed e-mail addresses.
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v~ See if your ISP offers built-in spam filtering. The filters work so well that
many spammers now try to evade the filters by using nonsensical words.
If they do make it through, the nonsense in the subject gives it away as
being spam.

v If you're seeing pop-up messages titled Messenger Service, head to
Chapter 10. Turning on your firewall keeps those messages from entering.
(Be sure you’ve installed Windows XP’s service packs, too, as covered in
Chapter 1.)

v Although Outlook Express offers some simple filtering rules in its Tools
menu, spammers figured out how to fool them long ago. They’re no
longer handy for filtering spam, but they work fine for routing e-mail
from certain people to certain folders.

Bugging Friends with
Windows Messenger

When you want to talk with distant friends, you usually call them on the
phone and start speaking. A phone conversation is fast, reliable, and efficient.
So why do so many people use Windows Messenger, a program that lets people
type little messages back and forth to each other? Messenger fans cite sev-
eral reasons:

v It’s free. Built in to Windows XP, Windows Messenger lets you communi-
cate with other Windows Messengers users worldwide, with no long
distance charges.

v It’s polite. As Windows Messenger sits in your taskbar, it lists your
friends’ names and whether they’re currently available for conversa-
tions. That eliminates playing phone tag and keeps you from bothering
people who are busy.

v It’s convenient. Speaking on the phone requires all your attention.
Windows Messenger lets you keep working in the background, simulta-
neously holding multiple conversations while shuffling papers.

v It’s useful. In addition to exchanging text messages, users can send files
and photos. Windows Messenger can take advantage of attached cameras
and microphones to hold videoconferences with your friends.

Windows Messenger is far from problem-free, however. Its far-reaching features
make it somewhat complicated to figure out for the first time. And although
several companies (Yahoo! and AOL, for instance) offer instant messaging soft-
ware, they’re not always compatible: Windows Messenger can’t send messages
to AOL’s Instant Messenger, for instance.
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Also, because people can swap files as easily as banter, instant messaging
software provides yet another roadway for traveling viruses. Many corpora-
tions ban them at work, fearing that employees are either revealing trade
secrets or talking about last night’s Sopranos episode. Finally, instant mes-
sage conversations aren’t as secure as e-mail.

v Windows Messenger and MSN Messenger are two different programs
that do pretty much the same thing. Both Messenger programs can talk
to each other. However, it’s best to install one or the other, but not both.
Uninstall MSN Messenger before using Windows Messenger, for instance.

v Microsoft constantly releases new versions of Windows Messenger. To
find out which version you’re using, choose About from the program’s
Help menu. Compare that version number with the latest one available
from Microsoft by using Windows Update, and download the newer one
if necessary.

Getting started with a .NET Passport

To start flinging messages to people around the world, sign up for what
Microsoft dubs a .NET Passport. The easiest way is to sign up for a free
Hotmail account at www.hotmail.com. Fill out the short questionnaire,
and Microsoft assigns you a Hotmail e-mail address. Log in to Windows
Messenger using that address, and you're set.

It’s completely ethical to lie when filling out Microsoft’s .NET Passport question-
naire. Your personal information is none of Microsoft’s business. Let Microsoft
fill its databases from credit card companies, like everybody else does.

Windows Messenger doesn’t work!

Can't log on? First, make sure your Hotmail
account hasn't expired. (Hotmail accounts disap-
pear if you haven't used them ten days after sign-
ing up or if you ignore them for 60 consecutive
days.) Visit Hotmail's Web site (www.hotmail.
com) and see if your account’s still valid. Also,
visit the .NET Passport site (www.passport.
com) to see if your passport’s still valid.

If you can send messages but not files, your
computer’s firewall might be causing trouble.

(Windows XP’s firewall doesn’t interfere with
Windows Messenger, but some third-party fire-
walls might.)

If you can log on, make sure that Microsoft's
computer hasn’t crashed: Choose .NET Service
Status from Windows Messenger's Help menu to
see if Microsoft's network is currently running.
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Signing on to Messenger
and adding friends

After you have a Hotmail account, you're ready to log on. Windows Messenger
almost always sits quietly in your taskbar, next to your clock. (It also tends to
pop into action whenever you open Outlook Express.) Can’t find it? Then click
the Start button, choose All Programs, and click the Windows Messenger icon,
shown in the margin, to bring it to life. The program leaps onto the screen, as
shown in Figure 9-8.
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When you sign on for the first time, however, there’s not much to do. Just as
you need a friend’s e-mail address in order to send that person an e-mail, you
need a friend’s Windows Messenger address before you can send him or her
an instant message. Ask your friends for their Messenger addresses and then
add them as contacts by following these steps:

1. Click Add a Contact from Windows Messenger.

Or you can choose Add a Contact from the Tools menu.

179
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2. Choose to add the contact by e-mail address or sign-in name and then
click Next.

Searching by a known e-mail address or sign-in name always works
better than searching by name and geographic location. You can also
search Microsoft’s Web site (members.msn.com) for strangers to chat
with. (Skip the first few pages to weed out the porn.)

3. Type your friend’s e-mail address and click Next.

Make sure you're typing in your friend’s Windows Messenger e-mail
address, which is often different than his or her e-mail address.

If you entered the person’s correct e-mail address, Microsoft locates
your friend and adds his or her name to your Contact list so you can
start sending that person messages.

4. Click Next to add more contacts or click Finish if you’re through.

Windows Messenger updates itself to display your newly added con-
tacts, as shown in Figure 9-9.
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v Notice how Figure 9-9 lists Margo as Online? That means Margo is cur-
rently logged on to her computer, ready to receive messages.
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v Don’t want to be disturbed? Then tell Windows Messenger to display
your status as unavailable by clicking your name and choosing any of
the following options from the drop-down list: Online, Busy, Be Right
Back, Away, On the Phone, Out to Lunch, or Appear Offline.

\\3

»* You can make Windows Messenger automatically list your status as Busy
when you begin working. Choose Options from the Tools menu and click
the Preferences tab. Then make sure a check mark appears in the Block
Alerts and Set Status to “Busy” When Running Full-Screen Programs box.

v Whenever one of your contacts signs in to Windows Messenger, a small
window known as an alert appears in the bottom-right corner of your
screen to let you know they’ve just fired up Windows Messenger.

Sending and receiving an instant message

If a friend’s online, you can contact that person in a variety of ways. Right-click
on any contact’s name to see your options, shown in Figure 9-10.
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Choose Send an Instant Message, for instance, to make a window appear on
your friend’s screen and display your message. If your computer has a micro-
phone and video camera, you can hold a voice or video conversation. Windows
Messenger lets you swap files, too.
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Sending instant messages is probably the most foolproof way to communicate,
when you follow these steps:

1. Right-click on your friend’s name in Windows Messenger and choose
Send an Instant Message.

2. Type your message and click the Send button, as shown in Figure 9-11.
Your words instantly appear on your friend’s Windows Messenger.
When your friend responds, those words appear in your Windows

Messenger window, as shown in Figure 9-12.

v To add little smiley faces and other symbols (known as emoticons), click
the little smiley face. A menu drops down, listing all the available sym-
bols. Click the one you want, and it appears in your message.

\NG/
SN . . .

& v As Microsoft says, never give out your password or credit card number
in an instant message conversation. Instant messages aren’t nearly as
secure as e-mail.

v After you've started a conversation, it’s easy to send or receive a file.
Click Send a File or Photo and choose the file or photo from the window
that appears. Your friend sees a message asking whether he or she wants
the file. If your friend clicks Yes, the file wends its way to his or her com-
puter. If your friend declines to download the file, Windows Messenger
tells you that.
»* When somebody sends you a file or photo, you'll find it in the My
Received Files folder inside your My Documents folder.
% Margo - Conversation =)
File Edit iew Actions Help
To: Margo <margolyles@hotmail.com:>
& mever give out your password or credit
card number in an instant message
conversation, Invite Someone
& to this
Conversation
. Send a File or
* Photo
Start Remote
* Assistance
— ol
¢ Application
Figure 9-11: SIIEKIY)
. Start
Click the * Whitehoard
Send bUtton @ Elock A Font %% = Ematicons
to send your Have you eaten lunch yet?
message to Send
your friend. ; .
|
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% Margo - Conversation B]E)] ]
Eile Edit Miew Actions Help
To: Margo <margolyles@hotmail.com:>
& Mever give out your password o credit
card number in an instant message
conversation, Invite Someone
» to this
Andy says: Conversation
Have you eaten lunch yet? . Send a File or
Margo says: “ Photo
MNope. |was thinking about a pizea @ Start Remote
® Assistance
Start
I S
@ Application
Figure 9-12: Sharing
. Start
Your polite * Whitehoard
friend @ Block A Font 4% - Emoticons
responds to
your Send
message.
Last message received on 5/31/2004 at 11:48 AM,
I

Some folks love instant messaging programs like
Windows Messenger. They love to be inter-
rupted, and they like to bug their friends. Other
folks hate them, and they loathe seeing Windows
Messenger’s dastardly little icon hogging space
next to their computer’s system clock.

If your computer’s service packs are installed,
as described in Chapter 1, removing Windows
Messenger is a cinch:

1. Open the Control Panel from the Start menu.
2. Choose Add or Remove Programs.

3. Select Add/Remove Windows Components.

Uninstalling Windows Messenger

4. Click to remove the check mark next to
Windows Messenger.

5. Click the Next button, click the Finish
button, and then restart your computer.

Sometimes simply running Outlook Express
revives Windows Messenger from the dead. To
keep Windows Messenger from reappearing,
choose Options from the Outlook Express’ Tools
menu and click the General tab. Then click to
remove the check mark from the Automatically
Log On to Windows Messenger box.
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Chapter 10
Safe Computing

In This Chapter

Assessing your safety with the Security Center
Changing the Windows Firewall settings
Automating Windows Update

Using a virus checker

Setting Internet Explorer’s security zones
Managing cookies

Preserving your privacy

! ike driving a car, working with Windows is reasonably safe, as long as
you steer clear of the wrong neighborhoods, obey traffic signals, and
don’t steer with your feet while you stick your head out the sunroof.

But in the world of Windows and the Internet, there’s no easy way to recognize
a bad neighborhood, spot the traffic signals, or even distinguish between your
feet, the steering wheel, and the sunroof. Things that look totally innocent —
a friend’s e-mail or something on the Internet — may be a virus or prank that
sneakily rearranges everything on your dashboard or causes a crash.

This chapter helps you recognize the bad streets in Windows’ virtual neigh-
borhoods and explains the steps you can take to protect yourself from harm
and minimize any damage.

Assessing Your Safety in
XP’s Security Center

Before reading any further, take a minute to check your safety with Windows
XP’s new Security Center, installed by Service Pack 2 (described in Chapter 1).
Although the Security Center more closely resembles a large panel of On
switches than a command post, it lists Windows XP’s three main defenses,
tells you if they’re activated, and lets you flip their On switches, if necessary.
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Figure 10-1:
Windows
XP’s new

Security
Center lets
you check

on your
computer’s
three main
defenses:
Windows

Firewall,
Automatic

Updates,
and a virus

checker.

Shown in Figure 10-1, the Security Center shows whether you've turned on
Windows Firewall, Microsoft’s Automatic Updates feature, and a virus checker.
The computer shown in Figure 10-1 passes the firewall test. But it cautions that
Windows Update isn’t updating automatically, and the virus detector isn’t
installed or working.

All three of these defenses should be up and running for maximum safety
because each protects you against different things.

Whenever the Security Center notices problems like these, it alerts you by
placing a red icon (shown in the margin) near your taskbar’s clock.

To make sure your computer’s three big cannons are loaded and pointing in
the right direction, open the Security Center and ogle the settings:
1. Open the Start menu’s Control Panel and choose Security Center.

The Security Center hops into action, as shown in Figure 10-1, and dis-
plays your computer’s current security status.

%) Security Center ==
] Security Center

Help protect your PC

@) Rewources %7y Security essentials
T i Help protect your computer by making sure that all of these settings are marked O,
How does Windows help protect my computer?

= Get the latest security and virus
information from Microsoft

> Fi e

= Check for the latest updates from ‘-»'l Firewall G Ol ¥
‘windows Update

+ Get support for securky-related Q Automatic Updates © CHECK SETTINGS | 2

is5UES

Automatic Updates is set up ta install updates after checking with you, Click Change setting to have Windows
automatically keep your computer current with important updates (recommended). How does Automatic
Updates help protect my computer?

= Get help about Security Center

= Change the way Security Center

alerts me Change setting

# Virus Protection @ NOT FOUND | 2

windows did not find antivirus software on this computer, Antivirus software helps protect your computer
against viruses and other security threats, Click Recommendations for suggested actions you can take, How
does antivirus sofbware help protect my computer?

Mote: Wwindows does not detect all antivirus programs.

Manage security settings for:

@ Internet Options _’Qfg System @ Windows Firewall
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2. Turn on the firewall, if necessary.

Windows XP’s updated, more powerful firewall monitors every connection
arriving at your PC. When the firewall notices an unrequested connection
trying to enter, it blocks it, stopping potential intruders.

If the Security Center lists your firewall as being turned off, click the
Recommendations button, choose Enable Now, and click OK to turn it
on. (Service Pack 2 turns on the firewall by default; the old firewall made
you turn it on manually.)

3. Turn on Automatic Updates, if necessary.

When turned on, Windows Update automatically checks in with Microsoft
through the Internet, downloads any new safety patches, and installs
them, all for free, and all without any effort on your part.

If the Security Center doesn’t show Automatic Updates as being turned
on, simply click the Change Setting button to turn it on.

4. Install virus protection, if necessary.

Although Microsoft provides a free firewall and free, automatic patches
for your computer, it doesn’t provide a built-in virus checker. Nearly
every computer and office supply store sells virus-checking software,
and you can also buy it online.

After you install the virus checker, the Security Center no longer warns
you about it. (If you already have a virus checker installed, make sure it
has a valid subscription for downloading new virus definitions.)

By following the four preceding steps, your computer will be much safer than
under any other version